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Welcome to QuickBooks Enterprise Solutions! This 

chapter helps you install your new software on your 

computer and start using it. Chapter 1

If you’ve been using Quicken as your accounting software, turn to 
“Converting data from Quicken” on page 16.
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Hardware and software requirements
To use QuickBooks Enterprise Solutions, you need the following:

Recommended:

� IBM compatible 1 GHZ Pentium III computer.

� 256 MB (megabytes) of RAM (random access memory).

Minimum:

� IBM compatible 500 MHZ Pentium III computer.

� 128 MB (megabytes) of RAM (random access memory). 

� Hard disk with the following amounts of free disk space:

� 2X CD-ROM drive (double-speed).

� 256-colour SVGA monitor with a resolution of 800 x 600 (using Small Fonts in your 
Windows Control Panel Display settings).

� Either Windows 98, Me, 2000, NT 4.0 (with Service Pack 6a), or XP.

� QuickBooks Enterprise Solutions installation CD-ROM.

� Works with any printer supported by Windows 98/Me/2000/NT 4.0/XP.

� Microsoft® Word 97, 2000, or 2002 or Microsoft® Excel 97, 2000, or 2002, if you plan 
to use the features that integrate with Microsoft Word or Microsoft Excel. (More RAM 
enhances the use of these features.)

� If you want to synchronize with contact management software, you need either:

- Microsoft® Outlook 97, 98, 2000, or 2002
OR

- ACT! version 3.08, 4.02, or Interact 2000 if you want to synchronize with contact 
management software.

� Payroll and online features/services require Internet access with at least a 28.8 Kbps 
connection speed.

� Remote access users require at least a 56Kbps Internet connection speed.

� Expert Analysis users require at least 64 MB of RAM and an additional 100 MB of free 
disk space.

Installation component QuickBooks 
Enterprise 
Solutions

QuickBooks Enterprise Solutions 280 MB

Microsoft Internet Explorer 6.0 70 MB

Additional for Timer 9 MB



Network requirements 3

Network requirements
QuickBooks Enterprise Solutions network requirements are the same whether you are 
sharing a company file or printing to a network printer:

Minimum:

� Windows 2000 Server, Windows NT 4.0 Server (with Service Pack 6a), Windows XP 
Server, or NetWare Network File Server 3.12. 

OR

� Peer-to-peer network, using either Windows NT 4.0 (with Service Pack 6a), or Windows 
98, 2000, Me, or XP

If you are a network administrator who installs QuickBooks Enterprise Solutions for other 
users in your company, and if your computers are running Microsoft Windows 2000 or XP, 
be sure those users have at least Standard user (Power Users Group) rights. Users who are 
granted Restricted user (Users Group) access do not have the operating system rights to 
write to the registry keys and will not be able to use QuickBooks Enterprise Solutions.

� For more information about multi-user setup, see “Working with multiple users” on 
page 97.

Important: Intuit recommends you have the latest Service Pack or update for your 
operating system or network software. If you are uncertain whether you have the latest 
Service Pack or update, contact Microsoft, Novell, or your network administrator.
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Where to go from here

Have you 
been using 
QuickBooks 
or Quicken 

for your 
business?

Are you using 
QuickBooks?

Are you using 
Quicken?

Turn to “Installing 
QuickBooks 
Enterprise Solutions 
for the first time” 
on page 5.

Is it a Canadian 
version of 

QuickBooks for 
Windows?

Is it 
QuickBooks 

for DOS or for 
Macintosh 4.0 
M1 to M11?

Is it a non-
Canadian version 
of QuickBooks or 
QuickBooks for 
Macintosh 4.0 
M12 or 4.5?

Turn to “Upgrading 
from earlier versions 
of QuickBooks” on 
page 10.

Call Technical 
Support for 
upgrade assistance 
(see page 224).

You can’t upgrade 
your company file. 
You need to create
a new company file 
(see “Setting up a 
new company” on 
page 33).

Turn to “Converting data 
from Quicken” on page 16.

No

No

Yes No No

Yes Yes Yes

Yes

Yes

No

Are you using 
Simply 

Accounting 
5.0, 6.0, or 7.0?

Install QuickBooks, create a 
company file, then turn to 
“Importing from / exporting 
to other software” on 
page 28.

Yes

To check whether your earlier 
version of QuickBooks is Canadian:
1. Start your earlier version of 

QuickBooks.
2. From the Help menu, select About 

QuickBooks.
3. Examine the QuickBooks logo. If 

it has a maple leaf above the “i” 
(in “Quick”) instead of a dot, you 
have a Canadian version.
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Installing QuickBooks Enterprise Solutions for 
the first time

Installing QuickBooks Enterprise Solutions

To use QuickBooks Enterprise Solutions, you must have Microsoft Internet Explorer 6.0 (or 
higher) installed on your computer. If you do not have any version of Microsoft Internet 
Explorer on your system, the QuickBooks Enterprise Solutions Setup program will install 
Microsoft Internet Explorer 6.0. If you have an earlier version of Microsoft Internet Explorer 
currently installed, Setup will replace it with Microsoft Internet Explorer 6.0.

If you already have other browsers installed, the installation of Microsoft Internet Explorer 
6.0 will not affect them or their settings and preferences.

When you buy Enterprise Solutions, your license agreement allows you to install the 
product on up to 10 computers. A copy must be installed on each computer from which 
QuickBooks Enterprise Solutions is to be used.

1 Shut down all programs that are running, including virus protection programs.

2 Insert the QuickBooks Enterprise Solutions CD-ROM in your computer’s CD-ROM drive.

Note: If installation does not start automatically, click Start in the taskbar; then 
choose Run. Type D:/setup.exe (where “D” is the CD-ROM drive letter). Click 
OK. 

3 In the Welcome window, enter the Installation Key Code located on the sticker on the 
back of the CD-ROM.
Important: Write the Installation Key Code from the CD on the back of the first 
page of this Startup Guide (Copyright page). 
If you are reinstalling the program on the same computer, the Installation Key Code that 
you previously entered will appear in the Installation Key Code window. Use that key 
code when you reinstall.
If this key code is missing or illegible, call the number for QuickBooks Enterprise Solu-
tions Phone Support. From the Help menu, choose Info & Support, and then, under 
Contact Intuit, choose Phone Directory. To replace your Installation Key Code, you will 
need to provide proof of purchase or your registration number. 

This section is only for new users.

If you are upgrading from an earlier version of QuickBooks, see “Upgrading from earlier 
versions of QuickBooks” on page 10.

If you are converting from Quicken to QuickBooks Enterprise Solutions, see “Convert-
ing data from Quicken” on page 16.
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4 In the Setup Type window, choose either Express or Custom setup.

� Choose Express setup to install Enterprise Solutions to the default location and 
program group, or if you are upgrading from a previous installation. Express setup 
will overwrite your last installed version of QuickBooks. It will also install Microsoft 
Internet Explorer 6.0 if it is not already on your computer. After choosing Express 
setup, click Next and proceed to Step 6.

� Choose Custom setup if you want the option to change installation settings or 
specify a different installation location.
Note: If you don’t have Microsoft Internet Explorer 6.0 installed on your 

computer, the choice to install it will be selected for you. If you already have 
installed it on your computer, you now have the option to reinstall it.

5 If you chose Custom setup in the previous window, you’ll be asked to select the 
installation components. Make your selections and click Next.

� You can install Enterprise Solutions in the default location or click Change to choose 
a different folder.

� You can install Microsoft Internet Explorer 6.0 over a previous installation. But, if no 
previous version of Internet Explorer exists on your computer, you must install it 
now.

6 In the License Agreement window, read the agreement (you’ll need to click Next a few 
times to read through the agreement in its entirety), choose Accept and click Next. 

7 The installation program will begin copying files to the location you chose:

� If this is an Express setup, the installer will begin copying files. When the Copying 
Files window appears, review the settings. If any settings are incorrect, go back to the 
Setup Type window and choose Custom setup so that you can make different 
choices. If you are satisfied with the settings, click Next.

� If this is a Custom setup, you’ll be asked to select a program folder from the list 
provided or type a new folder name. Select the folder and click Next. When the 
Copying Files window appears, review the settings. If any settings are incorrect, go 
back to the Setup Type window and choose Custom setup so that you can make 
different choices. If you are satisfied with the settings, click Next.

8 Once installation is complete, you will need to restart your computer before you can run 
Enterprise Solutions. 

To start the program, double-click the QuickBooks Enterprise Solutions icon on your 
desktop or from the Windows Start menu, and choose QuickBooks from the Program group.

When QuickBooks Enterprise Solutions starts for the first time, it displays the license agreement. 
Read it if you didn’t as you installed QuickBooks, then click Yes to accept it. To view the 
agreement in French, click En Français.

Once you convert an existing company file to QuickBooks Enterprise 
Solutions, that file cannot be read or used by QuickBooks Basic, Pro, or 
Premier versions.
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Installation troubleshooting

Important: If you have trouble with installation, please see the following list of common 
installation questions and answers.

� What should I do if I have trouble installing the software?
As an initial troubleshooting step, follow these accepted installation practices:
Close all open programs. This includes virus protection and other programs that may be 
running in the background.
In Windows, press CTRL+ALT+DELETE. This will bring up a Close Program window that 
will allow you to close programs one at a time. Ideally, close all programs except 
Explorer and Systray. If a program will not close or prompts you to reboot the computer, 
leave it open. Close as many applications as possible. 
In Windows NT 4.0 or later, from the Task Manager, select the Applications tab, then 
choose Close All.
Be sure your system meets the minimum requirements for installing the software.

� What should I do if I can’t find my installation key code?
Check the package your CD came in for a sticker. The key code is stamped on this sticker 
and contains 18-21 digits.
If you installed Enterprise Solutions on another computer, you may be able to retrieve 
the installation key code from that computer.

- Start the Enterprise Solutions installation program on the computer by clicking 
setup.exe. Insert the CD in the CD-ROM drive. When the installation key code 
screen appears, write down the key code and exit the installation program. Use that 
key code for the current installation.

If you are still unable to obtain your key code, call Technical Support for assistance at 
1-877-224-5934 (toll free).

� Can I run both the latest version of Enterprise Solutions and an earlier version of 
QuickBooks on the same computer?
Yes, as long as each version is installed in a different directory.

� What should I do if I want to go back to an earlier version of QuickBooks?
Uninstall the version you don’t want, and then reinstall the earlier version. Remember 
that updated company files cannot be opened in earlier versions.

� I received a replacement CD but can’t find my original key code. What should I do?
You must have a key code in order to install Enterprise Solutions from a replacement 
CD. If you can’t find your key code, see the question titled “What Should I do if I can’t 
find my installation key code.” 

� On how many computers can I install Enterprise Solutions?
When you buy Enterprise Solutions, your license agreement allows you to install the 
product on up to 10 computers.

If you need further assistance with installing Enterprise Solutions, please contact Technical 
Support at 1-877-224-5934 (toll free).
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Registering QuickBooks Enterprise Solutions

You can use QuickBooks Enterprise Solutions up to 5 times without registering. After your 
5th use, you must register to continue using it. We encourage you to register early. 
Registration entitles you to many benefits including technical support and the ability to use 
online features.

If you decide not to register when you get the registration message, click Remind Me Later. 
Enterprise Solutions will display occasional reminders about registration. You can also 
initiate registration on your own by phone or the Internet:

� By the Internet: Open your company file, and from the File menu choose Register 
QuickBooks Enterprise Solutions. In the Product Registration window, click Online 
and follow the directions on your screen.

� By phone: Open your company file, and from the File menu choose Register Quick-
Books Enterprise Solutions. In the Product Registration window, click Phone, then 
call the toll-free QuickBooks registration line.

Tip: Write down your registration number in the front of your Startup Guide (Copyright page). You will 
need it if you call technical support or if you apply for the QuickBooks Payroll Service or other 
online services. To see your registration number, choose About QuickBooks Enterprise Solu-
tions from the Help menu.

Going on from here

After installing the software, you’re ready to set your company up in QuickBooks Enterprise 
Solutions. The EasyStep Interview asks you simple questions about how your business works 
to walk you through the setup process. To determine what information you need to collect 
and start the EasyStep Interview, turn to “Setting up a new company” on page 33.

To learn more about setting up and using important features of QuickBooks Enterprise 
Solutions, turn to “QuickBooks Enterprise Solutions Basics” on page 81.

QuickBooks Enterprise Solutions file types

QuickBooks uses several types of files. Here are some of the more common ones:

� .QBW: Your company file. This contains your company set-up, and all the information 
you enter (customers, vendors, transactions, etc.) for your company.

� .QBB: A compressed backup of your company file.

� .QBX: A compressed version of an Accountant’s Review copy of your company file. See 
“Exporting data for your accountant (Accountant’s Review)” on page 30.

� .QBA: An Accountant’s Review copy of your company file that’s not compressed (that 
is, what your accountant gets when he or she opens the .QBX file you provided).

� .AIF: A special file containing the changes your accountant made to your company’s 
books in the .QBX file you provided. You merge the information from this file back into 
your regular company file (.QBW).
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If for some reason you can’t locate your company file (.QBW), you can use the Windows’ 
search feature to help you find it.

To search for your company file:
1 From the Windows Start button, select Search, then choose For Files or Folders. 

2 In the Search Results window, type *.QBW in the “Search for files named” field.

The asterisk symbol acts as a substitute for zero or more characters.

3 Choose a drive or folder in the “Look in” field.

4 Click Search Now.

If you need to reinstall QuickBooks Enterprise Solutions

Reinstalling QuickBooks Enterprise Solutions does not affect your company data in any 
way.

Reinstall QuickBooks Enterprise Solutions the same way you installed it (see “Installing 
QuickBooks Enterprise Solutions” on page 5). When the Installer asks for your Installation 
Key Code, enter the same code you used to install QuickBooks Enterprise Solutions the first 
time. You do not need to register QuickBooks Enterprise Solutions again unless you’ve 
moved it to a different computer.

When the Installer finishes, QuickBooks Enterprise Solutions looks forcompany files in its 
own directory. If your company files are in a different place, use the Open Company 
command to tell QuickBooks where to find your data.

Note: If you install a maintenance release for QuickBooks Enterprise Solutions, and then reinstall the 
program, you must also reinstall the maintenance release before you can work with your 
company file.
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Upgrading from earlier versions of QuickBooks 

Install terms explained

Throughout the installation process, we use some technical terms:

� Upgrade: 
The process by which you promote an earlier version of QuickBooks to a newer version. 
For example, if you currently have QuickBooks Pro 2003 and you bought QuickBooks 
Enterprise Solutions, you would be upgrading to the QuickBooks Enterprise Solutions 
version.

� Update: 
1) (noun) A newer release of the version of QuickBooks Enterprise Solutions that you’re 
currently using. Updates are also referred to as a maintenance releases or patches. 
2) (verb) The process of updating the format of an existing company file so that it can 
be opened with a newer version of QuickBooks Enterprise Solutions.

� Version (v): 
A release of QuickBooks Enterprise Solutions which is available through retail stores. 
These versions include enhancements and sometimes new features. 

� Maintenance release (R): 
Also called a patch or an update. A minor revision of QuickBooks Enterprise Solutions 
that you can download or install over your existing version of QuickBooks Enterprise 
Solutions. Maintenance releases are available throughout the year and can include the 
latest payroll or legal requirements, and feature additions. 

When Intuit publishes a maintenance release, a number is associated with it (for 
example, R4, R5 etc.). This number is important when it comes time to install a newer 
version of QuickBooks Enterprise Solutions, as it is a way for the Installer to determine 
which maintenance releases you installed in your previous version of the software. 

To tell what version of QuickBooks Enterprise Solutions you have:
1 Start QuickBooks Enterprise Solutions and open your company file. 

2 Press and hold the CTRL key, then also press 1 (the “1” above the letter “Q” on your 
keyboard, not the “1” on the keypad on the right).

3 The Product line tells you what version of the product you have, what release you have 
(“R”), and whether you have a Canadian version (“C”).

QuickBooks Enterprise Solutions can read and update all data created with earlier versions 
of QuickBooks (standard). 
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What happens when you upgrade

When you install QuickBooks Enterprise Solutions, the Installer searches for an older 
version of QuickBooks on your hard disk. If it finds one, the directory containing the older 
version becomes the directory for your new software unless you change it.

QuickBooks Enterprise Solutions will replace your older version of QuickBooks unless 
you specify a different directory during the installation.

QuickBooks Enterprise Solutions can directly update company files created with 
QuickBooks 6.0 or later. If you have several copies of QuickBooks using a company file 
shared on a network, you’ll need to upgrade each one to QuickBooks Enterprise Solutions.

To upgrade to QuickBooks Enterprise Solutions:

Once you upgrade an existing company file to QuickBooks Enterprise Solutions, that file 
cannot be read or used by other QuickBooks’ software such as Pro and Premier.

1 Install QuickBooks Enterprise Solutions according to the instructions on page 5.

2 When the Installer finishes, you’re prompted to restart your computer. Click Restart.

3 When your computer restarts, open QuickBooks Enterprise Solutions by double-
clicking the QuickBooks icon on your desktop.

Before you upgrade to QuickBooks Enterprise Solutions, you should:

1 Back up your company file to a set of new floppy disks (or your usual backup media). 
Ensure that all disks are labelled correctly and kept in a safe place in case you need 
them later. Do not overwrite this backup.

For instructions on making a backup, see the instructions that came with your older 
version of QuickBooks.

2 Verify your company file.

To verify data in most versions of QuickBooks, from the File menu, select Utilities, 
then Verify. In early versions of QuickBooks, see your documentation for instruc-
tions.

3 Create and print a Trial Balance for your company. For instructions on printing a 
Trial Balance, see the instructions that came with your earlier version of QuickBooks.

When you finish upgrading your software to QuickBooks Enterprise Solutions, 
create and print a second Trial Balance. Compare the two reports to confirm that all 
your accounts converted correctly.
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4 QuickBooks Enterprise Solutions looks for an existing company file to open.

� If it can’t find your existing company file, in the Welcome screen, select Open an 
existing company, then click OK.

� Now navigate to your company file, select it, and click Open.

When it detects that your company file was created using an earlier version of Quick-
Books, the Update Utility is opened. This utility updates the format of your company 
file so that it can be opened in QuickBooks Enterprise Solutions. 

Note: If your company file is password protected, you’ll need the Administrator’s 
password in order to open the company file. 

5 In the Update Company File to New Version window, type Yes and click OK to begin 
the process of updating your company file to QuickBooks Enterprise Solutions.

Some company files may require rebuilding of the data after updating to QuickBooks 
Enterprise Solutions. It can take more than 30 minutes, depending on the size of your 
company file.

6 In the Backup Company File window, do the following:

� In the Name field, keep the default name or type a new name for the backup file.

� If you do not want to save your backup file to the default location, click Browse to 
navigate to another location.

� Click Backup. To open this later, you’ll need to use the Restore feature.

QuickBooks Enterprise Solutions begins updating your company file and makes a 
backup file in the specified location. If you have a large company file, this process may 
take some time. Don’t interrupt QuickBooks or shut down your computer until the 
process is complete.

If the update process fails, try the procedure on page 14 to correct the problem, or 
contact Technical Support (see page 228) for assistance.

7 When the conversion finishes, click OK. The Update Utility closes.

8 You may want to verify your data:

� From the Window menu, select Close All.

� From the File menu, select Utilities, then Verify Data. 

� If verifying detects a problem, follow the onscreen instructions or contact 
Technical Support (see page 228).

9 Register QuickBooks Enterprise Solutions according to the instructions on page 8.
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To update a backup of your company file to QuickBooks Enterprise 
Solutions:

1 Install QuickBooks Enterprise Solutions according to the instructions on page 5.

2 When the Installer finishes, you’re prompted to restart your computer. Click Restart.

3 When your computer restarts, open QuickBooks Enterprise Solutions by double-
clicking the QuickBooks icon on your desktop.

4 On the File menu, click Restore. The Restore Company Backup window appears.

5 Make any necessary changes, then click Restore. When the file is restored, the Quick-
Books Update Utility launches.

6 In the Update File to New Version window, type Yes and click OK to begin the process 
of updating your company file to QuickBooks Enterprise Solutions.

QuickBooks begins updating your company file. If you have a large company file, this 
process may take some time. Don’t interrupt QuickBooks or shut down your computer 
until the process is complete. Doing so can corrupt your company file.

Some company files require rebuilding of the data after updating to QuickBooks Enter-
prise Solutions. This process can take more than 30 minutes, depending on the size of 
your company file. Don’t interrupt QuickBooks or shut down your computer until it is 
complete.

If the update process fails, try the procedure on page page 14 to correct the problem, or 
contact Technical Support (see page 228) for assistance.

7 When the conversion finishes, click OK. The Update Utility closes.

8 You may want to verify your data:

� From the Window menu, select Close All.

� From the File menu, select Utilities, then choose Verify Data. 

� If verifying detects a problem, follow the onscreen instructions or contact 
Technical Support (see page 228).

9 When the conversion finishes, click OK. The Update Utility closes.

10 Register QuickBooks Enterprise Solutions according to the instructions on page 8.
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If an update problem occurs

If your attempt to update your company file from an older version of QuickBooks fails, this 
procedure may correct the problem. If it is not successful, contact Technical Support (see 
page 228).

1 Reinstall your older version of QuickBooks into a completely new directory.

2 Install any maintenance release(s) available for the older version of QuickBooks that 
you were using.

3 Start the older version of QuickBooks, then restore the backup you made of your 
company file while attempting to update to your new version of QuickBooks. (See the 
documentation that came with your older version of QuickBooks for instructions on 
restoring a backup.)

4 From the Window menu, select Close All.

5 Start the Rebuild utility. (In many versions of QuickBooks, from the File menu, select 
Utilities, then Rebuild to start the Rebuild utility. In early versions, see your documen-
tation for instructions.)

6 When the rebuild completes successfully, back up the rebuilt file.

7 Exit from the older version of QuickBooks. (You can uninstall the older version of 
QuickBooks now, if you want.)

8 Reinstall QuickBooks Enterprise Solutions into the directory where you originally 
installed it.

9 When the Installer finishes, open QuickBooks Enterprise Solutions by double-clicking 
the QuickBooks icon on your desktop. 

10 From the File menu, choose Restore.

11 Navigate to the backup of the rebuilt company file (the file you created in Step 5). Select 
it, and then click Open.

12 Follow the instructions on your screen to restore and update your company file. If you 
are still having difficulties, call Technical Support (see page 228).

You’ll be asked to create several backups in this process. Do not overwrite 
the existing backup you used in Step 3!

Instead, use a new set of floppy disks for each backup (if you are backing up to your 
floppy drive) or give each backup a different name that you will remember (if you are 
backing up to your hard drive).
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about moving information to Enterprise 
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Converting data from Quicken
This section explains how to convert your Quicken data to QuickBooks Enterprise Solutions 
data and some of the differences between the two programs. After you finish converting, 
you’ll want to make some adjustments to your new company to take advantage of the 
QuickBooks Enterprise Solutions features that Quicken does not offer.

Note: Do not uninstall Quicken before installing QuickBooks Enterprise Solutions and converting to it.

Preparing your Quicken data for conversion

To make the transition to Enterprise Solutions as smooth as possible, you may need to make 
some changes to your:

Convert only the accounts you want to use in 
Enterprise Solutions

Before you convert to QuickBooks Enterprise Solutions, delete all accounts in Quicken that 
you know you won’t want in QuickBooks Enterprise Solutions. (In QuickBooks Enterprise 
Solutions, you can’t delete accounts that have transactions, but you can in Quicken. So it’s 
easier to delete the accounts you know you won’t want before you move to QuickBooks 
Enterprise Solutions.)

Note: All transfers to and from the deleted accounts will be converted as transactions to your opening 
balance equity account to ensure that your accounts balance.

You might want to delete accounts from your Quicken file in these situations:

� You have personal accounts as well as business accounts in your Quicken file.

Before you convert to QuickBooks Enterprise Solutions, back up your 
Quicken data file.

If you plan to continue using Quicken with this data (for example, if you have both busi-
ness and personal data in your Quicken file), make a copy of the Quicken file before you 
make changes. For instructions on backing up a Quicken file, see the documentation 
that came with your software.

QuickBooks Enterprise Solutions company files are not compatible with and cannot be 
converted back to  Quicken data files.

� Quicken Account list

� Memorized Transaction list

� Online banking accounts

� Names of customers on accounts 
receivable transactions
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� You have investment accounts in your Quicken file. 

If you do not delete your investment accounts, they will be converted to QuickBooks 
Enterprise Solutions "Other Current Asset" accounts (because QuickBooks Enterprise 
Solutions doesn’t track investments like Quicken does). You can either:

� Keep the "Other Current Asset" accounts as a way to include the value of your 
investments in your Enterprise Solutions balance sheet. In this case, you should 
continue tracking your investments in Quicken and update the balance of your 
Enterprise Solutions "Other Current Asset" accounts periodically.

� Or, delete the investment accounts from your Quicken file (so they are not brought 
into Enterprise Solutions at all) and continue to track the investments in Quicken. 
(The investments still appear in the copy you made of your Quicken data.)

Review your memorized and your scheduled 
transactions

If the QuickFill option for memorizing all transactions is turned off in Quicken, QuickBooks 
Enterprise Solutions converts both your memorized transactions and your scheduled 
transactions.

On the other hand, if the option is turned on, QuickBooks Enterprise Solutions converts 
only scheduled transactions and your transaction groups. It does not convert stand-alone 
memorized transactions.

So, if you have memorized transactions in Quicken that you’d rather not retype in 
QuickBooks Enterprise Solutions, you need to do one of two things:

� Turn off the QuickFill option for memorizing all transactions in Quicken. If your list of 
memorized transactions is very long, you may want to delete the ones you won’t need 
in QuickBooks Enterprise Solutions, or

� Put these transactions into a transaction group in Quicken. QuickBooks always 
converts transaction groups. After the conversion is complete, you can remove the 
memorized transactions from the group and use them as you did in Quicken. 

For information about transaction groups in Quicken, look in your Quicken guides.

Note: Memorized transactions from Quicken accounts payable will not work properly in QuickBooks 
Enterprise Solutions accounts payable. You should delete these before you convert your data.

If you have overdue scheduled transactions in your Quicken file, record them 
before converting.

For example, print any cheques you have pending.

To learn about… Search the Help index for…

Transactions group in QuickBooks memorized transactions, grouping 
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Make customer names consistent

When you convert to QuickBooks Enterprise Solutions, the names in your accounts 
receivable register become customers, and transactions become invoices and payments. If 
you accidentally used different names for the same customer in Quicken, QuickBooks 
Enterprise Solutions can’t link the customer’s invoices and payments correctly.

For example, if you have a customer listed as Dan Miller, D. Miller, and Daniel Miller, you 
should edit these names before you convert so that the customer goes by only one name.

If you use online banking

You can bank online with participating financial institutions through QuickBooks 
Enterprise Solutions just as you can in Quicken. However, not all institutions that work 
with Quicken also work with QuickBooks. Contact your financial institution before 
converting to confirm that it supports QuickBooks. If it does not, an online account in 
Quicken will not remain an online account after the conversion to QuickBooks Enterprise 
Solutions.

Tip: To see the current list of financial institutions that support online account access in QuickBooks 
Enterprise Solutions, choose Set Up Online from the Banking menu in QuickBooks, and then 
choose Online Financial Institutions List.

 

Converting your Quicken file to QuickBooks Enterprise 
Solutions

When QuickBooks Enterprise Solutions converts a Quicken data file, it doesn’t change it in 
any way. Also, Enterprise Solutions does not create any sort of link between your Quicken 
data and your new Enterprise Solutions company. Instead, it creates a completely new set 
of data files for you to use.

Your financial 
institution...

Comments What to do

Supports online account 
access in both Quicken 
and QuickBooks

You will need to re-enable 
your online accounts in 
QuickBooks after conver-
sion. See “Re-enable your 
online banking accounts” 
on page 21.

Supports online account 
access in Quicken, but 
not in QuickBooks

You are not able to use 
online account access in 
QuickBooks for this account. 
You could continue to use 
online account access in 
Quicken.

Select between the two 
choices described in “If 
your financial institution 
does not work online with 
QuickBooks Enterprise 
Solutions” on page 22.
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� If you’ve been using Quicken for Windows 5.0 or earlier, Quicken for DOS, or Quicken 
for Macintosh, call Technical Support for instructions (see page 228).

Quicken 2002, 2001, 2000, 98, and 6.0 for Windows

QuickBooks Enterprise Solutions can directly convert data from these products.

1 Install QuickBooks Enterprise Solutions according to the instructions on page 5.

2 Make sure that Quicken is not running.

3 Double-click the QuickBooks icon on your desktop to start your new software.

4 From the File menu, select Utilities, then Convert from Quicken.

5 Choose the Quicken file you want to convert, then click Open.

6 Follow the instructions on your screen to convert your file.

� If your Quicken file is protected with a password, QuickBooks prompts you to enter 
it. You then have to remove the Quicken password.

Fine-tuning your data after converting to QuickBooks 
Enterprise Solutions

After you convert your data from Quicken, you may need to make some additional 
adjustments to it before you start using Enterprise Solutions.

Edit your Other Names list

At the end of the Quicken conversion, unless you use Quicken Home and Business, you are 
asked to choose which account you used for Accounts Receivable (A/R). (QuickBooks 
Enterprise Solutions automatically recognizes the A/R account in Quicken Home and 
Business.)

As the conversion finishes, QuickBooks Enterprise Solutions gives you a list of names to 
which you made payments but which you have not used in your accounts receivable 
account. This list may contain not only the names of customers, vendors, and employees, 
but also descriptions such as “Deposit,” “Transfer,” and “Interest.”

You should change the names on the list to the correct type. (If you don’t change them 
now, they remain on your Other Names list so you can change them later, but you’ll have 
to do it one name at a time.)

If you want to use QuickBooks Enterprise Solutions account payable, be sure to move your 
Quicken payees (other than employees) from the Other Names list to the Vendor list. For 
more information, see “Changing to QuickBooks Enterprise Solutions accounts payable” on 
page 23.



20 Chapter 2   Importing and exporting data

To change types for names:
� In the Change Name Types window, click the corresponding column for each name 

you want to move. When all the names are marked correctly, click OK.

If you have different versions of one name

If you have slightly different versions of the same name (for example, Mike Rhymes, 
Michael Rhymes, and Michael P. Rhymes), QuickBooks puts each version of the name in 
the Other Names list.

In Enterprise Solutions, you can’t delete any name used in a transaction. However, you can 
merge the names to shorten the Other Names list.

Once you change the type for a name, you cannot undo it.

You can move names from the Other Names list to the Vendor, Customer:Job, or 
Employee lists. However, once moved, you cannot move a name again (although you 
can reset all names back to the Other Names list).

To restore all the 
check marks to the 
Other Name column, 
click Revert.

To learn about… Search the Help index for…

Changing the name type to a cus-
tomer, vendor, or employee

other names, list of

Merging similar names merging, list entries
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Fill in your company information

From the Company menu, choose Company Info, and fill in your company information. If 
you want QuickBooks Enterprise Solutions to track tax information for you, you must also 
select the tax form you file from the drop-down menu.

Turn on the QuickBooks Enterprise Solutions 
features you plan to use

In QuickBooks Enterprise Solutions, from the Edit menu, choose Preferences. Now you can 
customize Enterprise Solutions for your needs.

� If you collect sales taxes from customers (such as GST, HST, PST, or QST), turn on the 
GST/PST tracking preferences. For more information about tracking GST or PST, see 
“Gathering income tax information” on page 105.

� If you track inventory or write purchase orders, turn on the preferences for inventory 
and purchase orders. 

� If you plan to use QuickBooks Enterprise Solutions to pay your employees, see “Setting 
up payroll: an overview” on page 142.

 

Re-enable your online banking accounts

If you use online banking, you’ll need to re-enable your online accounts after you import 
them into QuickBooks Enterprise Solutions.

To re-enable your online accounts:
1 From the Lists menu in QuickBooks, choose Chart of Accounts.

2 Select your online account. Then click the Account menu button at the bottom of the 
window and choose Edit.

3 In the Edit Account window, click the Online Info tab.

If the account has no Online Info tab in the Edit Account window, it is not online in 
QuickBooks Enterprise Solutions. An account that was online in Quicken will not be 
online in QuickBooks Enterprise Solutions if the financial institution does not work 
online with QuickBooks Enterprise Solutions. 

� Select Online Account Access, then click OK.

To learn about… Search the Help index for…

Setting preferences preferences

To learn about… Search the Help index for…

Enabling accounts for online 
banking

online banking, enabling accounts
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If your financial institution does not work online with 
QuickBooks Enterprise Solutions

If your financial institution does not work online with QuickBooks Enterprise Solutions, 
your online accounts are converted to standard (not online) accounts.

� Notify the financial institution that you will no longer be using its online services.

� Alternatively, you could open an account with a financial institution that does work 
online with QuickBooks Enterprise Solutions.

Adjust your Opening Bal Equity account

QuickBooks Enterprise Solutions automatically creates an Opening Bal Equity account for 
you. When you create a new account and enter its opening balance, QuickBooks Enterprise 
Solutions enters that amount in the Opening Bal Equity account, so that your accounts 
balance. You can leave the Opening Bal Equity total alone, or you can distribute amounts 
from it to other equity accounts.

How QuickBooks Enterprise Solutions converts accounts 
receivable transactions

If you answered “Yes” to converting your Quicken asset accounts to QuickBooks Enterprise 
Solutions A/R accounts, QuickBooks converted the transactions as follows:

To learn about… Search the Help index for…

Distributing equity from before 
your start date

Opening Bal Equity account

Moving the amount in the Open-
ing Bal Equity account to other 
equity accounts

equity, transferring from Opening 
Bal Equity

This item in your Quicken A/R 
account...

...is converted to this in 
QuickBooks:

Each transaction that increases your A/R 
balance

An invoice to a customer

Each transaction that decreases your A/R 
balance and has only one split line

A payment from a customer

Each transaction that decreases your A/R 
balance and has more than one split line

A credit memo to a customer

Each payee A customer on your QuickBooks 
Customer:Job list
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QuickBooks Enterprise Solutions applies payments in Quicken to a customer’s oldest 
outstanding invoice first.

The conversion saves you the time of typing in all your accounts receivable transactions, 
but you’ll probably want to make some changes to the converted data. For example, if the 
category you used in most A/R transactions was “Sales income,” you’ll want to change the 
name of the converted invoice item from “Sales income” to the product or service you 
actually sell, such as “Consulting hours.” The income account, however, may be just fine 
as “Sales income.” 

You don’t have to make these changes now. QuickBooks Enterprise Solutions makes it easy 
to make changes at any time.

Changing to QuickBooks Enterprise Solutions accounts 
payable

If you used Quicken Home and Business, you may have had an Accounts Payable (A/P) 
account. QuickBooks Enterprise Solutions converts the transactions in this account into 
historical transactions in your journal, which indicate what you owe and to whom. The 
transactions do not appear in your QuickBooks Enterprise Solutions A/P account.

� In this case, track payments of outstanding bills only the same way you did in Quicken. 
However, enter any new bills with Enter Bills window (QuickBooks Enterprise Solutions 
creates a new A/P account for you the first time you enter a bill).

In all other versions of Quicken, the documentation explains how to set Quicken up for 
cash-basis accounts payable and for accrual-basis accounts payable. For a cash-basis system, 
Quicken recommends using a Bank account and simply postdating cheques. For an accrual-
basis system, Quicken recommends using an Other Liability account.

The transition to QuickBooks Enterprise Solutions accounts payable is the same for either 
system.

� If you used postdated cheques to track your bills, treat cheques you’ve already entered 
the same way you did in Quicken.

� If you had an Other Liability account in Quicken for accounts payable, it is now an 
Other Current Liability account in QuickBooks Enterprise Solutions.

No matter which method you were using in Quicken, from now on, use the Enter Bills 
window to track your bills. The Enter Bills window tracks your bills in the Accounts Payable 
account. To create this account, you can either:

Each category Both an item on your Item list and an 
income account on your Chart of 
Accounts

This item in your Quicken A/R 
account...

...is converted to this in 
QuickBooks:
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� Use the Other Current Liability account only for currently outstanding bills and let 
QuickBooks Enterprise Solutions create a new Accounts Payable account for you the 
first time you use the Enter Bills window. 

� Or, you can move the transactions in your Other Current Liability account to an 
Accounts Payable account (see below).

To move your Other Current Liability transactions to the Accounts 
Payable account:
1 In Quicken, create a report that gives you the total balance you owe each of your 

vendors. Make sure the date range is set to Include all dates, then print the report for 
reference.

2 Start QuickBooks Enterprise Solutions.

3 From the Banking menu, choose Make Journal Entry.

4 On the first line:

� In the Account field, choose Accounts Payable from the drop-down list.

� In the Name field, choose the vendor’s name.

� In the Credit field, type the open balance (you’ll need to do this for each vendor).

5 On the second line:

� In the Account field, choose the Other Current Liability account from the drop-
down list.

� In the Debit field, type the same amount that you entered in the Credit field of the 
first line.

6 Click Save & New.

Changing your payees to QuickBooks Enterprise 
Solutions vendors

If you haven’t already, you need to move your Quicken payees from the Other Names list 
to the Vendor list. See “Edit your Other Names list” on page 19.

If a Quicken payee had a balance that you converted to QuickBooks Enterprise Solutions, 
use Write Cheques until the balance of your old Quicken A/P account equals zero (you’ve 
paid off all your bills for that vendor). Enter any new bills into QuickBooks Enterprise 
Solutions accounts payable.

You also need to delete and re-enter any memorized transactions that QuickBooks 
Enterprise Solutions converted for you from Quicken accounts payable, as they will not 
work properly in QuickBooks accounts payable.

To learn about… Search the Help index for…

Deleting memorized transactions memorized transactions, deleting

QuickBooks accounts payable accounts payable
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Comparing QuickBooks Enterprise Solutions and Quicken

Once you understand the few terminology and feature differences between the programs, 
QuickBooks Enterprise Solutions will feel very familiar.

Terminology differences

Quicken uses terms familiar to anyone who has used a cheque book. QuickBooks Enterprise 
Solutions uses a few terms that are standard in business bookkeeping and that reflect the 
increased power and convenience of QuickBooks Enterprise Solutions for business.

This table lists the most important differences in terms. It does not list the many completely 
new QuickBooks Enterprise Solutions features and terms.

 

Quicken
term

QuickBooks
term

Definition

Account Balance sheet account A grouping of records related to one kind of 
asset, liability, or equity. 
These accounts appear on a balance sheet.

Category Income or expense 
account

A grouping of transactions related to one 
kind of income or expense. 
These accounts appear on a profit and loss 
statement (income statement).

Category and 
Transfer List
plus
Account List

Chart of Accounts The QuickBooks Chart of Accounts is like 
the Quicken Account list (balance sheet 
accounts) plus the Quicken Category list 
(income and expense accounts). 
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Feature differences

The following table lists features that exist in both Quicken and QuickBooks Enterprise 
Solutions, but that work differently in QuickBooks Enterprise Solutions than in Quicken.

Feature Quicken QuickBooks

Entering 
transactions

Enters most transactions in 
registers.

Enters most transactions in 
forms (cheque window, 
invoice window, and so on).
In QuickBooks, you can copy 
and paste a transaction from 
one register to another of the 
same type.

Write Cheques Displays a cheque that looks 
like a paper cheque.

Displays a business cheque 
with voucher area (so the 
“split” is part of the cheque 
form).

Classes Uses a slash (/) to separate a 
category from a class in trans-
actions.

Enters classes in separate 
fields. No need for a slash (/) as 
a separator. 
In QuickBooks, projects or jobs 
can be linked to customers as 
part of the Customer:Job list, 
so you can use classes for dif-
ferent kinds of classification.

Transfers Uses brackets [ ] to indicate a 
transfer to another balance 
sheet account.

No need to use brackets. 
QuickBooks handles transfers 
like any other transaction.

Passwords One password for entering and 
viewing data.

Customizable password and 
permission access for each 
person in your company.

Subaccounts Categories can have subcate-
gories, but accounts cannot 
have subaccounts.

Most accounts, even balance 
sheet accounts, can have sub-
accounts.

Payroll accounts 
(if you set up your 
accounts as 
described in the 
Quicken manual)

A separate liability account for 
each tax withheld and for 
every other payroll liability.

You can continue using your 
old liability accounts. How-
ever, by using payroll items, 
you can put all your payroll lia-
bilities into a single account.
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New and renamed balance sheet accounts

QuickBooks Enterprise Solutions and Quicken have similar kinds of balance sheet accounts, 
but QuickBooks Enterprise Solutions adds some types and uses different names for others. 
When you convert a Quicken file, the program automatically creates QuickBooks Enterprise 
Solutions accounts most like your Quicken accounts.

� In some cases, you may not want to use the account that QuickBooks Enterprise Solu-
tions creates auto-
matically. For example, Quicken sometimes uses liability accounts instead of equity 
accounts. In QuickBooks Enterprise Solutions, you can make them equity accounts.

� QuickBooks Enterprise Solutions changes your Quicken categories and subcategories 
into income and expense accounts with subaccounts.

When you convert from Quicken for Home & Business

After you have converted your Quicken for Home & Business data file to QuickBooks 
Enterprise Solutions, you’ll notice the following changes:

� The Invoice Items list is converted to the QuickBooks Items list.

� Each existing Invoice/Receivables account is converted to a QuickBooks Accounts 
Receivable account of the same name.

� Existing invoices are converted to QuickBooks invoices. However, they will appear in 
chronological order.

� Transactions linked to a customer remain linked.

Quicken 
account type

Converted to QuickBooks account 
type

Chequing Bank

Credit Card Credit Card

Cash Bank

Asset Other Current Asset

Liability Other Current Liability

Investment Other Current Asset

About payments, credit memos, and refunds.

Converted Quicken payments are always applied to the customer’s oldest outstanding 
invoice, so the payment links to invoices may be different after conversion. 

Credit memos and refund cheques, like payments, are also applied in chronological 
order based on invoice dates, so their links may also be different after conversion.
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Should you continue using Quicken for some things?

QuickBooks Enterprise Solutions does not change your original Quicken file in any way as 
it imports information from it, nor does it create any connection between it and your new 
QuickBooks Enterprise Solutions company. You can continue to use your original file with 
Quicken.

Once you’re using QuickBooks Enterprise Solutions for your business, you’ll probably want 
to continue using Quicken for your personal finance and investment accounts.

Here are some personal-finance activities you can perform only with Quicken:

� Track investments

Quicken includes investment tracking and reporting. Quicken updates the market 
values when you enter the latest share prices, and it reports on average annual total 
return, capital gains, and investment income.

� Amortize mortgage loans

Each time you record a payment on a loan, Quicken updates the number of payments 
made and calculates the amount credited to principal and interest.

� Create reports for personal finances

Quicken has many preset reports designed for personal use. 

Importing from / exporting to other software

Importing from other software

QuickBooks Enterprise Solutions can import information directly from some bookkeeping 
packages. To start the import wizard, from the File menu, select Utilities, then Import, then 
the software you are importing from. For help, click the Help button in the wizard.

With QuickBooks Enterprise Solutions, you can also import your contacts from Microsoft 
Outlook or Symantec ACT! (see page 30).

For all other software, QuickBooks Enterprise Solutions imports data in a format called IIF 
(Intuit Interchange Format), a special type of ASCII text file with headings to tell 
QuickBooks the type of information it contains. (This format is different from .QIF, used by 
Quicken.)

If you want to import data from other software programs, you need to create an IIF file from 
it or reformat data you already use to conform to IIF standards.

Do not use online banking for the same account in both programs.

If you track the same account in both Quicken and QuickBooks Enterprise Solutions, 
you can only use online banking in one program. If you try to use online banking for the 
same account in two different programs, it will not work correctly.
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Note: Creating an IIF file from scratch or changing data from another accounting program into an IIF 
file is not recommended unless you have programming experience. However, you do not need 
to learn about the IIF format to export lists and import them back into QuickBooks (see below).

Transferring lists between QuickBooks Enterprise 
Solutions companies

You can transfer a list (like the Customer:Job list) from one QuickBooks Enterprise Solutions 
company to another by exporting it to an IIF file, then importing it into the new company.

Note: When you import a list into an existing QuickBooks Enterprise Solutions company, QuickBooks 
replaces any duplicate entries with ones from the import file.

If you import customers or vendors from an IIF file, you’ll need to edit each one to add 
information such as payment terms. Also, if you have unpaid balances for a customer or 
vendor, you must enter an invoice or bill that at least tells the total amount owed.

Exporting to other software

When you export a list from QuickBooks Enterprise Solutions, it is automatically formatted 
as an IIF file. You can then import the IIF file into spreadsheets, word processors, database 
programs, or other QuickBooks companies. You can’t export transactions from 
QuickBooks, but you can create a report based on transactions and print it to a file that 
another program can import.

To learn about… Search the Help index for…

Creating an IIF file importing data

Method What it does Advantages Disadvantages

Print to disk Makes a copy of a list 
or report in a format 
common to other soft-
ware programs

You can import the file 
into a spreadsheet or 
word-processing program.

Only lists and reports can 
be printed to disk.
QuickBooks cannot read 
files printed to disk.

Export Puts lists into a file in 
IIF format, with one 
record per line and one 
column for each field

You can share lists with other 
company files or databases, 
word processosr, or spread-
sheets. You can add to the list 
and then import it back into 
QuickBooks.

QuickBooks can export 
only lists, not transactions 
or reports.

To learn about… Search the Help index for…

Exporting lists to another files exporting data
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Transferring information to Microsoft Word, Excel, 
Outlook, or Symantec ACT!

With QuickBooks Enterprise Solutions, you can easily export data to Microsoft Word or 
Excel and synchronize your contacts with Microsoft Outlook or Symantec ACT!

� If you use Microsoft Word as your word processor, you can use customer, vendor, 
employee, and other names in letters.

� If you use Microsoft Excel, you can export your QuickBooks report data to Excel for 
further customization and filtering. You can also export report data from multiple 
company files into one Excel spreadsheet.

� If you use Outlook or ACT!, you can synchronize your contact information with 
QuickBooks Enterprise Solutions.

Exporting data for your accountant (Accountant’s Review)

The Accountant’s Review™ feature allows an accountant to make certain kinds of changes 
in a special copy of your company file. Meanwhile, you can continue to enter daily 
transactions in the original (master) company file. After the accountant has made the 
changes, you merge them into the master company file.

To learn about… Search the Help index for…

Writing letters letters

Exporting data to Excel reports, exporting to Microsoft Excel

Synchronizing contact informa-
tion

contact management, synchroniz-
ing with a contact manager

You

Your
accountant

Start by creating an 
Accountant’s 

Review copy of your 
data for your 
accountant.

Continue using your 
company file for day-

to-day business 
tasks.

Merge your 
accountant’s 

adjustments into 
your QuickBooks 

company file.

Opens the 
Accountant’s 

Review copy in 
QuickBooks.

Reviews your data 
and makes 

adjustments.

Saves the 
adjustments to one 

or more disks.
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What can and can’t be changed

The Accountant’s Review feature may not be right for everyone. The accountant can make 
some kinds of changes but not others. The advantage of using the Accountant’s Review 
feature is that you can continue to work normally with your master company file (that is, 
the regular company file from which you make the Accountant’s Review copy). After the 
accountant has made changes, you can merge the changes into your master file.

Note: If you have set up users for your company (see “Working with multiple users” on page 97), your 
accountant will need the user name and password of the QuickBooks Administrator.

The table shows what an accountant can and cannot do while using an Accountant’s 
Review copy of your file, and any restrictions on you while this copy is out.

Your accountant 
can...

Your accountant 
cannot...

You cannot...

� View all existing
transactions and lists

� Add new items to the 
Chart of Accounts, Item 
list, To Do Notes list, and 
Memorized Transaction 
list (general journal 
transactions only)

� Enter transactions other than 
general journal
transactions

� Add new items to the 
Payroll Item list 

� Memorize transactions other 
than general journal transac-
tions

� Delete any items 
from lists

� Reorganize lists 
(move items, 
make one item a 
subitem of 
another)

� Create, edit, and print 
PD7A, T4, and Relevé 1 
forms

� Edit existing account 
names and numbers

� Edit account and tax 
information for existing 
items on the Item list

� Enter general journal 
transactions

� Reconcile new trans-
actions

� Adjust inventory values 
or quantities

� Create reports
� Change preferences 

temporarily
� Print T4A forms

� Edit existing payroll items
� Edit or delete existing transac-

tions, including pay cheques
� Reorganize lists (move items, 

make one item a subitem of 
another)

� Rename accounts or items
� Make items inactive
� Edit names of existing items 

on Item list
� Adjust payroll liabilities
� Enter or edit employee YTD 

payroll setup trans-actions
� Export changes to preferences
� Memorize reports
� Change a non-inventory part 

type to an inventory part type
� Merge new inventory part 

items with previous, existing 
inventory part items
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For accountants only:
working with an Accountant’s Review copy

The Accountant’s Review copy of a company file (which your client should create from his 
or her master company file) is a compressed, special type of company file. It has a .QBX 
extension instead of the usual .QBW or .QBB. When you start working with these files for 
the first time, QuickBooks Enterprise Solutions decompresses them to a .QBA file.

Note: If your client has set up users and passwords, you’ll need to find out the user name and password 
assigned to you or the QuickBooks administrator.

Once you have opened an Accountant’s Review copy, it remains the current QuickBooks 
Enterprise Solutions company unless you open a different company or you close the 
company. If you try to record a change that is not allowed, QuickBooks Enterprise Solutions 
tells you that it cannot record the change in an Accountant’s Review copy.

When you export your work from an Accountant’s Review copy, the changes to his or her 
company file are saved in a .AIF file. You should return this file to your client as soon as 
possible so it can be reintegrated with his or her .QBW file.

To learn about… Search the Help index for…

Setting up your accountant as a user with 
all privileges (if you have set up users)

permissions

Creating an Accountant’s Review copy of 
your current company file

accountant’s review copy

Merging the accountant’s file into the 
master company file

accountant’s review copy

Making the accountant’s revised copy 
your master company file

restoring data

Cancelling an Accountant’s Review copy accountant’s review copy

If your computer’s system date and time is earlier than the date and time that 
your client created the Accountant’s Review copy, you will not be able to 
open that copy.

To correct the problem you’ll need to determine which computer has the incorrect date 
and time, change the date and time, and try to reopen the copy. You may need to have 
your client cancel the first review copy and create another one for you.

To learn about… Search the Help index for…

Creating a file to give to your client accountant’s review copy
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Decisions to make before you start
In QuickBooks Enterprise Solutions, a "company file" contains all the financial records for 
a single business. Before you can use QuickBooks Enterprise Solutions, you need to tell it 
about your business so that it can set up your company file.

Locating an advisor to help you with QuickBooks Enterprise 
Solutions

Tip: Professional accountants and consultants can help set up your company file for you. To help 
small businesses find these professionals, Intuit Canada manages a referral service through the 
IntuitAdvisor program. The referral service connects small businesses working with QuickBooks 
Enterprise Solutions with accountants or consultants who are knowledgeable in QuickBooks 
Enterprise Solutions. The service is free - you simply pay the advisors’ fee for specific services 
you need.

These accountants and consultants possess the tools, resources, and knowledge to help you 
set up and maintain, and optimize QuickBooks Enterprise Solutions so that you can manage 
your business better.

You can locate a QuickBooks IntuitAdvisor in your area by using our no-cost online referral 
service on the QuickBooks.ca Web site (http://www.quickbooks.ca/). We suggest that you 
select two or three advisors and contact each to determine who would be right for your 
business. The advisor you select will provide you with information about his or her fees.

Becoming an IntuitAdvisor

If you are an accountant, bookkeeper, or computer consultant who supports small to 
medium business clients, you may want to consider becoming a member of this unique 
community. The program is intended to provide additional support to those people who 
service the needs of small business clients. It’s a great way to learn more about QuickBooks 
Enterprise Solutions as well as help you build your business.

By joining the program, you will receive the latest version of QuickBooks Enterprise 
Solutions plus all updates for it and payroll changes, additional training materials, 
invitations to training courses, informational emails, acces to an online forum, and referral 
programs. If you like, you can also have your name listed on our Web site to attract new 
QuickBooks Enterprise Solutions clients. To become an IntuitAdvisor or find one near you, 
visit the QuickBooks.ca Web site (http://www.quickbooks.ca/). 
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How many companies should you set up?

The Canada Customs and Revenue Agency (formerly called Revenue Canada) requires that 
for each business you have, you clearly show its income and expenses. For tax purposes, it’s 
usually best to set up a separate QuickBooks company for each business that files its own 
tax return.

If you have multiple company files, you can combine data from those company files in to 
one report. See “Combining reports from multiple company files” on page 91 for more 
details.

For example, if you have two shops and file one tax return for each, you need to set up two 
company files in QuickBooks Enterprise Solutions. However, if you have a farm that grows 
wheat and raises pigs and you file only one tax return for the entire operation, you only 
need one company file in QuickBooks Enterprise Solutions.

If you have one business but need to track different segments of it, set up one company file 
in QuickBooks Enterprise Solutions and use classes. These are a way of categorizing income 
or expenses in addition within income or expense accounts. For example:

You can set up subclasses of existing classes if you need to subtotal information about 
classes on reports.

Use classes to track the following Industry examples

Account executives Advertising, Consulting

Partners Law firms, Consultants

Construction industry standard categories (General, 
Site Work, Concrete, Masonry, and so on)

Construction contractors

Departments Businesses that budget by 
department, Retailers

Funds (General, Building, Outreach, and so on) 
You could start with two main classes for restricted 
and unrestricted funds, and then make each fund a 
subclass of a main class.

Nonprofit organizations, 
Religious groups

Locations (if the business has more than one) Restaurants, Retailers, 
Service businesses 

Manufacturers or Product lines Distributors, Manufacturing 
reps, Sales agents

To learn about… Search the Help index for…

Turning on the preference for 
using classes

classes, turning on in QuickBooks

Adding classes and subclasses classes, adding
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What accounting do I need to know?

Using QuickBooks Enterprise Solutions requires very little accounting knowledge. You need 
to understand a chart of accounts and the different types of accounts on it. You don’t have 
to know about debits and credit, journal entries or closing periods.

Your company’s chart of accounts

When you keep books for a business or organization, you want to track where your income 
comes from, where you put it, what your expenses are for, and how you pay them. You track 
this flow of money through a list of accounts called the chart of accounts. Your QuickBooks 
Enterprise Solutions chart of accounts can have:

� Balance sheet accounts

� Income accounts

� Expense accounts

� Cost of goods sold accounts

� Non-posting accounts (includes purchase orders and estimates, which do not appear on 
your balance sheet)

Some of these accounts are created for you automatically. For example, the first time you 
create an invoice or statement charge, QuickBooks Enterprise Solutions automatically 
creates an accounts receivable (A/R) account. You’ll add other accounts, such as your 
chequing account, during setup using the EasyStep Interview. You can create and modify 
your accounts as needed at any time.

Types of accounts

Balance sheet accounts

Your chart of accounts includes balance sheet accounts. These accounts track the following:

� What you have (assets)

� What people owe you (accounts receivable)

� What your company owes to other people (accounts payable and other liabilities)

� The net worth of your company (equity)



Decisions to make before you start 37

The following table describes the various types of QuickBooks balance sheet accounts.

Balance sheet 
account type

QuickBooks 
account type

Use to track

Asset What you have and what people owe you

Bank Transactions in chequing, savings, and money 
market accounts. You can also use this type of 
account for petty cash.

Accounts Receivable 
(A/R)

Transactions between you and your customers, 
including invoices, statement charges, pay-
ments from customers, deposits of customer 
payments, refunds, and credit memos. 
QuickBooks automatically creates an A/R 
account when you first create an invoice or 
statement charge.

Other Current Asset Assets that are likely to be converted to cash or 
used up within one year, such as the value of 
your inventory on hand, notes receivable due 
within a year, prepaid expenses, and security 
deposits.

Fixed Asset Depreciable assets your business owns that 
aren’t liquid (not likely to be converted into cash 
within a year), such as equipment, furniture, or 
a building.

Other Asset Any asset that is neither a current asset nor a 
fixed asset, such as long-term notes receivable.

Liability What your company owes to other people

Accounts Payable (A/P) Outstanding bills. When you first enter a bill, 
QuickBooks automatically creates an A/P 
account.

Credit Card Credit card transactions for your business 
expenses. One account per credit card.

Other Current Liability Liabilities that are scheduled to be paid within 
one year, such as sales tax, payroll taxes, 
accrued or deferred salaries, and short-term 
loans. Some businesses include the current por-
tion of long-term liabilities in this kind of 
account. 

Long-Term Liability Liabilities such as loans or mortgages sched-
uled to be paid over periods longer than one 
year.
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Balances for balance sheet accounts

The Chart of Accounts window shows a balance for each balance sheet account (except for 
the special equity account, Retained Earnings).

Income and expense accounts

Income and expense accounts track the sources of your income and the purpose of each 
expense. When you record transactions in a balance sheet account, you usually assign the 
amount of the transaction to one or more income or expense accounts. For example, you 
not only record that you took money out of your chequing account, but you keep track of 
what you spent the money on, such as utilities, advertising, or office supplies.

There are no registers for income and expense accounts, but you can create reports to show 
totals for these accounts over a period of time.

Equity Net worth of your company 

(equity = assets – liabilities)

Equity A company builds equity from three sources:
� Investment of capital in the business by the 

owners
� Net profit from operating the business during 

the current accounting period
� Retained earnings, or net profits from earlier 

periods that are carried forward into the cur-
rent fiscal year and that have not been distrib-
uted to the owners

Balance sheet 
account type

QuickBooks 
account type

Use to track

One of the first things you 
should do when you open a 
business is open a business 
chequing account.
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Cost of goods sold (COGS) account

Many businesses that track inventory have one cost of goods sold account, which is similar 
to an expense account. A COGS account contains the cost of inventory you have sold.

Reports that measure business profitability

The value and performance of your company can be summarized by two reports: the 
balance sheet and the profit and loss statement. How you set up your accounts will greatly 
influence the level of detail you can get on these reports. You may also want to create the 
statement of cash flows report, which details the net change in your cash during a period.

The balance sheet

A balance sheet is a financial snapshot of your company on one given date. This report is 
useful when applying for a business loan or at year-end to get an account of your company’s 
equity, assets, and liabilities.

Rock Castle Construction
Balance Sheet

As of March 31, 2002
                                   
                                                    
ASSETS

Current Assets
Chequing/Savings 29,454.55
Accounts Receivable 94,246.05
Other Current Assets 93.19

Total Current Assets 123,793.79

Fixed Assets 43,900.00
TOTAL ASSETS 167,693.79

LIABILITIES & EQUITY
Liabilities
Current Liabilities
Accounts Payable 44,118.16
Credit Cards 1,129.36
Other Current
Liabilities 2,655.72

Total Current 
Liabilities 47,903.24

Long Term Liabilities 8,470.96
Total Liabilities 56,374.20

Equity 111,319.59
TOTAL LIABILITIES & EQUITY 167,693.79

Assets include what you have and what 
people owe you. Examples include: 
� cash on hand
� money in your chequing account
� money you are owed
� furniture
� vehicles

total assets = total liabilities + equity

Liabilities include what your company 
owes to other people or your company 
debts. Examples include: 
� unpaid bills
� money you owe on credit cards
� loans
� sales tax you owe

Equity is the net worth of your company:

equity = assets - liabilities
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The profit and loss statement

A profit and loss statement, also called an income statement, shows your income and 
expenses over a period of time.

Page 2

Your cost of goods sold account always 
appears after income accounts and before 
any other expense accounts, so you can see 
what your net income is before subtracting 
your business’s indirect expenses, such as 
utilities and office supplies.

Net income = income - expenses
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The statement of cash flows

The statement of cash flows summarizes your sources (inflows) and uses (outflows) of cash. 
From the report, you can see how your cash position changed over a period of time. 

This shows how 
much cash was 
provided by 
profit-making 
activities.

This shows how 
much cash was 
provided by 
long-term 
liabilities and 
equity.

QuickBooks Enterprise Solutions also has the capability to 
display investing activities, which show you how much was 
invested in assets such as equipment and furniture.
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What accounting method should I use?

Cash versus accrual bookkeeping

There are two common methods of bookkeeping: cash and accrual. Your method 
determines how you report income and expenses on your tax forms. When you begin 
your business, you need to decide which bookkeeping method to use.

It’s best not to switch to a different accounting system after you’ve selected one. However, 
you can switch between cash and accrual reports in QuickBooks Enterprise Solutions at any 
time, without affecting your accounting records. By default, QuickBooks Enterprise 
Solutions creates reports on an accrual basis. To change reports (except a transaction report) 
to cash basis, search the Help index for "Reports: cash vs. accrual."

Cash basis

Some small businesses record income when they receive the money and expenses when 
they pay the bills. This method is known as bookkeeping on a cash basis. If you’ve been 
recording deposits of your customers’ payments but haven’t been including the money 
customers owe you as part of your income, you’ve been using cash basis accounting. 
Similarly, if you’ve been tracking expenses at the time you pay them, rather than at the time 
you first receive the bills, you’ve been using cash basis accounting.

Accrual basis

In accrual-basis bookkeeping, you record income at the time you make the sale, not at the 
time you receive the payment from the customer. Similarly, you enter expenses when you 
receive the bill, not when you pay it. Most accountants feel that the accrual method gives 
you a truer picture of your business’s finances.

How your bookkeeping method affects QuickBooks 
Enterprise Solutions

QuickBooks Enterprise Solutions allows you to enter your transactions the same way no 
matter which method you use for taxes. When you first install QuickBooks Enterprise 
Solutions, however, it uses accrual-basis accounting by default. For example, it shows 
income on a profit and loss statement for invoices as soon as you record them, even if you 
haven’t yet received payment. It shows expenses as soon as you record bills, even if they are 
unpaid.

You can see any report (except transaction reports) on a cash basis by changing the 
reporting preference. (For more information, search the Help index for “Reports: cash vs. 
accrual.”)

The Canada Customs and Revenue Agency (CCRA) requires accrual-based 
bookkeeping for businesses that collect GST except for farmers, fishers, and 
a few other specified businesses.

Check with your accountant or the CCRA before you make your choice.
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Determining a start date

New Business

If your business has no financial transactions yet (that is, you are starting up your business 
at the same time you are setting it up in QuickBooks Enterprise Solutions), your start date 
is today. You can go on to “Information to collect” on page 44.

Existing Business

Your start date is the date on which you begin managing your business finances in 
QuickBooks Enterprise Solutions. It determines what information you need to enter in the 
Interview and afterwards.

For example, you could choose today as your start date, in which case you will need to enter 
how much money you have in each of your accounts and the amounts that your customers 
owe you and you owe your suppliers. Or, you could choose an earlier date, in which case 
you’ll also need to enter all the business transactions you’ve made between your start date 
and today.

The advantage of choosing today as your start date is that you don’t need to enter many 
historical transactions, which saves you time. The advantage of choosing an earlier date 
(and entering your business’ historical transactions) is that you’ll be able to see a lot more 
detail in your business reports.

To choose a start date that’s best for your company, consider these questions:

� When does your company’s fiscal year start?

� How close is today to the end of your fiscal year?

� Do you have an accurate balance sheet for your current fiscal year?

� Do you have an accurate profit and loss statement (also called an income statement) 
for your current fiscal year?

� How far back in time are you willing to enter historical transactions (old invoices, bills, 
bank account transactions)

� Will you be tracking payroll in QuickBooks Enterprise Solutions?

Note: Although you can change your start date later, your start date determines much of your setup. 
It’s much easier to decide on the best start date now than change it later.

If it’s almost the end of your company’s fiscal year, consider finishing it using your old 
system of bookkeeping. Then set up your company in QuickBooks Enterprise Solutions with 
a start date of your fiscal year-end so you can use QuickBooks Enterprise Solutions for the 
new fiscal year. You’ll have the detail for each fiscal year, and you won’t have to do a lot of 
work setting up.
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If it is not near the beginning of your fiscal year, decide which is more important to you:

� Do you want to have full detail in QuickBooks Enterprise Solutions for the current fiscal 
year?

OR

� Do you want to enter relatively few historical transactions (covering the period 
between your start date and today)? If you’re not going to enter your historical infor-
mation for the full fiscal year, you may want to choose a start date at the beginning of 
a calendar quarter, especially if you’re going to use QuickBooks Enterprise Solutions 
payroll.

If your business generates a lot of invoices, bills, or cheques, you probably don’t want to 
enter more than three months of historical transactions. On the other hand, if your 
business has relatively few transactions, you may be willing to enter several months of 
historical detail.

Information to collect

Who owns your business?

First, determine how your business is owned. Is it a sole proprietorship, a partnership, or a 
corporation? The differences include the tax form you file (T1 or T2), your income tax filing 
deadlines, and how your profits are apportioned.

� Sole proprietorships: A sole proprietorship is an unincorporated company owned by 
one person.

� Partnerships: A partnership is an unincorporated business owned by two or more 
persons. In a partnership, each partner owns a share of all assets and liabilities. Each 
partner may have invested in the partnership, and each receives a specified share of 
profits. Partners do not receive salaries, but they may withdraw money against their 
share of profits.

� Corporations: A corporation is owned by its stockholders. Unlike a sole proprietorship 
or a partnership, a corporation can pay a working owner a salary.

Are you registered to collect sales taxes?

Although very small businesses are exempt, the Canada Customs and Revenue Agency 
recommends that all businesses register to collect the GST. When your company’s sales 
exceed a certain level, the CCRA requires you to register. Check with your local CCRA office 
about whether your company needs to be registered, and if so, how to go about it.

Registered businesses track the GST (or HST) paid on purchases for the business and 
collected from customers on sales. Usually, the business owner collects more sales tax 
than he or she pays out and remits the difference to the CCRA.
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Many provincial governments also require businesses to register to collect a provincial sales 
tax (PST or QST). Check with your province’s Minister of Finance for the requirements for 
your business.

Other important information you’ll need

This table lists the information you’ll need to complete the EasyStep Interview and where 
to find it. You’ll enter most of this information in the Interview, but some you’ll need after 
you finish the Interview and are completing your company setup.

Information you need Where to find it �

Company legal name and address Owner, your accountant, or tax 
forms.

❏

Federal business number. You must have a business 
number if you
� collect the GST, or
� pay wages to employees.

Canada Customs and Revenue 
Agency (CCRA), formerly Revenue 
Canada.

❏

The dates of your accounting period: 
� first month of your fiscal year
� first month of your income tax year, and
� your QuickBooks Enterprise Solutions start date

Your records or accountant. ❏

Income tax form your business will file
Tip: When the EasyStep Interview asks you, select the 
income tax form your company uses. QuickBooks Enter-
prise Solutions uses this information to associate 
accounts with tax form lines and create tax reports.

Your accountant, CCRA, or 
tax forms.

❏

Chart of accounts for your business
Tip: If you do not have an existing chart of accounts, 
don’t worry. The EasyStep Interview helps you choose 
an appropriate chart of accounts for your industry.

Your accountant or previous book-
keeping method.

❏

Names of the people in your company who will use 
QuickBooks Enterprise Solutions, and which areas of 
your financial records you want them to have access to.

See “Working with multiple users” 
on page 97.

❏

Balances for these accounts:
� Credit card
� Line-of-credit
� Loan
� Bank

� Statements covering your start 
date up to today for all bank 
accounts, including chequing, 
savings, and GICs.

� All uncleared cheques, deposits, 
or other items (credit card 
receipts, for example).

� Balance sheet prepared by your 
accountant.

❏
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How much GST/PST you owe. Accountant, CCRA, or provincial 
Minister of Finance

❏

List of types of items you sell (products and services), 
including:
� Item number or name
� Current sales price or hourly rates
� The tax code that is usually associated with the item
� Income account for tracking sales of the item
For inventory only:

� Purchasing cost
� Quantity in inventory
� Total value of inventory for the item

Your company records. ❏

List of customers, including:
� Addresses
� Contact names
� Phone numbers
� Outstanding invoices

Your company records. ❏

List of vendors, including:
� Addresses
� Contact names
� Phone numbers
� Outstanding bills

Your company records. ❏

Value of your assets
For fixed assets, you also need the original cost and 
accumulated depreciation.

Balance sheet prepared by your 
accountant.

❏

Equity information
All the money you have put into the company, plus the 
sum of the retained earnings (the net profit or loss) for 
each year your company has been operating.

Your accountant. ❏

Payroll information See “Setting up payroll: an over-
view” on page 142 for details.

❏

Information you need Where to find it �
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Starting the EasyStep Interview
The EasyStep Interview walks you through the process of setting up your entire business in 
QuickBooks Enterprise Solutions. It takes about an hour to complete, but if for some reason 
you need to exit the interview, you can click Leave at any time. 

Tip: For a list of the questions that appear in the Interview, see the EasyStep.txt file in your Quick-
Books Enterprise Solutions directory. You can use this list to organize your information for the 
Interview.

Starting the Interview the first time you start QuickBooks Enterprise 
Solutions:
� The first time you start QuickBooks Enterprise Solutions, it displays a window with 

several options. One is to create a new company. Choose this option to start the 
EasyStep Interview. You can also start the EasyStep Interview by choosing New 
Company from the File menu.

QuickBooks Enterprise Solutions displays the EasyStep Interview window.

If you don’t see this 
window when you start 
QuickBooks Enterprise 
Solutions, from the File 
menu, choose New 
Company.
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Opening the EasyStep Interview at other times:
� With your company file open, choose EasyStep Interview from the File menu. The 

interview picks up where you left it and you can continue on.

Getting around in the EasyStep Interview

The EasyStep Interview is broken into six sections. After you complete all the sections, your 
company file contains basic information about your business.

� General: Lets you enter company information, choose a chart of accounts appropriate 
for your business, decide on QuickBooks preferences, and specify a business start date.

� Income & Expenses: Lets you review the income and expense accounts on your 
business’s chart of accounts and create new accounts, if needed.

� Income Details: Lets you specify whether your business income is from services and/or 
products you sell. Based on the information provided, QuickBooks Enterprise Solutions 
determines which income tracking and accounts receivable features you need.

� Opening Balances: Lets you enter information about the customers who owe you 
money as of your start date, vendors to whom you owe money as of your start date, and 
balances in your balance sheet accounts as of your start date.

You can’t change information by returning to the EasyStep Interview and 
answering the questions differently.

If you need to change information you entered in the EasyStep Interview, change it 
directly in QuickBooks Enterprise Solutions. The EasyStep Interview is designed to help 
you with the initial set up of your company file, not for editing it.

The tabs along 
the top show 
topics within one 
section.

A check mark 
indicates the 
completed topic.

The major sections of the 
Interview are divided along the 
side.

A check mark indicates that all 
the topics in the section are 
complete.

Click Prev to 
return to a 
previous window 
in the Interview 
and click Next to 
move to the next 
window in the 
Interview.

When you see a More button, 
click it to get specific 
information about the question 
being asked in the Interview.

Complete the General section of the Interview before going on to other areas.

Enterprise Solutions won’t know enough about your company to ask the rest of the 
Interview questions unless you fill in your basic company information and start date 
first.
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� Payroll: Lets you enter information like Social Insurance Number and birth date for 
your employees, set how often you will pay them, and set up payroll items (which you 
use to assign rates of pay, income taxes, and other deductions and additions to pay 
cheques for employees).

� What’s Next: Describes some common tasks in QuickBooks Enterprise Solutions that 
you may want to complete after you have finished the Interview.

Completing the EasyStep Interview
The EasyStep Interview asks questions about your business. It uses your answers to set up 
the appropriate accounts and lists and get you started quickly.

General section

The General section of the EasyStep Interview allows you to enter some basic company 
information and set some QuickBooks Enterprise Solutions preferences.

1 In the first screen of the Welcome tab, click Next to begin.

2 Since you are setting up a new company in QuickBooks Enterprise Solutions — not 
upgrading a company file from a previous version of QuickBooks — click Next to go on.

3 Read each page of information in the Welcome tab, then click Next. When you 
complete the Welcome section, QuickBooks Enterprise Solutions places a check mark 

 on its tab and moves to the Company Info tab.

1 Read the first page of the Company Information tab, then click Next.

2 In the Company Name field, type your company’s name and press TAB. The name you 
typed is copied into the Legal Name field.

� The legal name is the name that your lawyer registers for you. This process 
involves a provincial and sometimes federal search for companies using the same 
name.

� In most cases, the company name is the same as the legal name. If you plan to use 
a company name other than your legal company name, it’s best to seek advice 
from your lawyer first.

When you’re finished, click Next.

Some questions ask you to make a decision that is not easily reversed.

When this is the case, you’ll see a warning symbol: 
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3 Type the complete address of your company, then click Next.

This address is used for cheques, invoices, and other forms.

4 In the “Other Company Information” window, select:

a the first month of your company’s income tax year (that is, the first month of the 
period covered by your company’s tax return).

b the first month of your company’s fiscal year (that is, the first month of your 
accounting year).

Note: For most businesses, the first month of the income tax year and the fiscal year are the 
same; however, in special cases, these dates may differ. Your accountant can help you 
determine what’s right for you.

c Select the tax return that your business uses:

- Personal Income Tax - T1: for individuals, unincorporated businesses, and 
partnerships

- Corporate Income Tax -T2: for incorporated businesses

d Choose the province where your company does business. The province you choose 
determines what taxes QuickBooks Enterprise Solutions tracks on sales and 
purchases and applies to employees’ pay cheques.

e If you have one, enter your company’s Business Number. Usually, the CCRA 
(Canada Customs and Revenue agency; formerly Revenue Canada) assigns this 
number when you register to collect the Goods and Services Tax (GST) or to pay 
employees.

5 Click Next. Now the Interview will help you customize QuickBooks Enterprise Solu-
tions for your business and create income, expense, and other accounts for your 
company.

Type of Business

When you set up your company in QuickBooks Enterprise Solutions, you can select a type 
of business that most closely matches your own. This allows QuickBooks to set up a chart 
of accounts tailored to your needs and other options like payment methods, customer and 
vendor types, and payment terms.

1 In the “Select your Type of Business” window, select the industry type that best 
describes your company.

Note: Once you accept the chart of accounts for a certain type of business, you can’t change to a 
different type of business (unless you start over with a new company file), but you can add, 
change, or delete accounts and set QuickBooks Enterprise Solutions preferences for your 
specific needs.
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2 Read the information about the business type you want, clicking Next until the Save 
As window opens.

3 Keep the name that appears or type a name for your company file in the File Name 
field, then click Save. A file is created that contains the company information you’ve 
entered so far.

4 Examine the income and expense accounts QuickBooks is creating for you to make sure 
they match the way your business works.

Note: If these accounts don’t make sense for your business, click Previous until you reach the 
"Select your Type of Business" window and choose a different type of business.

After you leave the Interview, you can change the name, description, and opening balances 
(opening balance can be changed in the account's register). The account currency or 
retained earnings can’t be changed.

5 Select Yes to accept the preset accounts for your business type or No to create your own 
accounts later in the Interview, then click Next. The “Accessing your company” 
window appears.

6 In the “Accessing your company” window, enter the number of people who need to 
work with your QuickBooks Enterprise Solutions company file.

� If you leave the number at 0 (zero), you’ve completed this tab and can click Next 
twice to go on to the Preferences tab.

� If different people need to work with your company data, when you click Next, 
QuickBooks Enterprise Solutions provides you with information about how you 
can set up your company file to accommodate different needs. Read the infor-
mation, then click Next twice to go on to the Preferences tab.

Note: Several users can use your company file at the same time through your company’s network. 
For more information, see “Working with multiple users” on page 97.

7 A check mark  is placed on the Company Info tab to show that you’ve completed it 
and moves to the Preferences tab.
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1 In this tab, you indicate which features of QuickBooks Enterprise Solutions you want 
to use. Read the information in the "What are your preferences" window, then click 
Next.

2 In the “Inventory” window, select Yes if your company buys items from a vendor, 
keeps them in stock, and resells them to customers. Otherwise, click No. After you’ve 
made your choice, click Next.

Note: Depending on the type of business you chose earlier, you may not be able to turn on 
Inventory at this time. If you need Inventory and cannot turn it on now, you can do so when 
you leave the Interview. From the Edit menu, choose Preferences. Click Purchases & 
Vendors, then click the Company Preferences tab, and select the Inventory and 
purchase orders are active checkbox.

� If you maintain Inventory, select Yes to set up inventory items now or No to do it 
when you leave the Interview, then click Next.

� If you select Yes to set up inventory items, you’ll be asked whether you’d like to 
track different units of measure for your inventory items. Select Yes if you have 
different units of measure for inventory items.

3 In the "Enabling Multicurrency" window, select Yes if you deal with foreign customers 
or vendors in their own currency, or No if not, then click Next. 

Federal and provincial sales tax preferences

One of QuickBooks Enterprise Solutions very useful features is its ability to track the GST 
(or HST) and your province’s sales tax, if it has one. After you turn on sales tax tracking, the 
correct taxes are automatically applied to sales and purchases and records the tax in the 
appropriate accounts.

Once multicurrency is turned on, you cannot turn it off. Only turn it on now 
if you are sure you will need it — you can always turn it on later.

For more information about setting up and using Multicurrency, see Chapter 5.

If you use sales tax tracking, after completing the Interview, turn to 
“Tracking and paying sales taxes” on page 115 for important information 
about using this feature.
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There are several options within the sales tax portion of the Preferences tab. To make it 
easier for you to follow, we’ve plotted out the steps in the flowchart below.

In QuickBooks Enterprise Solutions, it’s possible to assign a tax code to a customer that will 
override the tax codes you assign to the items or services you sell. For example, if you sell 
to a branch of the government that is exempt from all sales taxes, you can assign it an “E” 
(for exempt) tax code. The “E” tax code then appears on all invoices you create for this 
customer, for all the items it buys, instead of the tax codes you assigned to the items or 
services you sell.

If you have customers who have special tax status, you can turn on customer tax codes. 
Then you can assign each customer a tax code as you set him or her up. If you have many 
customers who have the same special tax status, you can set a default tax code that applies 
to all new customers you create. However, except for this specific case, it’s usually best to 
leave this option off.
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Invoice format

Tip: Later, you can customize these invoice formats further suit your needs.

1 Here, you choose the format of invoice that’s best for your business. In the “Your 
invoice format” window, select an invoice type:

� Product: For businesses that sell goods or products and need fields for shipping (for 
example, a retail store).

� Professional: For businesses that sell services and need a lot of room to describe 
them (for example, a public relations consultant).

� Service: For businesses that primarily provide services, but that also sell some 
products (for example, an interior design firm).

� Custom: For businesses that want to create their own invoice format.

2 Click Next to go on.

Other preferences

1 In the “Employees” window, enter the number of employees you have. Do not include 
owners (likely yourself), your partners (if more than one person owns the business), or 
the subcontractors you hire. Click Next to go on.

� If you don’t have any employees, you’re taken to the next step.

� If you have employees and want to use QuickBooks Enterprise Solutions to pay 
them, click Yes to the message and go on.

When you’ve chosen, click Next.

2 In the “Estimates” window, select Yes if your company provides estimates to customers 
or No if not, then click Next.

Yes You can now choose whether you want to use Progress Invoicing. Progress 
invoices are invoices for a percentage of the total owed to you based on how 
much of the work you have completed. They are based on the estimate you 
provided to your customer.

Select Yes if you want to use progress invoices or No if not, then click Next to go 
on to the next step.

No If you don’t use estimates or progress invoices, go on to the next step.

3 In the “Time Tracking” window, select Yes if you want to track the amount of time 
your employees or subcontractors work on each project and create pay cheques based 
on time, or No if not, then click Next.

4 Classes are a way to track specific areas of your business. You can use them in any 
way that is meaningful to you, like tracking different sources of income and expenses, 
separating business enterprises, keeping departments or properties straight, etc. For 
example, a contractor might classify his or her income and expenses as either resi-
dential or commercial work.

If you want to use Class Tracking, select Yes, or No if not, then click Next.
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5 Some small business owners pay their bills when they receive them. Most business 
owners, however, find it more convenient to pay bills in batches as they prefer to keep 
the cash in the company for as long as possible. 

If you don’t pay your bills immediately, QuickBooks Enterprise Solutions can help you 
keep track of what you owe and when it is due with an Accounts Payable account.

In the “Two ways to handle bills and payments” window, choose what you want to do, 
then click Next.

� Enter the cheques directly: You’ll pay bills immediately (no accounts payable).

� Enter the bills first then enter the payments later: You’ll record bills when you 
receive them and pay them later (using accounts payable).

6 QuickBooks Enterprise Solutions can remind you when it’s time to pay bills; print 
cheques and other forms; act on overdue customer accounts; and so on. Each reminder 
you set up appears on the Reminders list. 

Choose how often you want to see the Reminders list, then click Next.

� At start up: The Reminders list appears when you start QuickBooks Enterprise Solu-
tions. 

� When I ask for it: The Reminders list appears when you call it up.

� Rarely: QuickBooks Enterprise Solutions occasionally displays the Reminders list 
for you.

7 Here, you can choose to use a cash or accrual basis reporting. Most people will want to 
use the same reporting basis and accounting basis.

This preference does not affect reports that list individual transactions (which are 
always on a cash basis) or GST/PST Liability reports (which are always on an accrual 
basis).

In the “Accrual- or cash-based reporting” window, select the reporting option you 
want, then click Next.

� Cash: Select this option if you want your reports to show sales as income from the 
moment you receive payment, and bills as expenses from the moment you pay 
them.

� Accrual: Select this option if you want your reports to show sales as income from 
the moment you make a sale, and bills as expenses from the moment you receive 
a bill.

8 You’ve completed the Preferences section.

A check mark  is placed on the Preferences tab to show that you’ve completed it. 
Click Next to go on to the Start Date tab.
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If you haven’t read “Determining a start date” on page 43 yet, you should do so now. Your 
Start Date is the date on which you begin entering all your business transactions into 
QuickBooks Enterprise Solutions so it can help you manage your business finances.

1 Read the information in the “Understanding your QuickBooks Enterprise Solutions 
start date” window, then click Next, then do the same for the “Information for your 
start date” window.

2 Type your start date or click  to select it from the QuickBooks Enterprise Solutions 
calendar, then click Next.

3 You have now completed the General section. A check mark  is placed on both the 
Start Date tab and the General section to show that you’ve completed them. Click Next 
to go on to the first tab of the Income and Expenses section.

Income & Expenses section

This section helps you set up additional income and expense accounts in your business’ 
chart of accounts, if you need them. Some are already set up for you when you select a 
business type in the General section of the Interview.

1 Read the information in the start window for this tab, then click Next, then do the same 
for the “Income Accounts” window.

If earlier in the Interview you chose a business type that doesn’t include an income 
account, you’re prompted to do so now.

2 In the “Here are your income accounts” window, select Yes to add more income 
accounts to the list shown or No if not, then click Next. 

Yes Type the name of the account you want to add, then click Next. The “Add 
another account” window appears. Select Yes to add another account as you just 
did or No if you don’t want to.

No Go on to the next step.

3 Click Next to finish this tab. A check mark  is placed on the Income Accts tab to 
show that you’ve completed it. Click Next again to move to the Expense Accts tab.

1 In the “Expense Accounts” window, select More Details if you want additional infor-
mation on expense accounts or No if not, then click Next.

More Details Read the information in each of the next two windows, clicking Next 
in each one to move on.

No Go on to the next step.
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2 In the “Here are your expense accounts” window, select Yes to add more expense 
accounts to the list or No if you don’t want to, then click Next. 

Yes Enter the following:

- Account Name: the name of the account you want to add.

- This is a Subaccount: If this account is to be subaccount of an account you 
already created, select this option.

- Parent account: If this account is a subaccount of an account previously 
created, choose the main (“parent”) account from the drop-down list.

Click Next, then select Yes to add another account or No if not.

No Go on to the next step.

3 Click Next to finish this tab. A check mark  is placed on both the Expense Accts tab 
and the Income and Expenses section to show that you’ve completed them. Click Next 
to go on to the next section.

Income Details section

The Income Details section is where you tell QuickBooks Enterprise Solutions how to track 
the items or services you sell and the money you collect from your customers.

1 Read the information in the start window for this tab, then click Next, then do the same 
for the “Income Details: Introduction” window.

2 In the “Receipt of payment” window, select how often your customers pay you in full 
at the time of the sale.

� Always: Select if your customers always pay you in full at the time of the sale and 
you don’t need to track how much they still owe you.

� Sometimes: Select if your customers sometimes pay you in full at the time of the 
sale and you need to track how much they still owe you.

� Never: Select if your customers never pay you in full at the time of the sale and you 
need to track how much they still owe you.

3 Click Next.

� If you selected Always, go on to the next step. 

� If you selected Sometimes or Never, you’re asked if you want to provide reminder 
statements to your customers showing their recent transactions with your 
company and their balance.

Select Yes to provide reminder statements to your customers or No if not, 
then click Next.

4 A check mark  is placed on the Introduction tab to show that you’ve completed it. 
Click Next again to move to the Items tab.
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1 Read the information in the start window for this tab, then click Next.

2 If you provide a service to your customers and want to charge for labour, select Yes, or 
No if not, then click Next.

No Go on to the next step.

Yes In the “Service Items: Name” window, do the following.

a Enter this information, then Next.

- Item Name: A name for the service.

- Sales Description: A description for your customers. It will appear on 
sales forms like invoices.

- Sales Price: The price you charge your customers.

- Tax Code: The sales taxes that apply to this service when you sell it.

b From the “Income Account” drop-down list, select the income account to 
receive the money you charge customers for this service, then click Next. 

Subcontracted expenses

� If a subcontractor will perform this service for you and you will then 
pass the cost along to your customer, select Yes, then click Next. 
Otherwise, select No to set up another service item, then click Next.

Service Items: Purchasing Information

� Purchase Description: A description of this service for your subcon-
tractors. It will appear on purchase forms.

� Cost: The rate of pay for your subcontractors.

� Tax Code: The sales taxes that apply when you purchase this service 
from your subcontractors.

Service Item: Expense Account

� Expense Account: Select the expense account to pay out the money 
to your subcontractors for this service, then click Next.

c In the “Set up another service item” window, select Yes to add another 
service item as you just did or No to not, then click Next.

3 If you sell items to customers, but don’t keep them in stock, select Yes to set up non-
inventory parts, then click Next. Otherwise, click No.

Check the information you enter in this tab carefully before you click Next. 

You can’t return to this tab later to change the information you enter. However, after 
you complete the EasyStep Interview, you can change the information directly in Quick-
Books Enterprise Solutions, if you need to.
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This might happen in a few cases:

� If you buy something for a specific job for a customer and pass it along to him or 
her right away, like custom-made kitchen cabinets.

� If you make the thing you're selling from component parts, like a pizza.

� If you buy items and don't sell them again, like office supplies.

No Go on to the next step.

Yes In the “Non-inventory parts: Sales Information” window, do the following.

a Enter this information, then click Next.

- Item Name: A name for the item.

- Sales Description: A description for your customers.

- Sales Price: The price you charge your customers.

- Tax Code: The sales taxes that apply to this item when you sell it.

b From the “Income Account” drop-down list, select the income account 
to receive the money you charge customers for this item, then click 
Next. 

Products purchased for specific customers

� Select Yes if you purchase this item for a specific customer or No to 
set up another service item, then click Next.

Non-inventory Parts: Purchasing Information

� Purchase Description: A description of this item to appear on 
purchase forms.

� Cost: The amount you pay for this item.

� Tax Code: The taxes that apply to this item when you purchase it.

Non-inventory Parts: Expense account

� Expense Account: Select the expense account to use when paying for 
this item.

c Select Yes to add another non-inventory part as you just did or No to 
not, then click Next.

4 If you want to include incidental charges on your sales forms (like shipping charges or 
finance charges), select Yes to set up Other Charge items or No to not, then click Next.

No Go on to the next step.

Yes In the “Other Charges: Name and Sales Information” window, do the following.
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a Enter this information, then click Next.

- Item Name: A name for the item.

- Sales Description: A description for your customers.

- Sales Price: The price you charge your customers.

- Tax Code: The sales taxes that apply to this item when you sell it.

b From the “Income Account” drop-down list, select the income account to 
receive the money you charge customers, then click Next. 

Reimbursement for this Other Charge item

� Select Yes if you’ll pass this charge along to customers who will then 
reimburse you for it, or No to set up another item as you just did.

Other Charges: Purchase Information

� Purchase Description: A description of this item to appear on 
purchase forms.

� Cost: The amount you pay for this item.

� Tax Code: The sales taxes that you pay on this item.

Other Charges: Expense account

� Expense Account: The expense account to use when paying other 
charges.

c Select Yes to add another Other Charge item as you just did or No to 
not, then click Next.

5 Click Next to finish this tab. A check mark  is placed on the Items tab to show that 
you’ve completed it. Click Next to go on to the next tab.

1 Read the information in the start window for this tab, then click Next.

In the Preferences tab of the General section, you told QuickBooks Enterprise Solutions 
whether you wanted to use the inventory feature. If you did not use inventory, you can 
turn it on now.

� Select Skip inventory items to leave inventory off or I want to set up inventory 
items to turn it on, then click Next.

- If you select Skip inventory items, you’re finished with both this tab and this 
section. You can go to “Opening Balances section” on page 62.

- If you choose to set up inventory items, the “Adding an inventory item” 
window appears.

2 Select Yes to set up inventory items now or No to not, then click Next.

No Go on to the next step.

Yes In the “Inventory Item: Sales Information” window, enter the following, then 
click Next.
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- Item Name: A name for the item.

- Units of Measure: If you’ve turned on units of measure in the Preferences 
tab of the interview, click this button to set up your units of measure for 
purchasing and selling this item. See “Setting up different units of measure” 
on page 199, for more information.

- Sales Description: A description for your customers.

- Sales Price: The price you charge your customers. If you’ve set up different 
units of measure for this item, the reorder point is measured in units sold. 
For example, if you purchase a canned item in cases of one dozen cans per 
case, but sell the cans individually, then the sales price is measured in cans 
- not cases.

- Tax Code: The sales taxes that apply to this item when you sell it.

a From the “Income Account” drop-down list, select the income account to receive 
the money you charge customers, then click Next.

b In the Purchase Information window, enter the following, then click Next.

- Purchase Description: A description of this item to appear on purchase forms.

- Cost: The amount you pay for this item. If you’ve set up different units of 
measure for this item, the cost is measured in units purchased. For example, if 
you purchase a canned item in cases of one dozen cans per case, but you sell 
the cans individually, the cost is measured in cases - not cans.

- Tax Code: The sales taxes that you pay on this item.

c Enter the following, then click Next.

- Reorder Point: How many of this item you want to have in stock when you’re 
reminded to reorder. If you’ve set up different units of measure for this item, 
the reorder point is measured in units purchased. For example, if you purchase 
a canned item in cases of one dozen cans per case, but sell the cans individ-
ually, the reorder point is measured in cases - not cans.

- Quantity on Hand: How many of this item you have in stock as of your start 
date (which you entered in the General section).If you’ve set up different units 
of measure for this item, the quantity on hand is measured in units purchased. 
For example, if you purchase a canned item in cases of one dozen cans per 
case, but sell the cans individually, the quantity on hand is measured in cases 
- not cans.

- Total value as of your start date: How much the total quantity of this item is 
worth as of your start date. For example, if you have six shirts worth $10 each, 
the total value would be $60. If you have entered the number of units you have 
on hand and the cost of each, This amount is filled in for you.

d Select Yes to add another inventory item as you just did or No to not, then click 
Next.

3 Click Next to complete the Inventory tab and the Income Details section. A check mark 
 is placed on both to show that you’ve completed them and takes you to the 

Opening Balances section.
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Opening Balances section

In this section, you enter the amounts that customers owe you as of your start date, the 
amounts you owe vendors as of your start date, and the balances in your balance sheet 
accounts.

You need to enter these amounts to give QuickBooks Enterprise Solutions an accurate 
picture of your finances so that your reports and accounts are accurate before you start 
entering your daily business transactions.

1 Read the information in the start window for this tab, then click Next, then do the same 
for the next two windows.

2 A check mark  is placed on the Introduction tab to show that you’ve completed it.

1 Read the information in the start window for this tab, then click Next.

2 In the “Enter customers” window, select Yes to set up the customers who owe you 
money as of your QuickBooks Enterprise Solutions start date or click No to not, then 
click Next.

Yes In the “Customer job tracking” window, select Yes to track several jobs or 
projects per customer or No to not, then click Next.

� If you are not tracking jobs for customers, enter this information, then click Next.

- Customer Name: The name of the customer.

- Balance due on start date: The amount that this customer owes you as of your 
QuickBooks Enterprise Solutions start date.

To add another customer, select Yes or No to not, then click Next. Go on to the 
next step.

� If you are tracking multiple jobs for customers, follow this flowchart:

Check the information you enter here carefully before you click Next. 

You can’t return to this tab later to change the information you enter. However, after 
you complete the EasyStep Interview, you can change the information directly in Quick-
Books Enterprise Solutions, if you need to.
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3 You’ve completed this section. A check mark  is placed on the Customers tab to 
show that you’ve completed it.

1 Read the information in the start window for this tab, then click Next.

2 In the “Adding vendors” window, select Yes to enter vendors to whom you owe money 
as of your start date or No to not, then click Next. 

No Go on to the next step.

Yes In the “Adding vendors” window, enter the following, then click Next.

- Vendor Name: The name of the vendor.

- Balance due on start date: The amount that you owe this vendor as of your 
QuickBooks Enterprise Solutions start date.

To add another vendor, select Yes or No to not, then click Next.

3 You’ve completed this section. A check mark  is placed on the Vendors tab to show 
that you’ve completed it.

Add the 
customer’s 

job

Yes

You’re done! Go 
on to Vendors on 

page 63.
No

Because each customer can 
have more than one job, 
QuickBooks displays a colon (:) 
between the customer’s name 
and the job name in the 
Customer:Job field.

Yes

Does this 
customer have 
multiple jobs?

Start

Add another 
job for this 
customer?

Enter the 
customer’s 

name

Enter the 
customer’s 

balance owing as 
of your start date

Enter the balance 
owing for this job 

as of your start 
date

Add another 
customer?

Yes

No

No

Check the information you enter in here carefully before you click Next. 

You can’t return to this tab later to change the information you enter. However, after 
you complete the EasyStep Interview, you can change the information directly in Quick-
Books Enterprise Solutions, if you need to.
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1 Read the information in the start window for this tab, then click Next.

2 In the “Credit card accounts” window, select Yes to set up a credit card account or No 
to not, then click Next.

No Go on to the next type of account.

Yes In the “Adding a credit card” window, enter the name of the credit card, then 
click Next.

a Enter this information, then click Next.

- Statement Ending Date: Using a recent statement from your financial 
institution, choose a date that is on or before your QuickBooks Enter-
prise Solutions start date. Enter it directly or click  to select it from 
the QuickBooks Enterprise Solutions calendar.

- Statement Ending Balance: The balance of the credit card on the date 
you picked.

b Select Yes to add another credit card as you just did or No to not, then click 
Next.

Accounts - line of credit

1 In the "Adding lines of credit" window, select Yes to set up a line of credit account or 
No to not, then click Next.

No Go on to the next type of account.

Yes In the “Adding a line of credit” window, enter the name of the line of credit 
account, then click Next.

a Enter this information, then click Next.

- Statement Ending Date: Using a recent statement from your financial 
institution, choose a date that is on or before your QuickBooks Enter-
prise Solutions start date. Enter it directly or click  to select it from 
the QuickBooks Enterprise Solutions calendar.

- Statement Ending Balance: The balance of the line of credit on the date 
you picked.

b Select Yes to add another line of credit account as you just did or No to not, 
then click Next.
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Accounts - loan

1 In the “Loans and Notes Payable” window, select Yes set up a loan or note payable 
account or No to not, then click Next.

No Go on to the next type of account.

Yes In the “Adding a loan (liability) account” window, enter the following, then 
click Next.

- Name: The name of the loan.

- Unpaid Balance on: The amount owing on the loan as of your QuickBooks 
Enterprise Solutions start date.

- Long Term Liability: Select if this loan will take more than one year to pay 
off.

To add another loan account, select Yes or No to not, then click Next.

Accounts - bank

1 In the “Bank Accounts” window, select Yes to set up bank account or No if not, then 
click Next.

No Go on to the next type of account.

Yes In the “Adding a bank account” window, enter a name for the bank account, 
then click Next.

a Enter this information, then click Next.

- Statement Ending Date: Using a recent statement from your financial 
institution, choose a date that is on or before your QuickBooks Enter-
prise Solutions start date. Enter it directly or click  to select it from 
the QuickBooks Enterprise Solutions calendar.

- Statement Ending Balance: The balance of the bank account on the 
date you chose.

b Select Yes to add another bank account as you just did or No to not, then 
click Next.

Accounts - assets

1 In the “Introduction to assets” window, read the information, then click Next.

2 In the “Asset accounts” window, select Yes to set up an asset account or No to not, then 
click Next. 

No Go on to the next type of account.

Yes In the “Adding an asset account” window, enter the following, then click Next.

- Name: The name of the asset account.

- Type: Select the kind of asset account.

- Asset value: Type the value of this asset as of the QuickBooks Enterprise 
Solutions start date that you specified in the General tab.

To add another asset account, select Yes or No to not, then click Next.
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Accounts - equity

1 In the “Introduction to equity assets” window, read the information, then click Next, 
then do the same for the next window.

2 Click Next to complete the Accounts tab and the Opening Balances section. A check 
mark  is placed on both to show that you’ve completed them and takes you to the 
Opening Balances section.

Payroll section

Paying employees is a big responsibility, but with QuickBooks Enterprise Solutions, it can 
be easy. You have to keep track of hours, salaries and wages, Social Insurance Numbers, 
vacation pay, sick time, bonuses, advances, and company benefits such as contributions to 
pension plans.

If you have never run payroll before, we recommend that you set up payroll outside of the 
EasyStep Interview. Turn to “Setting up payroll: an overview” on page 142, which contains 
detailed information about how the QuickBooks Enterprise Solutions payroll features work 
and how you can make the most of them.

If you are familiar with using a payroll system, you can use the EasyStep Interview to get 
you going quickly. It guides you through setting up employees, entering their year-to-date 
payroll amounts, establishing their pay frequency and wages or salaries, and deducting the 
appropriate amounts for taxes and other reasons. After setting up your payroll system, turn 
to “Setting up payroll: an overview” on page 142 for information about using this feature.

What’s Next section

The final section in the EasyStep Interview helps you configure QuickBooks Enterprise 
Solutions to your liking. Browse through this section on your own.

� To leave the EasyStep Interview and save your changes, click Leave.

After using the EasyStep Interview to set up your company, do not return to 
it to make changes.

Instead, make any changes you need directly in QuickBooks Enterprise Solutions. Use 
the information in the Welcome to QuickBooks window and the on-screen Help to 
adjust your company file to your liking.
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Going on from the EasyStep Interview

What do I do next?

When you complete the Interview, the Welcome to QuickBooks window opens. This 
resource helps you get started using your new software. It explains how to get around in 
QuickBooks Enterprise Solutions, how to customize it further for your business, and where 
to get help or more information, if you need it.

� To display the Welcome to QuickBooks window, from the Help menu, choose 
Welcome to QuickBooks.

Using the QuickBooks Coach

The QuickBooks Coach is the fastest way to learn the basics of your new software. It 
explains how to get around in QuickBooks Enterprise Solutions, guides you through 
creating customers and items, and lets you practice making sales and receiving payments. 
It takes only 15 minutes to complete and will get you working quickly!

� To start the QuickBooks Coach, in the Welcome to QuickBooks window, click 
QuickBooks Coach.

Final steps to complete your setup

Fine-tune your accounts

QuickBooks Enterprise Solutions sets up a chart of accounts for you during the Interview. 
Before you begin entering transactions, make sure your chart of accounts is complete and 
that it accurately represents how your business works.

Change account names and edit, delete, or add accounts to make your chart of accounts 
reflect your company’s financial activity, if you have to.

Tip: You can adjust the opening balances of the accounts in your Chart of Accounts, too. For more 
information, see “Adjusting opening balances” on page 70.

It’s important to decide on an account structure that meets your needs now.

Although you can edit your chart of accounts later if you need to, it’s much easier to 
make changes before you start entering transactions.
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To set up account numbers:

Develop and follow consistent account naming and numbering conventions. For example, 
some accountants like you to add a numbering scheme to your accounts:

1000-1999 - Assets
2000-2999 - Liabilities
3000-3999 - Equity
4000-4999 - Income
5000-5999 - Expenses
6000-6999 - Other income and expenses

Adding numbers can help you identify the type of accounts, thereby speeding up your 
account selection on various forms. 

Enter your company’s historical transactions

If you’ve decided on a start date that is before today’s date, you’ll need to enter past trans-
actions to have complete financial records from your start date forward. Then your Quick-
Books records will be as complete as if you had started using the program on your start date.

Enter historical transactions in this order:

1 Invoices you’ve sent out since your start date

2 Purchase orders you’ve issued since your start date that have not been received in full

3 Cash or cheques you’ve received since your start date

4 Bills you’ve received since your start date

5 Bills you’ve paid since your start date

6 Deposits you’ve made to any of your accounts since your start date

7 Any other cheques you’ve written (for things other than bills) since your start date

Enter transactions in your bank account last, because your accounts payable and accounts 
receivable affect your bank account. By the time you enter all of your historical 
transactions, your cheque register will be mostly up-to-date.

To learn about… Search the Help index for…

Changing your chart of accounts � accounts, adding
� accounts, editing
� accounts, deleting

The order you enter historical transactions is important.

For example, QuickBooks Enterprise Solutions won’t know how to credit a customer 
payment unless you’ve previously recorded the invoice to that customer.
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Entering current transactions with historical ones

You don’t have to enter all your historical transactions before you start using QuickBooks 
Enterprise Solutions for your current ones. Enter current transactions as they occur so you 
don’t get behind. Then catch up with historical transactions when you can. Remember, 
though, that your account balances will be off until you’ve entered all the past transactions.

If current and historical transactions are related, enter the earlier one first. For example, if 
you receive a payment today for an invoice you have not yet entered, enter the invoice first 
and then use QuickBooks Enterprise Solutions to record the payment. That way, your 
transactions are linked correctly to each other.

Entering historical payroll information

If you are going to use QuickBooks Enterprise Solutions payroll, enter historical payroll 
information so QuickBooks Enterprise Solutions has complete year-to-date records of wages 
and salaries you’ve paid. QuickBooks Enterprise Solutions needs this information to 
compute accurate tax information and payroll reports. See “Setting up payroll: an 
overview” on page 142 for more information
.

Entering bank account information

If you entered all your historical transactions, your chequing account or savings account 
register already contains entries reflecting bills you’ve paid, cheques you’ve written for 
other purposes, and deposits you’ve received. But there are other transactions that you must 
enter to make your account registers complete:

� Cheques or other payments you created before your start date but weren’t cashed until 
after your start date (for example, cheques written a few months ago but not cashed 
until recently).

� Deposits you made before your start date, but which didn’t appear on statements until 
after your start date.

� Cheques or other payments you made after your start date that were not for bills or 
accounts payable (credit card payments, for example).

� Deposits made after your start date that were not customer payments.

� Bank charges, fees, or interest paid to your account.

To learn about… Search the Help index for…

Entering historical information historical transactions

To learn about… Search the Help index for…

Entering historical payroll 
information

payroll setup, year-to-date amounts



70 Chapter 3   Setting up a new company

Complete your customer, vendor, and item information

During the Interview, you entered information about customer and vendor open balances. 
Now you need to enter more information, such as addresses, phone numbers, and credit 
limits—though it’s not necessary to enter this information for all customers and vendors at 
once.

Note: If you use Symantec ACT! or Microsoft Outlook, you can synchronize information about 
customers and vendors, such as addresses and phone numbers, from your contact manager so 
that you don’t have to re-enter it. To learn about synchronizing contact information, search the 
Help index for “contact management, synchronizing”.

Items are the goods, services, and other things you buy and sell. QuickBooks Enterprise 
Solutions starts a list of items when you go through the Interview, but you’ll want to add 
to this list and refine the information you’ve already entered.

Adjusting opening balances

After creating your company in the Interview, you may need to enter additional opening 
balances or make adjustments to the account balances you’ve entered.

To adjust an opening balance for an account:
1 From the Lists menu, choose Chart of Accounts.

2 Double-click the account that should have an opening balance.

3 Click anywhere in the blank entry at the end of the register.

4 Change today’s date to your QuickBooks Enterprise Solutions start date.

5 Leave the Number and Payee fields blank.

To learn about… Search the Help index for…

Entering information in account 
registers

registers, entering transactions in

To learn about… Search the Help index for…

Adding a new customer customers, adding

Adding a new vendor vendors, adding

Item types and uses items, about
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6 Enter the opening balance amount.

� For bank accounts, enter the amount in the Deposit column.

� For asset, liability or equity accounts, enter the amount in the Increase column.

� For credit card accounts, enter the amount in the Charge column.

7 In the Account field, choose Opening Bal Equity from the drop-down list.

Note: If you have not entered an opening balance for any of your accounts, you will have to create an 
Opening Bal Equity account.

8 Click Record.

These accounts may also need adjusting:

� If you collect GST or PST, record the amount you owe as of your start date.

If you have entered your historical invoices and purchases, do not include the amount 
you owe since your start date (as the GST and PST you collected is included on them).

Instead, check whether you owe more than the invoices cover, and if so, adjust your 
GST or PST liability accordingly. Select GST/PST Activities from the Vendors menu, 
then GST or PST Adjustment. For more information, see “Gathering income tax infor-
mation” on page 105.

� Adjust the Uncategorized Income and Uncategorized Expenses accounts (if you’re 
using accrual-basis accounting).

When you enter unpaid opening balances for customers, QuickBooks Enterprise Solu-
tions assigns the income to an account called Uncategorized Income. Similarly, when 
you enter unpaid balances owing for vendors, QuickBooks Enterprise Solutions assigns 
the expenses to the Uncategorized Expenses account.

- If you keep your books on a cash basis (you record income when you receive 
payment), QuickBooks Enterprise Solutions does not show these two accounts on 
your profit and loss statement until a customer makes a payment, which is the 
expected behavior. You do not need to make any adjustments.

- If you keep your books on an accrual basis (you record the transaction when you 
make a sale or incur an expense), QuickBooks Enterprise Solutions does show these 
two accounts on your profit and loss statement as of your start date. Your 
accountant may want you to make an adjustment so that the income from all 
invoices and the expenses from all bills before the start date are also tracked on an 
accrual basis, regardless of whether payment has occurred. Ask your accountant 
whether this situation applies to you.

To learn about… Search the Help index for…

Recording the GST or PST you 
owed as of your start date

GST, historical data
PST, historical data

Adjusting your GST or PST 
liability

GST, adjusting
PST, adjusting
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� Adjust for current income and expenses if your start date is not at the beginning of your 
fiscal year.

If you set up your company in QuickBooks Enterprise Solutions with a midyear start 
date and you know what your income and expenses are from the beginning of your 
fiscal year to your start date, you can enter adjustments for them. Then, when you 
create a profit and loss statement in QuickBooks Enterprise Solutions, it will be accurate 
from the beginning of the fiscal year to any date after your start date.

To get this information, have your accountant create a year-to-date profit and loss 
statement (also called an income statement) for your current fiscal year through your 
start date.

� Distribute earnings and equity from before your start date.

After you have entered all of your opening balances and made other adjustments, you 
may want to distribute the amount in your Opening Bal Equity account to other equity 
accounts if you want to identify retained earnings or the equity of several owners.

To learn about… Search the Help index for…

Adjusting for Uncategorized 
Income and Uncategorized 
Expenses

� Uncategorized Expense account
� Uncategorized Income account

To learn about… Search the Help index for…

Adjusting income and expenses 
for midyear setup

adjustments, income and expenses 

To learn about… Search the Help index for…

Distributing earnings and equity 
from before your start date

Opening Bal Equity account

Equity carried over from previous 
fiscal periods

equity, retained earnings from

Moving the amount in the 
Opening Bal Equity account to 
other equity accounts

equity, transferring from Opening 
Bal Equity
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Things to think about after you’re finished

Create reports to check your setup

After you’ve finished setting up your company in QuickBooks Enterprise Solutions and 
making any adjustments, create reports to check that QuickBooks Enterprise Solutions has 
the right numbers.

In both QuickBooks Enterprise Solutions and your former accounting system, create a profit 
and loss statement and a balance sheet. Each report should cover the beginning of your 
fiscal year through to your QuickBooks Enterprise Solutions start date. For example, if your 
fiscal year began on July 1 and your start date was September 1, create reports that cover 
July 1 to September 1.

Both reports should show the same balances for your accounts.

Maintain your previous accounting system

If your business existed before you began to use QuickBooks Enterprise Solutions, make sure 
you keep your previous accounting system complete in case Canada Customs and Revenue 
requires information from your previous years of business.

You should keep any software and the hardware your former accounting system requires —
or have printouts of all the information and accounting reports.

Set up other company files, if you need them

If you use QuickBooks Enterprise Solutions with more than one company, and therefore 
have more than one company file, you should keep them all in the same directory. With 
QuickBooks Enterprise Solutions, you can combine reports from multiple company files.

If you update QuickBooks Enterprise Solutions, download tax tables, receive tax alerts, and 
so forth, you may have to download multiple copies of the new information if the company 
files are in different directories.

Connect QuickBooks Enterprise Solutions to the Internet

What you need

Your PC must be connected to the Internet through an Internet Service Provider (ISP). Your 
work PC may be connected through a local area network (LAN). If you can read e-mail or 
browse the Web, you are connected to the Internet. 

Why connect to the Internet?

You don’t need Internet access to use QuickBooks Enterprise Solutions, but the ability to 
“go online” can easily double the power and flexibility of your software. It allows you to 
take advantage of Internet-only features in QuickBooks Enterprise Solutions. 
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Consider these additional possibilities:

� Explore other opportunities with QuickBooks Enterprise Solutions’ connected services
From the Company menu, select Business Services Navigator.

� Receive QuickBooks Enterprise Solutions updates 
Download and install software updates as they become available.

� Download tax table information
You can download the latest tax tables.

If you are a new user

If you are a new user, you are prompted to register QuickBooks Enterprise Solutions, and if 
you choose to do so online, QuickBooks Enterprise Solutions helps you set up your Internet 
connection. It’s a good idea to register as soon as you can so that you can begin using all of 
the QuickBooks Enterprise Solutions online features.

Note: If you did not register your copy of QuickBooks Enterprise Solutions immediately after instal-
lation, you can do so at any time by choosing Register QuickBooks Enterprise Solutions from 
the File menu. (If you do not see Register QuickBooks Enterprise Solutions under the File menu, 
that means you have already registered.) 

If you are an upgrader

If you owned a previous version of QuickBooks, QuickBooks Enterprise Solutions uses the 
same Internet settings as your previous version. If you have changed your Internet Service 
Provider between then and now, or switched from using a modem to using a direct 
connection (for example, cable or DSL), you can change your settings manually. 

To Set up an Internet connection:
1 From the Help menu, choose Internet Connection Setup.

If you have not used QuickBooks Enterprise Solutions on your computer before, then 
the first time you go online (for example, to register your software), QuickBooks Enter-
prise Solutions automatically launches the Internet Connection Setup wizard.

2 Follow the onscreen instructions. Click Next to move through the screens. If you need 
help at any time, click Help.

3 Click Done.

Changing an Internet connection

If you already have a connection to the Internet, you can modify the connection settings. 
You can also set up other ways QuickBooks Enterprise Solutions can connect to the 
Internet. Doing so gives you an alternate way to connect to the Internet if your regular 
connection is down for some reason. 
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To change your Internet connection:
1 From the Help menu, choose Internet Connection Setup. The Internet Connection 

Setup displays.

2 Select Use my computer’s Internet connection settings to establish a connection 
when this application accesses the Internet.

3 Click Next.

4 In the Connection Setting window, click Advanced Connection Settings. The Internet 
Properties dialogue box appears.

5 To create a new dial-up networking connection, click Add.

Follow the onscreen instructions; click Next to move through the screens. 

Each Internet connection profile you create, is listed on the first screen of the Internet 
Connection Setup. 

If QuickBooks Enterprise Solutions doesn’t detect your Internet connection (for example, 
you’re using certain versions of AOL or CompuServe), try the following:

� Close QuickBooks Enterprise Solutions, then connect to your Internet Service 
Provider (ISP).

� When you have successfully connected to the Internet, reopen QuickBooks Enter-
prise Solutions.

� Go to the Internet Connection Setup, and on the “How do you want to connect to 
the Internet? screen, select Use my computer’s Internet connection settings to 
establish a connection when this application accesses the Internet.

Once you have told QuickBooks Enterprise Solutions that you have a direct connection, 
you should be able to access QuickBooks Enterprise Solutions’ Internet features by 
connecting to your ISP before opening QuickBooks Enterprise Solutions.
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Update QuickBooks Enterprise Solutions to the latest release

From time to time, Intuit provides updates to QuickBooks Enterprise Solutions that are 
available for downloading from the Internet. These updates might be:

� A maintenance release, which Intuit creates when a problem is discovered and fixed 
after QuickBooks Enterprise Solutions is delivered to customers.

� A new featureor service.

� Timely information that is relevant to your business.

Some updates require you to exit QuickBooks Enterprise Solutions before the new 
information goes into effect. In these cases, when you exit the software, it displays a 
message asking if you want to install the update. If you choose Yes, QuickBooks Enterprise 
Solutions closes and installs the update. If you choose No, QuickBooks Enterprise Solutions 
closes without installing the update.

Tip: If you do not have a company file available, but want to update QuickBooks Enterprise Solutions, 
open one of the sample company files, then update the software as you normally would.

If you signed up for theQuickBooks Payroll Service, QuickBooks Enterprise Solutions checks 
for new tax tables whenever you check for other updates to your software.

Getting updates from the Internet

In QuickBooks Enterprise Solutions, the Update QuickBooks window gives you a 
convenient way to download updates from the Intuit server to your computer.

To download an update, you need to have set up QuickBooks Enterprise Solutions to work 
with an Internet connection (see “Connect QuickBooks Enterprise Solutions to the 
Internet” on page 73).

There are several ways to update your version of QuickBooks Enterprise Solutions through 
the Internet:

� Automatic Update: This option prompts you when a new release is available for your 
version of QuickBooks Enterprise Solutions. If you choose to update when prompted, 
the necessary files are downloaded to your computer via the Internet in the back-
ground, with little impact on your computer’s performance.

� Manual Download: With this method, you decide when to download an update via 
the Internet to your computer. You can use this method at any time—even if your 
computer is set up to download updates automatically.

� From QuickBooks.ca: You can visit our Web site to download the latest release for 
your version.

� Multiuser Update: When updating multiple users, the new update is downloaded via 
the Internet or a CD to a local server for each user to then download to their computer.
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Automatic updates

By default, QuickBooks Enterprise Solutions is set to receive updates automatically. 
QuickBooks Enterprise Solutions periodically checks the Intuit server for new updates, and 
downloads the information gradually at times when your open Internet connection is not 
being used by another process or application.

Some of the advantages of this method include the following:

� You can download updates without interrupting a session or other tasks you perform 
with your computer.

� You can download updates whether or not QuickBooks Enterprise Solutions is running 
(as long as your computer is connected to the Internet).

� You can disconnect from the Internet at any time. When you reconnect to the Internet, 
QuickBooks Enterprise Solutions resumes downloading at the point it was previously 
halted.

To turn off Automatic Update:
1 On the File menu, select Update QuickBooks.

2 Select Options.

3 Click Off for the Automatic Update option.

4 Click Save.

5 Close the Update QuickBooks window.

Manual updates

If you choose to manually update the software, you should check for updates about once a 
month. With this method, QuickBooks Enterprise Solutions only begins the downloading 
process once you click Get Updates in the Update QuickBooks window.

Download times for updates vary depending on the speed of your Internet connection, the 
size of the update file(s), and the amount of traffic on the Internet. After QuickBooks 
Enterprise Solutions downloads an update, the program installs the necessary files to the 
correct directories or folders on your computer. 

To perform a manual update:
1 From the File menu, choose Update QuickBooks.

2 Click Update.

3 Select the updates you want to download by clicking the checkbox next to the update 
name. (A check mark means the update is selected.)

4 Click Get Updates.

Note: Manual updates can also be performed when the Automatic Update option is turned on.

Once the download process is complete, QuickBooks Enterprise Solutions displays the date 
and time of the download in the Last Checked column. In the File Received column, 
QuickBooks Enterprise Solutions displays the status of the download. Click the text in the 
Files Received column for additional details about the download.
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Updates from QuickBooks.ca

Visit the QuickBooks Web site at http://www.QuickBooks.ca/ to download updates. At the 
site, go to the Support page, then choose QuickBooks Product Updates. There you’ll find a 
list updates for the various versions.

Before installing the update from QuickBooks.ca:
1 Write down your QuickBooks Enterprise Solutions registration number in case you 

need it later.

� To find it, select About QuickBooks Enterprise Solutions from the Help menu.

2 Back up your company file(s).

To update from QuickBooks.ca:
1 From the Product Updates page, click the update link for the version you are using.

The File Download window opens.

By default, the “Save this program to disk” option is selected. This option saves a copy 
of the update to your computer for you to later install.

2 Click OK. The Save As window appears.

3 Navigate to a folder to save the update file to or keep the default.

4 Click Save.

5 When the download is complete, the WinZip Self-Extractor opens. (If it does not start 
automatically, double-click the file you downloaded.) Extract the files to a temporary 
folder where you can find them again easily.

6 Shut down all open programs, including QuickBooks Enterprise Solutions and any 
virus protection software you may have. Some virus protection programs can interfere 
with the installation.

7 Using Window Explorer, open the folder you specified in Step 5.

8 Double-click the Setup.exe file and follow the instructions on your screen.

Sharing updates among multiple users

If you use QuickBooks Enterprise Solutions in multi-user mode, you need to install 
maintenance releases on each computer that has QuickBooks Enterprise Solutions installed 
on it.

You can either connect to the Internet from each computer that has QuickBooks Enterprise 
Solutions installed on it, or else download the update to one computer on your network 
and share it (for example, if one or more users doesn’t have Internet access).

QuickBooks Enterprise Solutions sets up a shared location to which updates are 
downloaded. Then, if any user in a multi-user environment downloads and installs an 
update, QuickBooks Enterprise Solutions detects it and prompts each of the users—as they 
exit the program—to install the new version. 



Things to think about after you’re finished 79

To share updates, you need to be sure that all your users can access the location on your 
networks where the updates are downloaded:

� All of the QuickBooks Enterprise Solutions computers must be properly networked.

� Each computer must be configured to share files across the network.

Finally, all QuickBooks users on your network must complete the following steps:

To change the download location:
1 Open the shared company file.

2 From the File menu, choose Update QuickBooks.

3 Click Options.

4 In the Options windows, click ON for the Share Download option.

5 Click Save.

Updates from a CD-ROM

If you don’t have Internet access, you can have an update mailed to you on a CD-ROM (fees 
may apply). For more information, contact Customer Service (see page 226).

When you receive the CD, install the update as you would install any other software.

Before installing from a CD...
1 Write down your QuickBooks Enterprise Solutions registration number in case you 

need it later.

� To find it, select About QuickBooks Enterprise Solutions from the Help menu.

2 Back up your company file(s).

To install your update:
1 Shut down all open programs, including QuickBooks Enterprise Solutions and any 

virus protection software you may have. Some virus protection programs can interfere 
with the installation.

2 Insert the CD-ROM in your computer’s CD-ROM drive.

3 Open Windows Explorer and select the correct CD-ROM drive.

4 Open the folder containing the installer for your version of QuickBooks Enterprise 
Solutions.

5 Double-click Setup.exe and follow the instructions on your screen.

6 Review the Readme.txt file on your CD-ROM. It contains important information about 
how your software is affected by this update, and what you should do next.

Set number, currency, time, and date formats in QuickBooks 
Enterprise Solutions

Your settings in the Regional Options of Microsoft Windows affect how QuickBooks 
Enterprise Solutions displays numbers, currency, time, and dates.
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To check your Windows Regional Options settings:
1 From the Windows Start button, select Control Panel.

2 Choose Regional Options or Regional Settings, depending on the version of Windows 
you’re using.
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Getting around in QuickBooks Enterprise 
Solutions

Learn basic features in minutes

The fastest way to get started in QuickBooks Enterprise Solutions is to practice with the 
QuickBooks Coach. This interactive tutorial lets you practice common tasks without 
affecting the data in your company file. You can complete it in 15 minutes, and when you 
do, you’ll be able to navigate in QuickBooks Enterprise Solutions, set up customers and 
items, make sales, and receive money.

To start the QuickBooks Coach, select QuickBooks Coach from the Help menu, or else select 
it in the Welcome to QuickBooks window.

About the Getting Started window

When you first open QuickBooks Enterprise Solutions, the Getting Started window appears. 
It lists the steps you need to complete to finish setting up your new company file, tells you 
how to find the information you’ll need while you’re working, and gives you some useful 
tips on managing your business.

QuickBooks Enterprise Solutions also provides information about resources for your 
business, product news, and how to get help, if you need it. Look under the Help menu for 
these options.

Navigating in the working area

QuickBooks Enterprise Solutions makes it easy to access the feature or information you 
want. There are several ways to get around in most areas of QuickBooks Enterprise Solutions 
— just choose the one that best fits your work style.

The Icon bar gives you one-
click access to the features 
you use most. And, you can 
customize it to your needs.

Navigators are 
an easy way to 
work in one 
area of 
QuickBooks.

As you use 
QuickBooks, the 
Open Window 
list keeps a list 
of the areas 
you’ve worked 
in.

Each Navigator shows the 
tasks for one area of your 
business.

The Customer Navigator, 
shown here, contains 
customer-specific tasks like 
creating an invoice. 

For more on the Navigators 
see “Getting information 
about your company” on 
page 86.
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Moving between windows

Tip: If you’d like to be able to see multiple windows open at the same time, from the View menu, select 
Multiple Windows.

QuickBooks Enterprise Solutions maximizes your workspace by displaying one window at 
a time at its full size. Because it keeps a list of the windows you have open, you can quickly 
switch between windows as you work.

Using lists, forms, and registers

When you’re working in QuickBooks Enterprise Solutions, you’ll spend most of your time 
using a form, a list, or a register. Since these are so basic to QuickBooks Enterprise Solutions, 
take a few minutes to become familiar with them.

Using lists

Lists store information about customers, vendors, employees, items or services you sell, and 
so on. They save you time and help you enter information consistently and correctly.

You fill out most QuickBooks Enterprise Solutions forms by selecting entries from a list. For 
example, when you’re filling out an invoice form, you select a customer name from the 
Customer:Job list. QuickBooks Enterprise Solutions then fills in the customer’s name, 
address, payment terms, and other information.

To learn about… Search the Help index for…

Customizing and using the Icon 
bar

Icon Bar

Displaying the navigators navigators

Displaying and using the Open 
Window list

windows, list of open

Showing, hiding, or customizing 
items on the QuickBooks desktop

desktop

This list 
includes each 
customer and 
job and their 
outstanding 
balances.

An “X” beside a 
name shows it’s 
inactive.

You can create notes on many lists.

Use the menu buttons at the bottom of 
lists for a variety of tasks: creating new 
entries, editing existing ones, creating 
reports about items on the list, and 
using them in transactions.

To re-sort the list by name or type, click 
the column header.

To show the items marked “inactive,” select Show 
All. To hide these items, clear the checkbox.
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Using forms

You record most of your daily business transactions on a QuickBooks Enterprise Solutions 
form, which looks just like the paper forms you’re used to. After you fill it in, QuickBooks 
Enterprise Solutions does the accounting.

Using registers

Just as you use the paper register that comes with your cheques to record the transactions 
in your chequing account—cheques you’ve written, withdrawals you’ve made, and 
deposits—QuickBooks Enterprise Solutions uses electronic registers to record the activity in 
its accounts. The register shows every transaction for that account, as well as the account 
balance.

Although you usually would use forms for entering and viewing transactions, you can also 
do so directly in registers. Here’s an example of the register for an accounts receivable 
account.

When you record a bill and then 
write a cheque (using the Pay Bills 
window) to pay for the business 
expense, QuickBooks enters 
transactions in your accounts 
payable register to show the 
expense you incurred and the 
payment you made.

It also records the cheque in your 
chequing account, keeping your 
records up to date and providing a 
running balance of what you owe at 
any time.

It also shows payments 
you’ve received against 
your invoices.

At the bottom-right of 
the register, you see a 
running balance, or 
ending balance as it is 
referred to in 
QuickBooks, of all your 
accounts receivable, so 
you always know how 
much you’re owed.

The register 
shows 
information 
about invoices 
written to 
customers — 
the date of the 
invoice, the 
date it’s due, 
the name of the 
customer, and 
the amount.
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Where to learn more about using QuickBooks 
Enterprise Solutions

QuickBooks Enterprise Solutions provides a variety of ways for you to obtain useful 
information and answers to your questions. If you are having a specific problem and prefer 
person-to-person assistance, see “QuickBooks Enterprise Solutions Technical support” on 
page 228.

Using the Help & Support window

The Help & Support window is your one-stop source for answers to your QuickBooks 
Enterprise Solutions questions. There, you can enter a question in your own words and get 
immediate answers drawn from both the Help system and our technical support database. 
For example if your cheque numbers are out of sequence, you could enter “How do I reset 
my cheque numbers?” Enterprise Solutions then finds the answer for you. 

In the Help & Support window, you can also learn about and sign up for support plans, look 
up support and product-related phone numbers, submit suggestions for product 
improvements, learn about training resources, and find a certified QuickBooks Enterprise 
Solutions IntuitAdvisor. This window brings together a wealth of information about 
Enterprise Solutions.

To display the Help & Support window, choose Info & Support from the Help menu.

Finding step-by-step instructions

How do I? menus

Throughout QuickBooks Enterprise Solutions, you’ll find windows with a How Do I? drop-
down menu in the upper-right corner. These menus provide quick access to information 
and instructions for the window you’re working in.

Using the Help Index

The tables in the manual and the How Do I menus on the windows are not exhaustive, so 
we encourage you to search the extensive QuickBooks Enterprise Solutions Help system. 
(Go to the Help menu and choose Help Index; then enter your subject. You can get back to 
the index from any Help topic.)

Finding information about fields in a window

If you’re unsure of a field or control (such as a button) in a particular window, you can press 
F1 to get help on the key parts of the window. These “What’s important about...” topics 
provide answers to questions such as:

� What does this button do?

� What kind of information is displayed in this column?

� What happens when I select this option?



86 Chapter 4   QuickBooks Enterprise Solutions Basics

Finding business-specific information

A collection of topics, customized for various types of businesses, provides information 
about setting up and using QuickBooks Enterprise Solutions for the types of businesses 
listed.

To view the industry-specific information:
1 From the Help menu, choose Using QuickBooks for Your Type of Business.

2 Click an industry name in the window that appears.

3 Click the topic that interests you.

4 To print a topic, click Print.

Exploring QuickBooks Enterprise Solutions with a sample 
company

Use the sample company that comes with QuickBooks Enterprise Solutions to get familiar 
with the software: explore the features, enter test data, and run reports.

To view the sample company
1 From the File menu, choose Open Company.

2 In the Open a Company window, choose sample.qbw.

Getting information through the Internet

You can use the QuickBooks.ca Web site (http://www.quickbooks.ca) to browse for answers 
to questions about QuickBooks Enterprise Solutions or Intuit Canada.

To get to QuickBooks.ca from within QuickBooks Enterprise Solutions (using the built-in 
Web browser), select it from the Help menu.

Getting information about your company
Navigators are the best starting point to see how your company is doing at a glance. They 
gather information from your data and display it in one location so you can manage your 
business more effectively. There are eight navigators: 

� Company

� Business Services

� Customers

� Vendors

� Employees

� Banking

� Reports

� Help & Support
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Creating reports

QuickBooks Enterprise Solutions provides a wide variety of preset reports and graphs 
designed to give you quick and easy access to your company’s information. In addition, you 
can create your own customized reports that have a different look and layout as well as 
scope of information.

The flowchart 
shows activities 
for dealing with 
one customer. 

Click the icons 
for quick access. 

Click these icons for 
quick access to 
features you use to 
manage all your 
customers.

Use this drop-down list for convenient 
access to reports you’ve added to the 
memorized reports list.

In this area, 
QuickBooks 
provides you 
with suggestions 
for working with 
your customers.

To learn about… Search the Help index for…

Using the Company Centre Company Centre

Using other QuickBooks centres centres

Decision Tools decision tools
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Finding the right report

With the Report Finder, you can quickly review and choose among the many preset reports 
that QuickBooks Enterprise Solutions provides. To help you choose an appropriate report, 
the Report Finder displays a sample of each report, as well as a summary of what the report 
conveys about your business. 

Customizing the look of a report

Most reports can be customized for unique presentation of your data. For example, you can 
do the following:

� Change the typeface (font) and how numbers display

� Add or remove columns and adjust their width

� Create or change subtotal groupings

� Change the sort order of transactions

Choose a report 
category and 
view a general 
description of 
your choice.

The specific 
reports available 
in the category 
you selected are 
listed here.

View a 
thumbnail 
picture with 
sample data to 
get an idea of 
a report’s 
content. You 
can customize 
a report before 
or after you 
generate it.

QuickBooks provides details about a report’s content to help 
you decide whether the report is appropriate for your needs.

To learn about… Search the Help index for…

Finding a report reports, finding

Creating a report reports, creating

Preset reports report types, all



Getting information about your company 89

After you have customized a report, you can save the settings for future use. Saving report 
settings is called memorizing. The next time you run the report, QuickBooks Enterprise 
Solutions recreates the format of the report, but uses your latest financial data.

When you memorize a report, QuickBooks Enterprise Solutions adds it to the Memorized 
Report List. To display this list, from the Reports menu, choose Memorized Reports, then 
choose Memorized Report List.

Click Modify Report 
to customize a report 
for your needs.

Each tab covers 
different aspects 
of the report. For 
example, this 
tab allows you 
to choose the 
columns you 
want to display.

You can export reports to a Microsoft 
Excel spreadsheet. With QuickBooks 
Enterprise Solutions, you can also 
create combined reports in Excel (see 
“Combining reports from multiple 
company files” on page 91).
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Changing the scope of the information in a report

Creating your own version of an existing report can also include filtering, or changing the 
scope of the information that displays on a preset report. 

We encourage you to explore 
the extensive list of filters.

Your options here will include 
filtering for data you entered in 
your custom fields.

To learn about… Search the Help index for…

Changing date ranges reports, dates in

Customizing a report report customization

Adjusting, adding, or deleting 
columns on a report

report customization, columns

Tailoring the data in the report 
(filtering)

reports, changing the scope of

Changing headers and footers report customization, headers
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Combining reports from multiple company files

A combined report is a report that combines or consolidates data from a common time 
period (e.g., last month, last quarter, last year-to-date) from different company files, and 
pulls that data together into one report. Parent companies and head offices might use 
combined reports to pull together data from subsidiaries, divisions, or branches. 

In order to create combined reports, you need Excel 97 or higher, permission to create 
sensitive financial reports, and at least two QuickBooks company files. The QuickBooks 
company files must also be updated to work in QuickBooks Enterprise Solutions. To update 
an older company file, simply open it in QuickBooks Enterprise Solutions and save it. Once 
you open an older file in QuickBooks Enterprise Solutions, you cannot open it again using 
the older version of QuickBooks.

To create combined reports from multiple company files
1 From the Reports menu, select Combine Reports from Multiple Companies.

Note: QuickBooks verifies whether the current user has the reporting permissions 
needed to create combined reports.

2 Click Add Files to select the company file(s) whose data you want included in the 
report. The Add Company Files window appears.

3 In the Add Company Files window, select the company file(s) you want to have 
combined in the report, and click Open. If you do not see the company file you want 
to add, you’ll need to browse to its location.

4 When you’re done selecting the files you want in the report, from the Combine Reports 
from Multiple Companies window, choose the report(s) you want to create.

5 Change the date range of the report (if needed), and select Accrual or Cash as the report 
basis.

6 Enter a new name for the combined report, and click Combine Reports in Excel. 

As you select
company files,

they are added to
this list. To remove
a file from the list,
select the file and
click Remove File.

Click in the check
mark column to

select the report(s)
you want created.

Click again to
deselect the report.

Here, you can 
assign a name for 
the combined 
report. This name 
appears at the top 
of the report. The 
default name is the 
name of the 
company file you 
had open when you 
opened this 
window.

Click this button to 
further define how 
you want the report to look in the Excel spreadsheet. Multiple 
reports are separated by tabs at the bottom of the spreadsheet.

Note: If you have 
multicurrency 
turned on, foreign 
transactions are 
converted and then 
shown on reports in 
the home currency.
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What does “Other” refer to on reports?

If you use subaccounts, subitems, or jobs, then sooner or later you will see the word “Other” 
on a report:

QuickBooks Enterprise Solutions shows the word “Other” when you create a report for an 
account that has subaccounts (or items that have subitems, customers that have jobs, and 
so on) and there is a transaction associated with the main account. Generally, if you are 
using subaccounts (or subitems or jobs), you should associate transactions only with the 
subaccounts instead of the master account.

Tip: To remove the “Other” line or column on a report, double-click its dollar amount to see the 
transaction and adjust it. When QuickBooks Enterprise Solutions displays a report listing one or 
more transactions, double-click each one in turn. In the transaction itself, replace the problem 
name with the correct subaccount, subitem, or job.

Backing up your company data
Your data is valuable! No recovery technique can repair all possible file damage or protect 
against theft or natural disasters.

To guard against and minimize data loss, you should make regular backup copies of your 
QuickBooks company (or companies). In the event of a data loss, you can restore your data 
from the backup.

You can backup your company file to your hard drive, floppy disks, or, if you subscribe to 
the QuickBooks Backup Service, a secure server on the Internet. Online backup through the 
Internet is fast and convenient, and stores a copy of your company file on secure, third-
party server away from the physical location of your company.

It’s a good idea to store at least one recent backup off-site. That way, in case of theft or 
natural disaster, you’ll have a copy of your company data in a safe place. If you back up to 
floppy disks, we recommend that you keep multiple backups on different sets of disks and 
that you periodically replace the disks with new disks.

Note: The QuickBooks Backup command does not simply copy your company data file. Instead, it 
compresses the data into a compact backup file which only QuickBooks can open. You can name 
the backup file whatever you want.

The $18.45 expense for Automobile-Other is 
for the Automobile main account and not 
for either of the subaccounts.
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Recommended backup routine

If you use multi-user mode, you must switch to single-user mode to create a backup. For 
more information on single-user mode, see “Working with multiple users” on page 97.

� Prepare several sets of backup disks by formatting them fully. The number of disks 
you’ll need depends on the size of the company file you’re backing up.

� Label the disks “QuickBooks Backup Monday,” “QuickBooks Backup Tuesday,” etc. (If 
your backup requires more than one disk, label the disks “Monday, Disk 1,” “Monday, 
Disk 2,” and so on.)

By having one set of backup disks for each business day, you likely won’t lose more 
than one day’s records if a disaster strikes.

� Each day, back up onto that day’s disks and keep them in your office.

� At least once a week, make a second backup to keep off your premises.

Alternate between two sets of disks for your weekly off-set backup. If a disaster strikes 
your office, you’ll want a reliable record of your data to fall back on.

� Periodically, replace your backup disks with new disks formatted on your machine. 
Disks are susceptible to damage and should be replaced periodically.

� At the end of the fiscal year, make an archive copy of your data to keep off your 
premises.

Restoring company data

If you need to restore your company file from a backup, use the Restore command. Because 
QuickBooks backup files are compressed, simply copying the backup file to your 
QuickBooks Enterprise Solutions directory will not give you access to your data.

Note: If QuickBooks Enterprise Solutions finds a company file with the same name as the one you’re 
restoring to a given directory, it asks you whether you want to replace the existing file. 

If you answer “No,” QuickBooks returns you to the Restore window. You must then give a different 
name to the restored file, and when the process is finished, you will have two different versions 
of your company data.

If you are restoring your company file because your computer or hard drive malfunctioned, 
we recommend that after the hardware repairs are done, you reinstall QuickBooks 
Enterprise Solutions and any updates, before you proceed.

To learn about… Search the Help index for…

Backing up your company data backups

To learn about… Search the Help index for…

Restoring your company data restoring from a backup
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Condensing data

If your company file has grown very large, you can reduce its size by condensing the older 
transactions that you no longer need much detail about.

For example, you might want to condense the transactions your company completed two 
years ago or more, especially if your company file has grown quite large (more than 75 MB). 
Condensing large company files can sometimes improve the performance of QuickBooks 
Enterprise Solutions.

When you condense data, you can specify an ending date for the period of time you want 
to condense. Transactions dated after your selected ending date are not affected. For 
example, if your ending date is 12/31/01, all transactions dated 01/01/02 and later remain 
intact in your company file.

When you condense your company file based on transactions as of a specific date, 
QuickBooks Enterprise Solutions deletes only closed transactions. Open transactions are 
retained. Therefore, to condense the most possible transactions, try to complete any unpaid 
bills or uncleared transactions you have before starting. It is best to choose an end date that 
is six months or more in the past. 

If you select Remove ALL transactions, all open as well as closed transactions are deleted.

If you use payroll

If you use QuickBooks Enterprise Solutions to pay your employees, payroll data is not 
condensed for the current payroll year or the previous one.

For example, if you choose to condense your company file in March, 2002, QuickBooks 
Enterprise Solutions would not condense payroll data from 2002 or 2001. It would 
condense payroll transactions from the date you started using QuickBooks through to 
December 31, 2000. 

If you report financial information to the Québec Minister of Revenue, you 
must keep the archive file the Condense function creates in case you need 
to refer to it during an audit.

Doing so helps you comply with legislation from the MRQ. The legislation states that 
your accounting software cannot allow you to modify or delete data without keeping a 
record of the original data.

You must keep the archive file the Condense function creates in case you 
need to refer to your payroll transactions during an audit.

The CCRA requires that you keep your payroll transactions for seven years. Since an 
archive file contains your payroll transactions for a given period, you must keep it.

Also, you should make sure you have printed records of your most important payroll 
transactions before you condense your data and create an archive.
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Examples of transactions that would be deleted
� If an invoice has been paid in full, QuickBooks Enterprise Solutions deletes the details 

and includes the amount in a summary transaction showing income accounts. Neither 
the customer name nor the items sold are retained. However, if an invoice is not 
printed, unpaid, partially paid, or marked as pending, QuickBooks Enterprise Solutions 
leaves the invoice in your file so you can apply payments to the invoice.

� Only estimates that are dated on or before the ending date and that have a job status 
of Closed are deleted. If an estimate has any other job status (Pending, Awarded, In 
Progress, Not Awarded, or None), the estimate is retained regardless of its date.

� Only if you choose the option in the Condense preferences: if you have paid a bill for 
a reimbursable expense, QuickBooks Enterprise Solutions the a bill regardless of 
whether you have invoiced the customer for the expense. 

Examples of transactions that would be retained

The following table gives examples of the situations that cause QuickBooks Enterprise 
Solutions to retain transactions dated on or before your specified ending date.

When you follow the steps in the Archive & Condense Data wizard, you’ll have an 
opportunity to remove old transactions and unused items to further reduce the size of your 
data file. However, transactions that meet the following criteria are always retained.

Summary transactions

The summary transactions that QuickBooks Enterprise Solutions creates appear in the 
registers of your balance sheet accounts (Bank, Accounts Receivable, Accounts Payable, and 
so on).

Each balance sheet account has one GENJRNL summary transaction for each month in 
which QuickBooks Enterprise Solutions deleted transactions. The transaction amount is the 
total of the transactions that QuickBooks Enterprise Solutions deleted for the month. 

For a given month, the register may also show other transactions that QuickBooks 
Enterprise Solutions did not delete. These are transactions that could be affected by 
transactions you have yet to enter.

When QuickBooks retains a 
transaction with earlier date

Example of retained transaction

The transaction is linked to another 
transaction that has an opening 
balance.

An undeposited customer payment that 
you applied to an invoice. Even though the 
invoice is paid, QuickBooks retains the 
invoice because it has a link to an open 
transaction (the undeposited payment).

The transaction is linked to a 
transaction in the current year.
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When opening a register, you can spot the summary transactions by looking for GENJRNL 
in the Type field.

To view a breakdown of amounts by account, select a GENJRNL transaction and click Edit. 
The General Journal Entry window shows the breakdown of amounts by account for all 
summarized transactions for this month.

Note: You cannot edit a GENJRNL summary transaction.

How condensing data affects your reports

Account balances

After you condense your data, you can still create reports that summarize financial activity 
for the period of time you condensed. For example, if you condense last fiscal year’s data, 
you can still create profit and loss reports that compare last year’s results to this year’s. This 
is because QuickBooks Enterprise Solutions adds summary transactions to your company 
file to preserve monthly account balances.

Transaction detail

After you condense your data, you won’t be able to create reports that show daily detail for 
the period of time you condensed. This is because QuickBooks Enterprise Solutions has 
deleted the individual transactions that would have provided the detail. In addition, you 
won’t be able to create reports that show balances for individual customers or vendors over 
that period of time.

As a result, the totals for sales revenue on GST/PST liability reports will be incorrect. As a 
precaution, QuickBooks Enterprise Solutions creates a backup file in case you need access 
to the deleted transactions later.

Cash basis reports

After you condense your data, you won’t get an accurate cash basis report for data that 
includes a condensed time period. This is because QuickBooks Enterprise Solutions has 
deleted the individual transactions that would have provided the information about 
whether transactions were paid. As a result, the totals will be incorrect.

To learn about… Search the Help index for…

Condensing your QuickBooks 
company file

condensing data

Restrictions for condensing data if 
you’re using the QuickBooks Payroll 
Service

condensing data
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Working with multiple users
Using QuickBooks Enterprise Solutions on a network is basically the same as using it on a 
single computer, with a few exceptions. For most of the tasks you perform everyday, up to 
10 users can access the company file at the same time. When users are allowed to work 
simultaneously in the company file, the file is in multi-user mode.

However, there are some activities that allow only one person at a time to be in the 
company file. These activities require the file to be in single-user mode. In this mode, other 
users must close the company file on their computer. Then the person who wants to 
perform the activity must switch the file to single-user mode. After finishing the activity, 
the person switches back to multi-user mode, and then the others may open the file and 
continue working as before.

Single-mode activities include:

� Setting up a new company file

� File operations such as backing up, condensing, or exporting data

� Some types of changes to lists

� Activities involving an Accountant’s Review copy

Network Options 

The company file should be located on a shared resource, like a server or a hard disk, that 
others have read/write access to. 

Tip: If your QuickBooks Enterprise Solutions CD is mounted on a shared CD-ROM drive, you can 
install from the mounted CD, but you cannot install across the network to a remote computer. 
That is, you must be sitting at the computer you’re installing to. (You must still store the company 
file on the shared resource.)

In a multi-user environment, all users must have the same version and release 
of QuickBooks Enterprise Solutions. You can update an older company file 
simply by opening it in your new version of QuickBooks Enterprise Solutions.

To purchase additional copies of QuickBooks Enterprise Solutions, call 1-888-333-8580.
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Peer-to-peer networks

In a peer-to-peer network, Jack, Sarah, and Amy each have a separate copy of QuickBooks 
Enterprise Solutions installed on their networked computers. Because Sarah does the most 
work on QuickBooks Enterprise Solutions, the company file resides on her computer in a 
folder or directory that both Jack and Amy have read/write access to. 

� For peer-to-peer networking, QuickBooks Enterprise Solutions requires either Windows 
NT 4.0 (or later) with Service Pack 3 (or later), or else Windows 98 or later.

Client-server networks

In a client-server network environment, Jack, Sarah, and Amy each have a copy of 
QuickBooks Enterprise Solutions installed on their networked computers. They all also have 
access to a file server. The company file is stored on the file server in a place that they all 
have access to.

� For server-based networking, QuickBooks Enterprise Solutions requires either Windows 
NT 4.0 Server (or later) with Service Pack 3 (or later), Windows 2000, or NetWare 
Network File Server 3.12 (or later).

QuickBooks Enterprise Solutions
installed & company file (company.qbw)

QuickBooks Enterprise
Solutions installed

QuickBooks Enterprise
Solutions installed
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Setting up multiple-user networking

Follow these steps to set up a multi-user environment for QuickBooks Enterprise Solutions. 

1 Make sure you have your computers properly networked. 

Please refer to your networking software documentation for instructions. 

2 Install a copy of QuickBooks Enterprise Solutions on each of the computers you’re 
working with. 

3 Have your QuickBooks Enterprise Solutions Administrator add your users (see “Setting 
up users and passwords” on page 101).

Note: Up to 10 users may have access to the company file simultaneously. However, 
you can set up as many users as you wish. For example, if you have 10 full-time 
employees and three part-time employees who need access to the company file, you 
can set up all thirteen employees as users of the company file. All thirteen are 
considered valid users of the company file, but only 10 can access the company file at 
the same time.

4 Register your copies of QuickBooks Enterprise Solutions after you have begun sharing 
the company file (see “Registering QuickBooks Enterprise Solutions” on page 8. 

This allows us to properly register the different copies of QuickBooks Enterprise Solu-
tions you are using. For more information about how to register, see “Registering 
QuickBooks Enterprise Solutions” on page 8.

5 (Optional) Have users customize their QuickBooks Enterprise Solutions working envi-
ronment. 

For example, each user can decide which menus will appear, the kinds and frequency 
of various reminders, and so forth.

QuickBooks Enterprise
Solutions installed

QuickBooks Enterprise
Solutions installed

QuickBooks Enterprise
Solutions installed

Company file
(company.qbw)
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Note: Your networked computers must all use the exact same version of QuickBooks Enterprise Solu-
tions. That means that if you install an update to QuickBooks Enterprise Solutions on one 
computer, you must install it on all your computers.

Using the multi-user mode

After you’ve set up the multi-user environment, up to 10 users can now log in to your 
QuickBooks Enterprise Solutions company file. They will only be able to access the features 
set up for them by the Administrator.

Switching between modes

To switch from multi-user mode to single-user mode:
1 Inform others working in QuickBooks Enterprise Solutions so they may close the 

shared company file and their copy of Enterprise Solutions. 

2 From the File menu, choose “Switch to single-user mode.” 

To switch from single-user mode to multi-user mode:
� From the File menu, choose “Switch to multi-user mode.”

Refresh after entering data

Anytime you are working with others in the company file, you can use the Refresh button 
to make sure you have the most current information on your reports. The Refresh button 
will update your screen with the information that others have entered into QuickBooks 
Enterprise Solutions since you selected the report or list. 

If you add other computers to your network

As your business grows, you may want to add additional computers to your office and, 
therefore, additional copies of QuickBooks Enterprise Solutions. 

Note: Your networked computers must all use the same multi-user version and release of QuickBooks 
Enterprise Solutions. 

After you add the computer to your network

1 Install QuickBooks Enterprise Solutions on the new machine.

2 Have a user open the company file.

To learn about… Search the Help index for…

Switching between modes multi-user mode, single-user mode

Your refresh options Refresh button
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3 Once a user has accessed the company file, register this copy of QuickBooks Enterprise 
Solutions.

Setting up users and passwords

Some parts of your company’s data are more sensitive than others. You can use passwords 
to make sure that each employee you have can only access those parts of QuickBooks 
Enterprise Solutions you want him or her to use.

Areas you can protect include sales and accounts receivable, purchases and accounts 
payable, chequing and credit cards, inventory, time tracking, payroll, sensitive accounting 
activities, and sensitive financial reports.

In this way, you maintain the security of your business data even when several people 
access your company file simultaneously. Until you set up users (and passwords) in your 
QuickBooks Enterprise Solutions company file, any person who accesses the file will have 
full access to all features of the program.

Setting up the Administrator and users

About the QuickBooks Enterprise Solutions 
Administrator

When you create a QuickBooks Enterprise Solutions company file, QuickBooks Enterprise 
Solutions creates a user called “Admin”. This user is the QuickBooks Enterprise Solutions 
Administrator for the company file.You can set up a password for the Administrator. When 
you assign a password to the Administrator, QuickBooks Enterprise Solutions prompts you 
to log on when you open the company file.

The QuickBooks Enterprise Solutions Administrator has unlimited access to the entire 
company file and is the only person who can add additional users and change access 
privileges. For each user he or she sets up, the Administrator designates:

� A password. The password can contain up to 16 letters and numbers and is not case 
sensitive. The user can change the password later, but the Administrator will still be 

The QuickBooks Enterprise Solutions password feature provides a basic 
degree of protection for your data, but it is not a complete security system.

For example, it will not prevent someone using Windows Explorer from deleting your 
company file.

Do not forget the Administrator’s password. Once you’ve chosen a password 
for the Administrator, write it down and store it in a safe place.

An Administrator’s password, if forgotten, cannot be recovered. If you forget this pass-
word, you’ll have to send your company file to Intuit (there is a fee associated with this 
service). 
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able to make changes to the user’s access privileges and can assign the user a new 
password, if necessary.

� Full access, selective access, or no access to each area of QuickBooks Enterprise Solu-
tions.

Setting up and customizing users

After you’ve set up the Administrator, you can add new users. Use the New User Setup 
Wizard to select the parts of QuickBooks Enterprise Solutions you want the new user to use.

� From the Company menu, choose Set up Users.

You can set up as many users as you want. However, only 10 users can access the company 
file simultaneously in QuickBooks Enterprise Solutions. 

Note: In Windows 2000, using the Users and Passwords control panel, you can set up each of your 
employees with a log-in profile. All the people who will use QuickBooks Enterprise Solutions must 
be set to Standard User (Power Users Group) or higher, not Restricted User (Users Group). 
Otherwise, QuickBooks Enterprise Solutions will not run properly.

When the Wizard finishes, a summary screen for all your users appears:

To learn about… Search the Help index for…

The different access areas of 
QuickBooks

passwords, access areas

The role of the QuickBooks 
Administrator

admin

Setting up users with passwords 
and access

users, adding

Changing passwords passwords, changing
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Using permissions to close an accounting period

Unlike most other accounting systems, QuickBooks Enterprise Solutions does not require 
you to “close the books” at the end of an accounting period. Closing books is often a 
complicated process that involves transferring information from one ledger to another and 
summarizing it. You can ask QuickBooks Enterprise Solutions for reports at any time, not 
just at the end of a period.

However, you may want to restrict access to the transactions of prior accounting periods to 
be sure the transactions are not changed without your knowledge. By requiring permission 
to delete, add, or edit any transaction before a chosen date, you can discourage accidental 
or casual changes to “closed” periods, but still make corrections in them when necessary. 
For example, you may want to prevent your staff from making changes to old transactions 
after you‘ve paid the GST or PST liabilities for them.

You can grant or deny access to older transactions when you set up a user. To deny users 
access to “closed” periods, do not grant them permission to Change or Delete Transactions 
recorded before the closing date. 

Then enter the closing date in the User List window (from the Company menu, select Set 
Up Users).

Recording who changed what

QuickBooks Enterprise Solutions can record all changes made to transactions and the name 
of the user who made the changes. Then you can review the changes in the Audit Trail 
report.

To keep an ongoing record of changes to transactions, you must make sure the audit trail is 
turned on and keep it on. If the preference is turned off for a period of time, QuickBooks 
Enterprise Solutions does not keep a record of changes, if any, to the transactions in that 
period.

Deleting passwords passwords, deleting

To learn about… Search the Help index for…

Using permissions to “close” 
your books

closing periods

To learn about… Search the Help index for…
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If your computer is older or you make a lot of changes to existing transactions, QuickBooks 
Enterprise Solutions may slow down slightly when the Audit Trail is on. Also, the size of 
your company file may increase more rapidly than it has in the past.

These changes occur because instead of writing over transactions you change, QuickBooks 
Enterprise Solutions records both the original transaction and all changes to it. However, 
for most users, the performance of QuickBooks Enterprise Solutions should not change.

Choose the date 
range you want to 
see on the report.The “Current 

Transaction” 
entry shows 
what the 
transaction is 
like now; the 
“Previous 
Transaction” 
shows what it 
was like before 
the change.

You can also 
see who made 
the change and 
when.

If you report financial information to the Québec Minister of Revenue, we 
strongly recommend that you turn on the Audit Trail feature permanently.

Doing you helps you comply with legislation from the MRQ.The legislation states that 
your accounting software cannot allow you to modify or delete data without keeping a 
record of the original data.

To turn on the Audit Trail permanently, install QuickBooks Enterprise Solutions accord-
ing to the instructions on page 5. Then, when you start QuickBooks Enterprise Solu-
tions, click Yes when asked if you report any information to the MRQ.

To learn about… Search the Help index for…

Using the audit trail feature audit trail
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Gathering income tax information

How QuickBooks Enterprise Solutions tracks tax information

As you set up your company in QuickBooks Enterprise Solutions, you select which tax form 
your business uses:

� The T1 General form, for individuals, unincorporated businesses, and partnerships; or

� The T2 form, for incorporated businesses.

Later, you choose the type of industry your business falls into. When you do, QuickBooks 
Enterprise Solutions sets up a suggested Chart of Accounts for your company and maps the 
accounts in it to the most appropriate lines of your tax form.

QuickBooks Enterprise Solutions uses CCRA standards to map the accounts in your Chart 
of Accounts to the best tax line on your return. If you select the T2 tax form, QuickBooks 
Enterprise Solutions uses the General Index of Financial Information (GIFI). GIFI is a 
“standardized” financial statement that allows the CCRA to compare industries more easily. 
It simply classifies the accounts you use (and that you list on the financial statement you 
file along with your tax return each year — usually, a balance sheet, a statement of retained 
earnings, and an income statement).

You are responsible for consulting a tax advisor or the Canada Customs and 
Revenue Agency about your tax circumstances.

Tax laws change often, and their application can vary based on the specific facts of your 
business. This information is not intended to be exhaustive.

You can select a tax form either in the EasyStep 
Interview (as you set up your company) or in the 
Company Information window (from the 
Company menu, choose Company Information).

It’s important to select the correct tax form for 
your business as you set it up in QuickBooks — 
changing it later can be very time consuming.

If you change your tax form (for example, from T1 to T2), all the mapping 
between your accounts and tax lines is lost.

You’ll need to reassign the appropriate tax lines to your accounts. It’s best to select the 
correct form as you set up your company.
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You may have noticed that, as you choose an industry type 
for your business in the EasyStep Interview, QuickBooks 
lists “GIFI for Small Business Corp.” as an option. If you 
choose it, your business’ Chart of Accounts will contain 
most of the GIFI accounts that the CCRA specifies, and you 
can delete the ones you don’t need. However, no matter 
what type of industry you choose in the EasyStep Interview, QuickBooks Enterprise 
Solutions uses GIFI to match the accounts for that industry to your T2 tax form.

As you create new accounts, you must manually map them to the correct tax line. 
Otherwise, your income tax data will not be correct. If you are unsure about what tax 
line you should map an account to, consult a tax professional or the CCRA for advice.

As well as letting you export tax data to Intuit Canada’s tax products, mapping your 
accounts properly lets you generate accurate tax reports, which keep you informed about 
your tax situation and help you prepare your income taxes.

After your accounts are mapped to the correct tax lines, QuickBooks Enterprise Solutions 
tracks tax-related transactions as you enter them. At any time, you can create reports and 
financial statements that show your company’s tax status and meet the requirements of the 
CCRA.

What QuickBooks Enterprise Solutions can track 

QuickBooks Enterprise Solutions can track information for various tax forms and schedules:

The choices that appear in the Tax 
Line menu as you edit an account 
depend on which tax form you 
select for your company.

To learn about… Search the Help index for…

Setting up accounts to track tax-
related income and expenses

income taxes, setting up for

QuickBooks tracks Output created

Income tax information, including information for the T1 
General, T2 for Incorporated Businesses, Schedule 3, 
Schedule 4, T777, T2124, T2124C, T2032, T2042, T2121, 
Rental, and Medical Expenses.
This list is not exhaustive. Your options will vary depend-
ing on your business.

A report detailing the amounts to be 
recorded on each line of the tax form you 
chose when you set up your company.
Much of this information can also be 
imported into QuickTax® and ProFileTM.
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Setting up income tax tracking

Use this checklist to make sure income tax tracking is set up properly. You may have set up 
some parts of income tax tracking when you created your company, but not others.

Task Comments
Search in the 
Help Index for...

�

Check that the first month 
of your company’s income 
tax year is set properly.

Likely, you or your accountant will 
have determined the best income tax 
year for your business before you set 
up your company in QuickBooks. If 
you are not sure what your tax year 
is, check last year’s return.
You can use either the calendar year 
or a fiscal year as your income tax 
year, but you must be consistent from 
year to year.

company, changing 
information about ❏

Check that the income tax 
form for your company is 
set properly:
� Use the T1 for individu-

als, unincorporated 
businesses, and partner-
ships.

� Use the T2 for incorpo-
rated businesses.

Important: If you change the tax form 
you use, all associations between 
accounts and tax lines are reset to 
<unassigned>. You’ll need to reas-
sign the appropriate tax line to each 
of your accounts.

� company, changing 
the tax form you file

� accounts, tax lines

❏

Choose a tax line for each 
account in your Chart of 
Accounts.

You may want to add or edit your 
accounts to more closely match your 
tax forms.

� accounts, tax lines
� accounts, adding to 

your chart of accounts

❏

Check your tax situation 
with income tax reports 
and transfer your tax data 
to QuickTax.

For more information on 
this step, see “Reporting 
income tax information” 
(following).

Create an Income Tax Detail or 
Income Tax Summary report (see 
“Reporting income tax information” 
on page 108). Be sure that the “To” 
and “From” dates cover your last 
income tax year correctly.

Follow the instructions that came 
with QuickTax to import data from 
QuickBooks. 
(Note that QuickTax imports data 
from the last company file you 
opened with QuickBooks.)

� report finder
� QuickTax ❏
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Reporting income tax information

 Once you’ve assigned tax lines to your accounts, QuickBooks Enterprise Solutions tracks 
tax-related income and expenses automatically throughout the year. To check your 
business’ tax situation at any time, use QuickBooks Enterprise Solutions’ income tax 
reports. These reports show your accounts, the tax lines you’ve associated with them, and 
the amount to be recorded on your tax form, and can be printed for later reference.

Use the Report Finder (under the Reports menu) to create income tax reports. In the Report 
Finder, select Accountant and Taxes from the drop-down menu, then choose the income tax 
report you want from the list. Remember that the “To” and “From” dates must cover your 
last income tax year correctly!

To make completing your income tax return even simpler, you can transfer your tax 
information from QuickBooks Enterprise Solutions to one of Intuit Canada’s tax products 
(see “Transferring tax information to Intuit tax products” on page 109).

Getting the numbers you need to file your income 
taxes

Whether you fill out your income tax forms by hand, pass your company’s tax information 
on to your accountant, or transfer your tax data from QuickBooks Enterprise Solutions to 
one of Intuit Canada’s tax products, complete the following steps to make sure your 
numbers are correct.

� Check the tax line assignments for your accounts. The accuracy of your tax reports 
depends on each tax-related account being assigned to the correct tax line (see “How 
QuickBooks Enterprise Solutions tracks tax information” on page 105).

An easy way to check that all your accounts are assigned to the proper tax lines is to 
create an Income Tax Preparation report. It lists the accounts in your Chart of Accounts 
and which tax lines are assigned to them.

� Check that the amounts in your Income Tax Summary report are correct.

One way to check is to compare your Income Tax Summary report to your Trial Balance 
(make sure they cover the same period of time!). Check that the account totals (Trial 
Balance) are the same as the matching tax line totals (Income Tax Summary report). If 
they’re not, an account may not be mapped properly to a tax line. (Remember, too, that 
you may have more than one account mapped to a tax line. If so, the sum of the 
account totals should be the same as the tax line total.)

To learn about… Search the Help index for…

Checking tax line assignments to 
ensure the accuracy of your 
income tax summary report

income taxes, filling out tax forms

Checking the amounts distributed 
to various accounts

income taxes, filling out tax forms
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Income Tax Summary report

The Income Tax Summary report shows the amount associated with each tax line for the 
tax form you specified during setup.

Income Tax Detail report

The Income Tax Detail report shows the amount associated with each tax line for the tax 
form you specified during setup, and includes individual transactions.

Many businesses find this level of detail is the most convenient for filling out income tax 
forms.

Income Tax Preparation report

The Income Tax Preparation report shows the accounts in your Chart of Accounts and 
which tax lines are assigned to them.

Transferring tax information to Intuit tax products

If you use a current version of QuickTax or another Intuit tax product to prepare your tax 
return, you can transfer your tax data from QuickBooks Enterprise Solutions directly into it 
in a few minutes.

Note: QuickBooks Enterprise Solutions only exports information to Intuit tax products. For more infor-
mation about these products, visit http://www.intuit.com/canada/ or http://www.QuickenStore.ca/

Your Intuit Canada tax product will have instructions on transferring information from 
QuickBooks Enterprise Solutions. It will import data from the last company file you opened 
with QuickBooks Enterprise Solutions.

Make sure the reporting preference is set to the accounting method you use 
for tax reporting: Accrual or Cash.

From the Edit menu, choose Preferences, then Reports & Graphs, and then click the 
Company Preferences tab. 

To learn about… Search the Help index for…

Transferring tax information from 
QuickBooks to your tax software

� QuickTax
� ProFile
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Solving printing problems
If you’re having trouble printing, try checking these areas before you call technical support. 
You can also visit http://www.quickbooks.ca/ for information about specific printers.

When should I reinstall my printer driver?

If your printer has any of these problems, you may have to reinstall your printer driver in 
Microsoft® Windows or contact the printer’s manufacturer for assistance:

� Your printer isn’t printing at all, from any program.

� Your printer prints “garbage” from any program.

� Your printer won’t feed paper correctly.

Nothing happens when you try to print

There are several things you can try:

� Make sure the printer is turned on and is online.

� Try printing from another application to verify that Windows can still communicate 
with the printer.

� Check for stalled printing jobs on your printer:

a From the Start menu, select Settings, then Printers.

b In the list, double-click the printer you’re using. 

c Select the stalled print job in the list.

d From the Document menu, select Cancel.

The form is clipped on the top, bottom, left, or right

Likely, you only need to adjust the form’s margins and alignment. However, some printers 
can’t print the entire width needed for the standard forms that come with QuickBooks 
Enterprise Solutions. In this case, you’ll need to customize the form in QuickBooks 
Enterprise Solutions to have larger margins.

To adjust the margins for forms:
1 In QuickBooks Enterprise Solutions, from the File menu, choose Printer Setup.

2 Choose the form you want from the Form Name drop-down list.

3 Click the Margins tab.

� If there is no Margin tab, you need to adjust the form’s alignment instead. See “To 
adjust the alignment of forms:” on page 111.
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4 Set the margin you want in the Left, Right, Top, and Bottom fields.

QuickBooks Enterprise Solutions displays the margins in inches, but you can enter 
margin sizes in inches (in), millimetres (mm), centimetres (cm), points (pt), or picas 
(pi).

If you find that QuickBooks Enterprise Solutions leaves larger margins than you 
entered, your printer may be unable to print outside a specific area. Most printers 
cannot print with margins smaller than .25 inches. Many require margins no smaller 
than .5 or .67 inches. Check your printer manual or contact the printer manufacturer 
if you have such a problem.

If you’re using a continuous printer, you may have to slide the paper clamps over to get 
the printer to start at the position you want.

5 Click OK to save the changes.

To adjust the alignment of forms:

Coarse alignments:

This adjustment is only needed for continuous-feed (dot matrix) printers. Use it when the 
printing on your forms is off vertically by more than a line or two.

1 Make sure your printer is turned on and is online, with blanks of the forms you want 
to print inserted to the printer’s paper feeder.

2 From the File menu, choose Printer Setup.

3 Choose the form you want from the Form Name drop-down list.

4 Click Align. (If the Align button is not available, that form cannot be aligned.)

5 If a list of templates appears, select the one you want and click OK.

QuickBooks Enterprise Solutions displays a window where you can choose coarse or 
fine adjustments.

6 Click Coarse.

7 Click OK to print a sample form.

8 Look at the pointer line that QuickBooks Enterprise Solutions prints across the middle 
of the sample form. Determine the number that it points to. Do not adjust your 
printer at this time.
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9 Type the number in the Pointer Line Position field in the window that appears, then 
click OK.

If necessary, QuickBooks Enterprise Solutions advances the paper in the printer to 
correct the alignment, and then prints another sample.

10 Note the correct position of the form for future positioning.

Visually line up part of your printer, such as the sprocket cover or print head, with one 
of the position numbers along the edge of the form. Make a note of this spot, so you 
can use it in the future as an alignment cue to position your forms visually.

Even if your printer has an “autoload” or “park” feature (the printer puts the paper in 
the same place each time you load it), you need to manually line up your forms for 
coarse alignment using a visual cue. QuickBooks Enterprise Solutions cannot remember 
placement relative to your printer’s autoload point.

11 (Optional) In the Align window, click Fine to make further adjustments, then go on to 
Step 5 of the Fine-alignment process (below).

Fine-alignment adjustments:

This method of adjustment is available for all type of printers.

1 Make sure your printer is turned on and is online, with blanks of the forms you want 
to print inserted to the printer’s paper feeder.

2 From the File menu, choose Printer Setup.

If the text does not 
line up properly on 
the form, determine 
the closest number 
to the pointer line, 
rounding up. 

In this example, 
you’d enter 81.
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3 Choose the form you want from the Form Name drop-down list.

4 Click Align. (If the Align button is not available, that form cannot be aligned.)

5 If a list of templates appears, select the one you want and click OK.

6 If you are using a continuous-feed (dot-matrix) printer, QuickBooks Enterprise Solu-
tions displays a window where you can choose coarse or fine adjustments. Click Fine.

7 Click Print Sample.

QuickBooks Enterprise Solutions prints the form with a small alignment grid (1/10 inch 
squares) on it.

8 Check the horizontal and vertical alignment of the text in the alignment grid.

9 Enter amounts in the Vertical and Horizontal fields to move the printed text to align 
it. (The alignment values are in hundredths of an inch. For example, 25 means 0.25 of 
an inch.)

� For continuous-feed printers, if the printing is off to the left or right by a large 
amount, move the form over in the printer to correct the problem. Use the Fine 
Alignment window for changes of less than 0.25 inch only.

10 Click Print Sample to see if the form is now aligned correctly.

11 When you are finished making adjustments, click OK.

QuickBooks Enterprise Solutions saves the horizontal and vertical alignment adjust-
ments.

Problem Solution

The text prints too 
high.

Decrease the number in the Vertical field. For example, if the 
text is printing 2 squares (that is, 0.2”) too high, type -20 in the 
Vertical field.

The text prints too 
low.

Increase the number in the Vertical field. For example, if the text 
is printing 1 1/2 squares (that is, 0.15”) too low, type 15 in the 
Vertical field. 

The text prints too 
far to the left.

Increase the number in the Horizontal field. For example, if the 
text is printing a 1/2 square (that is, 0.05”) too far to the left, type 
5 in the Horizontal field.

The text prints too 
far to the right.

Decrease the number in the Horizontal field. For example, if the 
text is printing 1 square (that is, 0.1”) too far to the right, type -10 
in the Horizontal field.



114 Chapter 4   QuickBooks Enterprise Solutions Basics

12 Click OK in the Printer Setup window.

Dates and the bottoms of letters are clipped on forms

The font you‘re using may be too large. In the Printer Setup window, click Font. Try a font 
size of 10 points or less.

Changing fonts
1 From the File menu, choose Printer Setup.

2 Choose the form you want from the Form Name drop-down list.

Note: You can’t change the fonts on some forms here. You can change the fonts on these forms by 
selecting Templates on the forms and customizing them.

3 Click the Fonts tab and then the Font button.

4 Choose the font you want.

Not all options are available for all fonts.

5 Click OK in the Select Font window and the Printer Setup window to save the changes.

Printing is slow

There are several things you can try:

� Lower the print resolution for your laser printer: In the Settings tab of the QuickBooks 
Printer Setup window, click Options. Then click the Graphics tab and set a smaller 
number of dots per inch. 

� If you’re printing on blank paper or letterhead, do not choose to print lines around 
each field. In the Settings tab of the QuickBooks Printer Setup window, clear the Print 
Lines checkbox.

� Make more computer memory (RAM) available by closing down programs you don’t 
need.

You can change to italic, bold, 
or a combination.

Choose a point size. Most 
people prefer a size between 9 
and 12 points. 

A description for the selected 
font type appears here.

Choose the font.

You can see what the font 
looks like here. 

Select one or both of these 
checkboxes to strikeout 
and underline text.

Choose a colour (not 
available for cheques).
If you have a colour 
printer, you can print 
any other form in colour.
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There are several types of sales tax in Canada: the 

Goods and Services Tax (GST), the Harmonized Sales 

Tax (HST), and provincial sales taxes. The sales tax 

feature of QuickBooks handles all of these. It helps 

you determine how much sales tax to collect on the 

sales you make, how to record the sales tax you pay 

on business purchases, and how to pay what you owe 

when it is due. Chapter 5

You are responsible for consulting a tax advisor about the sales taxes 
that apply to your business.

For information about the GST and HST, contact the CCRA. For information 
about your provincial sales taxes, contact your provincial minister of finance.

Tracking and 
paying sales 
taxes

How to collect 
and pay the right 
amount of GST 
and PST

Does your 
business need to 
be registered?

116

Setting up sales 
taxes

117

Determining your 
sales tax 
liabilities

121

Remitting your 
tax liability to the 
government

121

Locking older 
transactions 
after paying your 
GST/PST 
liabilities

123
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Does your business need to be registered?
Although very small businesses are exempt, the Canada Customs and Revenue Agency 
(CCRA) recommends that all businesses register to collect the Goods and Services Tax (GST) 
or, in provinces where the provincial sales tax has been combined with the GST, the 
Harmonized Sales Tax (HST).

Registered businesses track the GST or HST collected from customers on sales and paid on 
purchases for the business. Usually, you collect more sales tax than you pay out and must 
remit the difference to the CCRA. (Occasionally, you may pay out more than you collect 
and claim a refund.)

Many provincial governments also require you to register to collect a provincial sales tax 
(PST or, in Québec, QST). In most provinces, for provincial sales taxes, you track only the 
amount you collect (instead of the amount you collect and the amount you pay) and remit 
that amount to the government.

In Québec, however, the QST works much the same way as the GST: businesses may be able 
to deduct the amount of QST paid on business-related purchases from the amount of QST 
collected from customers, then remit the difference.

Check with the CCRA, your province’s Ministry of Finance, or your accountant about how 
your business should handle federal and provincial sales taxes.

How QuickBooks calculates the GST and PST

QuickBooks uses your company address to determine what rates of GST and PST apply in 
your province and assigns these rates to default sales tax codes.

It then calculates the GST and PST separately for each item on sales or purchase forms 
according to the sales tax code you assign to it. QuickBooks displays the GST and PST totals 
in boxes at the bottom of the form, then adds these amounts to the total. The HST is 
calculated as one rate in the GST field.

Tax amounts are tracked in your GST Payable and PST Payable liability accounts. When you 
make a sale, QuickBooks records the GST on the transaction as an increase in your GST 
liability because you must remit the amount of tax to the government. When you make a 
purchase, the GST on the transaction is a decrease in your GST liability because you can 
claim the expense as an input tax credit.

Similarly, the PST on sales is recorded as an increase in your PST liability. However, whether 
you record the PST you pay on purchases as a decrease in your PST liability depends on 
whether your provincial government allows you to claim input tax credits for it.

At regular intervals, you must file GST and PST returns and create cheques to remit the 
amount you owe to the federal and provincial governments. As your business grows, you 
have to file GST/PST returns more often. Once a sales tax entry is included on a GST or PST 
return that you’ve filed, it is marked as reported. If you enter a transaction from a previous 
reporting period after you’ve already sent your return, it will automatically be included in 
the next return you send.
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Setting up sales taxes

Turning on the sales tax preference
1 From the Edit menu, select Preferences.

2 Select GST/PST from the scroll box, then click the Company Preferences tab.

3 Set the preferences according to your business needs, then click OK.

Should I track my provincial sales tax separately?

When you buy an item for your business, in most provinces, you are either exempt from 
paying the PST on it if the item is to resell or else you cannot claim the PST you paid on it 
as an input tax credit (unlike the GST). That means that, for accounting purposes, you can 
consider the PST on an item you buy as part of its cost and not bother tracking it separately.

However, if you can claim back the PST you pay on items for your business (as in Québec) 
or want to record the amount of PST you pay for your own information, you can track the 
PST separately. In the first case, the PST you pay is assigned to your PST Payable account to 
reduce your PST liability to the government; in the second case, the PST you pay is assigned 
to a PST expense account for your information only.

If your province 
uses the 
Harmonized 
Sales Tax (HST), 
only track the 
GST. You do not 
need to track 
PST as well.

You can enter the 
business numbers 
that are assigned 
to you by the CCRA 
and your 
provincial Minster 
of Finance here.

If you have 
customers with 
special tax 
status, check 
this box. You 
will then be able 
to assign a tax 
code to his or her customer profile. On sales forms, the tax 
code you assign to customers overrides the tax codes you 
assign to items.

This code is 
assigned to all 
new items by 
default.
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Entering sales tax liabilities as of your start date

If your business collected the GST or your provincial sales tax before you began using 
QuickBooks, you need to enter the amount you owe the government for each tax (that is, 
your sales tax liabilities) as of your QuickBooks start date.

1 From the Vendors menu, select Sales Tax, then choose Adjust Sales Tax Due. The Sales 
Tax Adjustment window appears.

2 In the date field, type your QuickBooks start date or click  to select it from the Quick-
Books calendar.

3 Select the vendor (government agency) that you are adjusting for, from the Sales Tax 
Vendor list.

4 Select whether this is a tax transaction on items bought or items sold.

5 Enter the Adjustment Amount:

� If you owe sales tax, enter the amount as a negative number. Your Sales Tax 
Account (e.g., GST Payable) will record the amount under the Increase column.

� If you’re entitled to a refund, enter the amount as a positive number. Your Sales 
Tax Account (e.g., GST Payable) will record the amount under the Decrease 
column.

6 Select Opening Bal Equity from the Adjustment Account drop-down list.

7 Click OK.

Changing the default tax codes

In rare cases, you may need to adjust the default sales taxes that QuickBooks sets up. 
For example, if your province charges an increased amount of sales tax on an item your 
business sells, you may want to set up a new sales tax code for the higher rate.

To create a new tax code:
1 From the Lists menu, choose Tax Codes List.

2 Click the Tax Code menu button, then choose New.

A check mark in this column means 
that the PST is calculated on the 
sale price after the GST has been 
added to it (“piggybacked on the 
GST”). 

If the column is clear, the PST is 
calculated on the sale price 
independently of the GST.
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3 Fill in the information for your new tax code.

4  Click OK.

What the Zero Rated (Z) tax code is for

Under the GST, certain goods and services are taxed at a rate of 0% instead of the usual 7%. 
These items are called Zero Rated.

(To see whether the items you sell are Zero Rated, you should check with the CCRA or your 
accountant. Some examples are basic groceries such as milk, bread, and vegetables; 
agricultural products such as grain, raw wool, and fish for human consumption; 
prescription drugs and medical devices; and items manufactured for export.)

Note: Zero Rated items are not tax exempt, and should not be assigned the Exempt tax code (E).

If you sell a Zero Rated item, you charge your customers 0% GST on it. This means that you 
do not collect any GST to remit to the government. However, because the item is taxable, 
you can claim input tax credits (the GST you paid on the materials you needed to produce 
the item) for it. When you file your GST return, you receive a refund based on these credits.

Assigning tax codes to items

To let QuickBooks know how to tax the items or services you sell and purchase for your 
business, assign each a tax code as you set it up in the Item List.

Once you have done so, QuickBooks applies the correct sales taxes to them on sales and 
purchase forms. (If you are unsure of what taxes apply to your business, check with the 
CCRA, your provincial Ministry of Finance, or your accountant.)

Enter the GST 
and PST 
percentages for 
this tax code.

Enter a unique 
letter or number 
to identify this 
tax code and a 
description.

If the PST is to be calculated “on top of” the GST (that is, the GST is calculated 
on the sale, added to the total, and the PST is then calculated on this new 
total), select the Calculate Provincial Tax on GST (Piggyback) checkbox.

If either the GST or PST does not apply 
to a new tax code you’re setting up, 
select its Tax Exempt box.

Note that selecting this box is not the 
same as leaving the percentage at 
zero. (See “What the Zero Rated (Z) tax 
code is for” below.)

To learn about… Search the Help index for…

Assigning tax codes to items items, assigning tax codes to
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Assigning tax codes to customers 

If you have regular customers who have special tax status (for example, who are exempt 
from paying the GST or PST), you can assign them customer tax codes that override item 
sales tax codes on all forms.

First, ensure the Allow customer tax codes preference is selected in the GST/PST preferences. 
Then you can add the tax code to the customers’ profile in the Customer:Job list.

Using tax codes on sales and purchases

Once you have assigned tax codes to the items you sell and buy and assigned customer tax 
codes to customers with special tax status, QuickBooks automatically applies the correct 
taxes as you fill in forms. The tax code appears to the right of the Amount column and the 
amount of tax above the total.

If you need to apply a different tax code to an item, you can change the item’s tax code 
from the form. In the rare event that you need to adjust the amount of tax on a transaction 
manually, adjust the amount directly in the GST or PST box.

To learn about… Search the Help index for…

Turning on the "Customer Tax 
Codes" preference

customers, tax codes for

Setting up customers customers, adding new

The tax code that is being applied to this item 
is shown in the TAX column. QuickBooks gets 
this tax code from the Item List where you 
assign a default tax code to items. 

These fields can be edited, 
so you can manually 
change the amount of tax 
that QuickBooks calculates 
for you.

If you need to create a 
new tax code, you can do 
so from the Tax Codes 
List under the Lists menu.

To learn about… Search the Help index for…

Using a tax code on a form tax codes, changing on forms
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Determining your sales tax liabilities
If you collect sales tax from customers, you also have to make periodic payments of it to the 
government. You can check what your sales tax liability is to the CCRA and your provincial 
Ministry of Finance by creating GST and PST Liability reports.

Creating GST and PST Liability reports

These reports provide complete information about the sales tax your company has collected 
on sales, paid out on business-related purchases (where applicable), and owes to (or will be 
reimbursed from) the government for a particular period.

The CCRA requires businesses to report the GST on an accrual basis, so the GST Liability 
Report isn’t affected if you change your accounting basis to Cash in the Reports and Graphs 
preferences window.

You create GST and PST Liability reports the same way. Provinces that use the HST only 
need to create GST reports as their provincial sales tax is included in it.

� From the Reports menu, choose Vendors & Payables, then GST Liability or PST Liability. 
Make sure the dates accurately reflect the reporting period.

This report includes the following information for the Goods and Services Tax Return you 
file at regular intervals:

� Total sales and other revenue not including GST or PST (Field 101: Sales & Other 
Revenue).

� Total purchases, which is subtracted from Sales & Other Revenue to calculate your Net 
Sales.

� Total GST collected and collectible on sales (Field 103: GST Collected and Collectible).

Canada Customs and Revenue considers invoices due on the date you issue them. So, 
for any given reporting period, unpaid invoices with GST must still be included in the 
GST “collected and collectible” for that period.

� Total input tax credits (Field 106: Input tax credits).

Remitting your tax liability to the government 

Use the Pay Sales Tax function to create cheques for the sales tax you’ve collected, which 
you can then print and send in to the CCRA or your provincial Minister of Finance, along 
with your return.

You must file a return for each reporting period, even if you do not owe money or expect a 
refund. For reporting periods with no business transactions, file a nil return.

1 From the Vendors menu, choose Sales Tax, then Pay Sales Tax.

QuickBooks displays the Pay Sales Tax window.

2 Select which tax agencies (Vendors) to pay, by clicking in the Pay column.
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3 Note that the Payment Account field shows your chequing account.

To draw the cheque on a different account, just select it from the drop-down menu.

4 If you want QuickBooks to print a cheque, select To be printed. If you are writing a 
cheque by hand, select Assign cheque no.

5 Click Next.

6 QuickBooks displays your tax return. You can make adjustments directly on the form, 
with the exception of lines 103 and 106. To adjust the amounts on these lines, click the 
Adjust button beside the line. 

7 Click Next.

QuickBooks displays the tax return, after any adjustments, ready for printing.

8 Click Print.

QuickBooks creates and records the cheque(s) to the Receiver General or Minister of 
Finance. You can now print the cheques, by choosing Print Forms from the File menu, 
then choosing Cheques. It also updates your Liability reports and Payable registers to 
show that you’ve made a payment. 

If you receive a Sales Tax refund

You create and file a sales tax return the same way in QuickBooks, regardless of whether you 
have to remit tax or you have a refund due. Either way, you use the Pay Sales Tax feature, 
as described on the previous page. Once you’ve created your return with a refund owing, 
QuickBooks enters the refund amount into an invoice, using the preset Receiver General - 
Receivable customer item. When you receive the refund, enter the amount as a payment 
received against this invoice. If the preset Receiver General - Receivable customer item does 
not appear in the Customer:Job dropdown list, it may be set to "inactive." Open the 
Customer:Job list (by choosing 

Adjusting your GST Payable or PST Payable account

From time to time, you may need to make adjustments to your GST Payable or PST Payable 
account, either increasing or decreasing the amount you must remit. 

These adjustments may include writing off the GST amount of a bad debt. For example:

Taxable items on invoice $200.00
GST due 14.00
PST due 18.00
Total $232.00
GST reported in the 4/1/2002 - 6/30/2002 reporting period
PST reported in the 4/1/2002 - 6/30/2002 reporting period
No payment received on invoice in 2002
Write off bad debt in 2002
Claim a GST adjustment of 7/107 x $214 = $14
Claim a PST adjustment of 7/107 x $218 = $18 
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To adjust your GST Payable or PST Payable account:
1 From the Vendors menu, choose Sales Tax, then choose Adjust sales Tax Due.

2 Type the transaction date and an entry number.

3 In the detail area, verify the GST Payable or PST Payable account and the debit or credit 
amount.

4 (Optional) Type a memo for this transaction.

5 Continue by entering the appropriate account, such as Bad Debt, in the second distri-
bution line, and enter the debit or credit amount.

If you don’t have a Bad Debt account, you can add one as you go. Choose Expense or 
Other Expense for its account type.

6 Click OK.

Locking older transactions after paying your GST/PST liabilities

After you’ve paid your GST and PST liabilities for a given period, you won’t want your 
employees to change any of the transactions that affected your payment. QuickBooks lets 
you restrict access to these older transactions to be sure they are not changed without your 
knowledge. By requiring permission to delete, add, or edit transactions before a chosen 
date, you can discourage changes to these “closed” accounting periods, but still make 
corrections when necessary.

To deny users access to “closed” periods, when you set up user names and passwords for 
your staff, do not grant them permission to Change or Delete Transactions recorded before 
your closing date. Then enter a closing date that is later than the date of your payment. For 
more information about setting up user names and passwords, see “Setting up users and 
passwords” on page 101.

To lock older transactions after paying sales tax liabilities:
1 To set up or edit user names for your staff, from the Company menu, select Set Up 

Users.

2 Do one of the following:

� Select an existing user name from the list, then click Edit User, or

� Click Add User to create a new user name.

3 If you do not want this user to have access to your historical transactions, give him or 
her access only to “Selected areas of QuickBooks” when the wizard prompts you.

4 Work through the wizard until you reach the Changing or Deleting Transactions 
screen.

5 Select No to the question, “Should this user also have the ability to change or delete 
transactions that were recorded before your closing date?”

6 Work through the rest of the wizard for this user, then any other users in your user list 
or that you are adding.

7 At the bottom of the user list, click Closing Date.

� If you closed the user list, from the Company menu, select Set Up Users.
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8 Type the date up to which your books are closed, then click OK.

9 Click Close to close the user list.

To learn about… Search the Help index for…

Using permissions to “close” 
your books

closing periods
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Multicurrency: an overview
In QuickBooks Enterprise Solutions, you can record transactions in currencies other than 
the Canadian dollar. With the multicurrency feature turned on, QuickBooks Enterprise 
Solutions tracks foreign transactions and accounts for them correctly, regardless of the 
currency you use. For example, if you sell goods to the United States, you might enter some 
transactions in US dollars and others in Canadian dollars. Tracking these foreign-currency 
transactions is as easy as selecting the foreign customer or vendor from your customer:job 
list; QuickBooks Enterprise Solutions takes care of everything else.

With multicurrency, you can also set up a fixed foreign price for items, or enter prices in 
your home currency and then have QuickBooks Enterprise Solutions calculate the foreign 
price based on the current exchange rate. See “Set up foreign prices for items” on page 130 
for more information on setting up foreign prices.

The home currency refers to the currency that is used in the country in which your business 
is located. QuickBooks Enterprise Solutions selects the Canada Dollar as the home currency 
by default. In registers and forms, home-currency transactions are displayed in the home 
currency, whereas foreign transactions are displayed in their foreign currency. On most 
reports, however, foreign balances are converted into the home currency.

Note: Once multicurrency is turned on, you cannot turn it off. We recommend that you make a backup 
of your company’s file before turning multicurrency on. 

A note about exchange rates

Exchange rates of currencies change daily, and these fluctuations can generate a gain or loss 
in your books. QuickBooks Enterprise Solutions accounts for these gains and losses by 
tracking them in the Exchange Gain/Loss expense account which is created automatically 
when multicurrency is turned on (see “Exchange rates and how they affect your 
transactions” on page 133 for more information).

Setting up multicurrency
If you deal in a currency other than the Canadian dollar, you need to turn on the 
multicurrency feature. This feature is turned off by default, as many businesses deal only 
with Canadians using Canadian dollars.

After multicurrency is turned on, you will need to assign a currency to each of the 
customers and vendors with whom you deal  on an international basis. Customers and 
vendors that were created before you turned on the multicurrency feature are automatically 
assigned your home currency (by default, "Canada Dollars"). The home currency is used to 
determine the value of all other currencies, and its exchange value is fixed at 1. Once the 
home currency is chosen, it cannot be changed or deleted.
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Each foreign currency you deal in must have a matching Accounts Receivable or Accounts 
Payable account in the same currency. This allows you to track transactions specific to each 
currency that you set up in QuickBooks Enterprise Solutions. You can also set up foreign-
currency Bank and Credit Card accounts. 

To setup multicurrency, you need to complete these tasks:
1 “Turn on the multicurrency preference” on page 127.

2 “Set up foreign accounts” on page 128.

3 “Create foreign customers and vendors” on page 129.

4 (Optional) “Set up foreign prices for items” on page 130.

Turn on the multicurrency preference

If you invoice, receive payments or pay bills in a currency other than the Canadian Dollar, 
you should turn on the multicurrency feature. You can do so in one of two ways: in the 
EasyStep Interview as you create a new company (see “General section” on page 49), or in 
the Preferences window.

Once multicurrency is turned on, you cannot turn it off. We recommend that you back up 
your company file before turning multicurrency on. That way, you can go back to the way 
your company was, if for some reason you don’t want to use the multicurrency feature 
anymore.

To turn on multicurrency from the Preferences window:
1 From the Edit menu, choose Preferences.

2 From the scroll box on the left, select Accounting.

3 In the Company Preferences tab, select Use multicurrency.

4 Click OK. Multicurrency is now turned on, and the home currency is set to "Canada 
Dollar". 

1
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You can now:

� Assign a foreign currency to a customer and vendor.

� Use a currency list which includes many common currencies and the ability to 
download current exchange rates in to QuickBooks from the Internet.

� Generate a report to calculate unrealized and realized gains and losses.

� Quickly convert foreign dollars to Canadian dollars or Canadian to foreign dollars 
with the Currency Calculator.

� Use the "Exchange Gain & Loss" expense account to track gains and losses due to 
fluctuations in exchange rates.

� Set a foreign price for items you sell frequently to foreign customers.

� Locate multicurrency transactions with two new filters in the "find" function. 

Set up foreign accounts

You can choose a foreign currency for Bank, Credit Card, Accounts Receivable (A/R) and 
Accounts Payable-type (A/P) accounts.

You do not need to set up foreign Bank and Credit Card accounts to track foreign 
transactions. However, for each foreign currency you deal in, you must create an A/R 
account (if you have customers), an A/P account (if you have vendors), or both in that 
currency. For example, if you have customers in the USA and England, you’ll need two 
additional A/R accounts: one in US Dollars and the other in UK Pounds. You cannot use 
the same A/R and A/P accounts you use for your Canadian-dollar transactions because 
the Canadian dollar and other currencies rarely trade as equals.

Note: Once a transaction is recorded in an account, the account’s currency cannot be changed.

To set up a foreign account:
1 From the Company menu, select Chart of Accounts. The Chart of Accounts appears.

2 On the Chart of Accounts window, click the Account menu button, and choose New.

3 Create an A/R or A/P account for each currency in which you want to deal. See the 
online help for information on how to set up a new account.

When you select a currency, the Exchange field shows its exchange rate. If you want to 
update the exchange rate, do it from the Currency List. See “Using the Currency List” on 
page 131 for more information.
 

2

To learn about… Search the Help index for…

Setting up accounts accounts
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Create foreign customers and vendors

After you’ve set up foreign A/R and A/P accounts, you can set up the foreign customers or 
vendors who will be using these accounts. To do so, create the customer or vendor as you 
normally would and choose the correct currency from the drop-down list in his or her 
profile. Once a currency is assigned to a customer or vendor, all future transactions 
involving him or her are recorded in the currency you assigned, with the exception of bill 
and credit card payments (in this situation, the account you use to pay determines the 
currency of the transaction).

Existing customers or vendors (that is, ones you set up before turning on the multicurrency 
feature) are automatically assigned the Canadian-dollar currency. If you want to use a 
different currency for these individuals, you’ll need to create new customer or vendor 
profiles in the correct currency.

Note: Once a transaction has been recorded for a foreign customer or vendor, you cannot change the 
currency assigned to him or her. You cannot assign a foreign currency to the Receiver General 
and Minister of Finance vendors.

To create a new foreign Customer, Vendor, or Other Name:

Open a new profile and fill it in as you normally would with the following exceptions noted 
on the graphic below.

Only one currency can be associated with a Customer, Vendor or Other Name. If you deal 
with a customer or vendor in more than one currency, you’ll need to create an additional 
customer or vendor profile for each currency in which you do business.

3

2 Select the currency you 
want to associate with 
this profile. If the currency 
you want is not in the 
drop-down list, select 
<Add New> to create a 
new currency. 

Also, if the exchange rate 
is out-of-date, update it.

1 (Optional) Enter an 
opening balance if 
applicable. 

Once a transaction 
is recorded for a 
customer, you 
cannot enter an 
opening balance in 
this window.
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Set up foreign prices for items

By default, items in the Item List are priced in the Canada-dollar currency. What that means 
is when an item is used in a foreign transaction, the price of the item is calculated by 
multiplying the home-currency amount with the foreign currency’s exchange rate. Because 
the price is converted based on an exchange rate, there is a possibility that the price of an 
item may go up or down if the exchange rate changes. 

QuickBooks Enterprise Solutions allows you to set up a fixed foreign price on items you sell 
frequently to one particular country. By doing this, the foreign price of the item will not 
change due to fluctuations in exchange rates. You can only select one other currency 
besides your home currency to assign to item prices.

To turn on foreign pricing:
1 From the Edit menu, choose Preferences.

2 From the scroll box on the left, select Accounting.

3 In the Company Preferences tab, select Use foreign prices on items.

4 From the "Foreign item currency" drop-down list, select the currency you want to use 
as a fixed foreign price on items. If you deal with more than one foreign currency, 
choose the currency you deal in the most.

5 Click OK.

4

Once the foreign 
pricing preference 
is turned on...

... you’ll see an extra field in the New 
Item window where you can enter a 
fixed foreign price for an item.

QuickBooks uses an item’s Foreign 
Price in transactions where the 
currency matches the currency that you 
chose in the foreign pricing preference. 
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Using the Currency List

The Currency List is a list of all the currencies that are set up in QuickBooks Enterprise 
Solutions. We’ve included a total of 43 currencies in the Currency List. The list contains 
information about each currency such as its exchange rate, currency symbol, and hotkey. 

When a foreign transaction is recorded, QuickBooks Enterprise Solutions uses the exchange 
rate from the Currency List to convert the foreign amount into the home-currency amount. 
You should rarely need to make changes to the Currency List, except to add and delete 
currencies, and update exchange rates. You cannot delete your home currency.

To create a currency:
1 From the Lists menu, choose Currency List.

2 At the bottom of the Currency List, click the Currency menu button and select New. 
The New Currency window appears

.

3 On the New Currency window, fill in the currency options (at the very least, the 
Currency Name, Country Code and Country fields must be filled in):

� Currency Name: the name of the currency.

Inactive currencies are not shown in this list. There are 
more then 40 currencies defined in QuickBooks. To display 
all currencies, click the "Show All" checkbox. 

Hotkeys help you convert foreign 
amounts to your home currency quickly. 

To use them, on any form, select the 
foreign amount you want to convert, 
then hold SHIFT and type that currency’s 
hotkey. QuickBooks multiplies the 
foreign amount by its exchange rate, 
which gives you the amount in your 
home currency.

Select this checkbox to make a currency inactive. This hides 
the currency from the list as opposed to deleting it entirely.

Minimizing the Currency List makes it easier to read from 
drop-down lists on forms.
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� Country: the country in which the currency is used.

� Currency Code: the internationally-recognized code for the currency.

� Currency Symbol: the symbol (such as $) to represent this currency on forms.

� Hotkey: a unique letter or symbol to use with the SHIFT key to multiply an amount 
by the currency’s exchange rate.

� Exchange Rate: the value of one unit of the foreign currency in your home 
currency. In order to keep your foreign transactions accurate, you should update 
the exchange rate on a regular basis.

Format options

� Symbol Position: select where you want the currency symbol placed. Your options 
include Leading (in front of the dollar value) or Trailing (behind the dollar value).

� Decimal Separator: enter the symbol you want to use on forms to represent the 
decimal placeholder. The default is a period (.).

� Decimal Places: select the number of decimal places you want to use on forms. 
You can select zero through 2.

� Thousand Separator: enter the symbol you want to use on forms to represent the 
thousand placeholder. The default is a comma (,).

4 Click OK. The new currency is added to the Currency List and is available on forms that 
use it.

 

Keeping your exchange rates up to date

With QuickBooks Enterprise Solutions, you can keep your exchange rates current by simply 
downloading the latest rates from the Internet. 

� With the Currency List open, click the Currency menu button, and select Download 
Current Exchange Rates. 

You must be connected to the Internet in order to do this. QuickBooks downloads the 
latest rates from the Internet, and updates the Currency List. Inactive currencies and 
currencies using non-standard ISO currency codes are not updated. Transactions that 
have been recorded are also not affected by the new exchange rates. 

Can I change the exchange rate on a saved transaction? Yes. Simply change the rate 
on the appropriate form and QuickBooks takes care of the rest. You won’t see any 
changes to the foreign amount on the form, however, because it is required to record 
transactions in the home currency, QuickBooks Enterprise Solutions adjusts the home 
currency amount in the register based on the new exchange rate. 

To learn about… Search the Help index for…

Creating, editing, or deleting a 
currency

� currencies, creating
� currencies, editing
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Using the currency calculator

The currency calculator is a handy way to convert a dollar amount into a foreign currency 
or vice versa.

� From the Company menu, choose Currency Calculator.

Exchange rates and how they affect your 
transactions

The exchange rates provided in QuickBooks Enterprise Solutions were accurate at the time 
your software was released. However, because currencies fluctuate in value, you should 
update the exchange rates of your currencies often—every week or possibly more 
frequently, depending on the volatility of the currency. (The easiest way to update 
exchange rates is by using the Currency List. See “Using the Currency List” on page 131 for 
more information.)

Tip: An exchange rate field also appears on some forms so that you can enter the latest exchange 
rate "on the fly", without having to go to the Currency List. You should (when reconciling your 
chequing accounts, for example) update the exchange rate used for cheques and deposits to 
reflect the actual rate that was used by your bank at the time the cheques were processed or 
your deposits accepted.

It is these changes in exchange rates that can affect the profits you make from foreign sales 
and your costs for foreign purchases. Basically, as a business owner, you want to track the 
potential effect of exchange rate changes on foreign transactions that haven’t been 
completed (referred to as unrealized gains and losses) as well as the actual effect of the 
changes on transactions that have been completed (referred to as realized gains and losses). 
QuickBooks Enterprise Solutions provides a report to help you track both types of gains and 
losses.

Unrealized Gains and Losses

When you create a foreign transaction, the foreign currency is worth a certain amount in 
your home currency, which is determined by its exchange rate on the day of the 
transaction. However, the exchange rate likely changes before the transaction is closed. 

1 Type the dollar value you 
want to convert.2 Select the currency of the dollar 

amount you want converted.

3 Select the currency you want 
the dollar amount converted to.

A read-only field that displays 
the result of the conversion.

4 Click here to copy the converted 
amount to the clipboard. Then, 
use the paste command 
(CTRL+V) to paste the amount 
into a field on a form.
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Until the transaction closes, the difference between the value of the foreign currency when 
you created the transaction and its current value as of today is your unrealized gain or loss.

For example, say a customer purchases an item from you for $100 US dollars, which is $130 
CDN at the time you issue the invoice. Before the customer pays you, the Canadian dollar 
falls, and the US dollar exchange rate climbs to 1.5 from 1.3. The $100 US that the customer 
owes you is now worth $150 CDN, so your unrealized gain is $20 CDN. (You won’t know 
how much money in Canadian dollars the customer actually pays you until you receive his 
or her payment and deposit it in a bank. At that point, the bank converts it to Canadian 
currency, and your gain or loss is "realized".)

Many accountants prefer you take your unrealized gains and losses on open foreign 
transactions (invoices and bills) into account when you create reports about your 
company’s net worth, as doing so gives a more accurate picture of the value of your 
company on that date. Check with your accountant to see what he or she recommends.

To determine your unrealized gains and losses and make a home 
currency adjustment:

To ensure your net worth reports show the true value of your foreign currency accounts 
(and therefore your company) at the end of a reporting period, your accountant should 
make a home-currency adjustment in the general journal.

1 Create an "Unrealized Gains and Losses" report:

a From the Reports menu, select Multicurrency, then Unrealized Gain and Loss.

b In the Exchange Gain/Loss window, update the exchange rates for the purpose of 
this report. (Note that doing so does not update the Currency List.)

c Click OK. QuickBooks Enterprise Solutions summarizes open foreign transactions 
and the potential gains or losses on them.

2 Use the information in the report to create a home-currency adjustment in the General 
Journal entry to account for your gain or loss. Select the Exchange Gain/Loss expense 
account as the other account that will be affected by this entry.

In this example, the Unrealized Gains and Losses report shows a currency gain for the 
US A/R account, and a currency loss for the US A/P account. Therefore, the entries in 
the General Journal should be recorded as follows.

Insert picture of an example of a report

On reports, foreign 
amounts are 
displayed in the 
home currency. 

In this example, the 
home currency is 
Canadian, therefore 
these amounts are in 
Canadian dollars.
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3 Create your net worth reports.

4 Reverse the General Journal entry to remove the unrealized gain or loss from your 
books.

Realized Gains and Losses

A gain or loss on a foreign transaction because of changes in the exchange rate becomes 
realized once the transaction is either partially paid or paid in full. When you close the 
transaction, QuickBooks Enterprise Solutions compares the value of the foreign amount 
when the transaction began to its value when the transaction closed. QuickBooks 
Enterprise Solutions enters the difference (gain or loss) in the Exchange Gain/Loss account 
(which is created automatically when multicurrency is turned on).

For example, if you owe a vendor 500 French Francs, and the dollar/franc exchange rate 
changes from 0.25 when you ordered the products to 0.20 when you pay the bill, your 
realized gain is $25 CDN. That is, when you ordered the products, you owed $125 CDN, but 
you actually paid only $100 CDN because the franc fell relative to the Canadian currency. 
QuickBooks Enterprise Solutions balances the transaction by assigning the $25 gain to the 
Exchange Gain/Loss account.

To determine your realized gains and losses over time, use the "Realized Gains and Losses" 
report. This detailed report shows the original amount of each foreign transaction in your 
home currency, the actual exchange rate when the transaction was closed, and the resulting 
gain or loss to you.

Select this checkbox 
to ensure these 
amounts are 
recorded as an 
adjustment to the 
home currency 
without affecting 
the foreign balance 
of that account.

You need to specify a 
customer name when a 
journal transaction is 
entered for an A/R 
account (or vendor name 
for an A/P account). 

When making home-
currency adjustments, 
create a phony customer 
or vendor to which you 
can assign unrealized 
gains & losses.
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To print a realized gains and losses report:
� From the Reports menu, select Multicurrency, then Realized Gain and Loss.

Dealing with foreign customers
QuickBooks Enterprise Solutions handles customers who pay in foreign currencies in much 
the same way as customers who pay in your home currency. You create an invoice and 
receive payments in exactly the same way. The only difference is that the currency you 
assign to the customer in his or her profile becomes the currency of the transaction (see 
“Create foreign customers and vendors” on page 129).

Creating invoices for foreign customers

Before you can create an invoice for a foreign customer, you must set him or her up in the 
customer:job list and create a foreign A/R account. Then you can create an invoice as you 
normally would. As you do, you also need to:

On reports, 
foreign 
balances are 
converted to 
the home 
currency.

The price of the item is 
converted into the customer’s 
currency (US dollars) using the 
exchange rate. In this example, 
the rate for "skiing lessons" is 
$50 Canadian, but when the 
item is added to the invoice, the 
rate is converted to $33.99 US.

If you don’t want the price 
converted using the latest 
exchange rate, set up a foreign 
price. See “Set up foreign 
prices for items” on page 130.

1 Select a foreign 
customer such as 
this US customer. 
QuickBooks selects 
an A/R account that 
matches the 
currency of the 
selected customer. If 
one doesn’t exist, 
QuickBooks prompts 
you to create one.

2 Update the exchange 
rate if necessary. 
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Note: When you create an invoice for a foreign customer, and add an item that has a tax code assigned 
to it, the tax code is not brought over to the invoice.

Receiving payments from foreign customers

You receive payments from foreign customers as you normally would. As you do, you also 
need to:

Depositing foreign money
1 From the Banking menu, choose Make Deposits. The Payments to Deposit window 

appears.

2 In Currency drop-down list, select the currency in which you have received payments  
and want to deposit. You can only deposit payments from one currency at a time. 
Then, from the list of payments you’ve received, select the payment(s) you want to 
deposit.

3 Click OK. The Make Deposits window appears.

4 In the Deposit To field, select the account to which you want to deposit the payment. 
You can deposit foreign money into a home currency account (the amount is 
converted using the currency’s exchange rate, or a foreign bank account as long as it 
matches the currency of the deposit).

5 In the Exchange Rate field, update the exchange rate if necessary.

6 Fill in the remaining fields as you normally would. If you are getting cash back from a 
foreign deposit, you need to set up a Petty Cash account that matches the currency of 
the money you are depositing and account for the holdback in it.

1 Select the foreign 
customer from whom 
you are receiving the 
payment; in this case, 
it is a US customer. 
QuickBooks selects an 
A/R account that 
matches the currency 
of the selected 
customer. If one 
doesn’t exist, 
QuickBooks prompts 
you to create one.

Fill out the "Receive 
Payment" window as 
you normally would.

2 Update the 
exchange rate 
if necessary. 

The customer 
determines the currency
of the transaction, and 
seeing that this 
customer is American, 
the amounts on this 
form are in US dollars.
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Dealing with foreign vendors
Working with foreign vendors is much the same as working with vendors in your home 
currency. The steps involved in making purchases and paying bills doesn’t change. The 
only thing that is different is the currency of the transaction, which is determined by the 
vendor. See “Create foreign customers and vendors” on page 129 for instructions on how 
to create a foreign vendor.

Creating purchase orders for a foreign vendor

Before you can create a purchase order for a foreign vendor, you must set him or her up in 
the vendor list, create a foreign A/P account, and have the purchase order preference turned 
on. 

Create a purchase order for a foreign vendor as you normally would. As you do:

As you enter items on foreign purchase orders, their prices are converted to the vendor’s 
currency. If the item has a foreign price and its currency matches the vendor’s, the foreign 
price is used instead (see “Set up foreign prices for items” on page 130 for more 
information).

1 Select a foreign vendor. Because 
the currency of this vendor is US 
Dollars, for example, the currency 
of the transaction will also be US 
Dollars.

QuickBooks selects an A/P account 
that matches the currency of the 
selected vendor. If one doesn’t exist, 
it prompts you to create one.

Fill out the "Create Purchase Order" 
window as you normally would.

2 Update the exchange rate if 
necessary.
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Paying bills from foreign vendors

Often, you will receive bills in a foreign vendor’s currency and be expected to pay in the 
same currency. If you make purchases from a foreign vendor, you should consider opening 
a bank account in the vendor’s currency.

You can only pay bills in one currency at a time.

1 Open the Pay Bills window as you normally would.

2 In the A/P Account drop-down list, select the A/P account that matches the currency 
of the bill you want to pay. For example, if you are paying a bill from a US vendor, select 
your US A/P account.

 

You can only display bills in one currency at a time. The currency is 
determined by the A/P account that is selected. In this case, we’ve selected 
a US A/P account, therefore the bills listed here are from US vendors. 

Update the exchange rate.

If the exchange rate 
changes between the time 
you entered the bill from 
the time you paid the bill, 
a gain or loss is 
generated. QuickBooks 
accounts for it by making 
an entry in the Exchange 
Gain/Loss expense 
account.

Select the account from which the payment will be taken. If the bank account is not set up as foreign, 
QuickBooks calculates the amount in the home currency that is to be withdrawn using the exchange rate.   

To learn about… Search the Help index for…

Payments using your credit card credit cards
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Transferring foreign funds
You can transfer money from a home-currency bank account to a foreign bank account or 
from a foreign account to a home-currency account. However, transferring money between 
two foreign bank accounts can only be done if the currency of the accounts are the same.

1 From the Banking menu, choose Transfer Funds.  

2 With the Transfer Funds Between Accounts window open:

Fill in the rest of the window as 
you normally would.

Update the exchange 
rate to match the rate 
of exchange on the 
day of the transfer.

Select the currency 
denomination of the 
amount you want to 
transfer. 

For example, if you know 
the transfer amount in 
Canadian dollars, select 
Can$ and then enter the 
Canadian amount. If you 
know the transfer amount 
in US dollars, then select 
$US to specify the amount 
in US dollars. 

Enter the amount of the 
transfer.
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QuickBooks Enterprise Solutions helps you pay your 

employees and administer vacation pay, accrued 

time, bonuses, benefits, and more.

Time tracking lets you to track hours for your 

employees or subcontractors. You can create 

payments based on these hours and pass the cost 

along to clients. Chapter 7

As a QuickBooks Enterprise Solutions customer, you are already 
signed up for the QuickBooks Payroll Service.

You can begin using the payroll features, and start paying your employees 
right away.

Setting up 
payroll and 
time tracking

How to pay 
employees and 
track their time
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Setting up payroll: an overview

QuickBooks Payroll Service

QuickBooks Payroll Service takes the worry out of processing your payroll. It automatically 
provides you with an updated tax table whenever the income tax, Employment Insurance, 
Canada Pension Plan / Québec Pension Plan, or other payroll rates change. QuickBooks 
Enterprise Solutions can then continue to withhold the correct amounts from your 
employees’ pay cheques.

The QuickBooks Payroll Service is included in QuickBooks Enterprise Solutions, which 
means you are already signed up and can start setting up payroll now. 

If you don’t use the payroll feature in QuickBooks 
Enterprise Solutions

If you have employees, you must track payroll. You don’t have to use QuickBooks 
Enterprise Solutions to pay your employees — you could use an accountant or a payroll 
service. However, you still need to set up your employees on the Employee list and track 
their pay cheques and other payroll amounts so that your accounts will be correct.

If you aren’t using the payroll feature or turn it off, the Employee List allows only very basic 
information about each employee—name, contact information, Social Insurance Number, 
hire and release dates, and custom information you define.

To learn about… Search the Help index for…

Using an external payroll service payroll services, other than Intuit

If you have employees, but aren’t 
using QuickBooks payroll

payroll, not using
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Setting up payroll: an overview
The amount of time it takes to enter your payroll information into QuickBooks varies with 
the size of your company. Often, it can take one to two hours.

To set up your payroll system:
1 In the Payroll & Employees preferences, check that the payroll features are turned on 

and are configured properly for your needs.

For example, you can choose how you want your Employee list sorted and what prints 
on employee pay cheques and vouchers or paystubs.

2 Gather the information you need to set up payroll (see page 144).

3 Confirm that the  liability and expense accounts that QuickBooks creates for you meet 
your needs (see page 148).

4 Set up:

� Your payroll items (see “Setting up your payroll items” on page 148).

� Your employees (see “Setting up employees” on page 153).

� The employees’ year-to-date amounts (see “Summarizing amounts for this year to 
date” on page 159).

5 Protect your company’s payroll data from unauthorized access by setting up user 
permissions. For information about restricting access to your company file, see “Setting 
up users and passwords” on page 101.

To learn about… Search the Help index for…

Setting up payroll payroll setup, required information

Getting payroll updates payroll, updating

Setting payroll preferences preferences, payroll

Set user permissions for payroll permissions
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Collecting the information you’ll need

If you paid employees before you set up your company in QuickBooks Enterprise Solutions, 
you’ll need to get information from your previous accounting package or your accountant.

Information you need to start Where to find it

Company

How often you pay your employees Your accountant or company records

Contact information for the agencies you 
remit money to after withholding it from 
employee payments (e.g. the CCRA)

Your accountant or company records

Start date for payroll Your company records

Tax information

Your business number Your accountant or the CCRA

Current tax tables covering payroll with-
holdings such as Employment Insurance 
premiums and pension plan contributions

QuickBooks downloads them auto-
matically when you sign up for the
Payroll Service

Compensation, benefits, and other payroll 

items

How you pay your employees and officers: 
hourly wages, salaries, commissions

Your accountant or company records

Things you add to employee pay cheques
� Examples include bonuses, travel 

expenses, employee loans

Your accountant or company records

Things you deduct from employee pay 
cheques
� Examples include union dues, repay-

ments of employee loans or advances, 
health or life insurance paid by the 
employee, deductions for pension plans

Your accountant or company records

Expenses your company pays that are 
based on employee pay cheques (company 
contributions
� Examples include Canada Pension Plan 

contributions (or QPP, in Québec), health 
or life insurance paid by the company, 
Employment Insurance, etc

Your accountant or company records
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Employees

Employee name, date of birth, and Social 
Insurance Number (SIN)

Employee

Address of the employee, including the 
province in which he or she works

Your accountant or company records

Federal and provincial TD-1 forms for the 
employee, completely filled out 
(see “Entering information from employee 
TD1 forms” on page 156)

Employee

Employee’s rate of pay or salary and pay 
cheque additions, deductions, and com-
pany contributions (if any)

Pay cheques, reports, or payroll ledger

Employee’s accrued time and vacation pay Pay cheques, reports, or payroll ledger

Year-to-date amounts

Each employee’s payroll amounts from the 
beginning of the calendar year to the date 
you started using QuickBooks.
� That is, the total amount you’ve paid out 

to the employee so far this year, and
� The total amounts you withheld from 

each of the employee’s payments and 
what for.

Copies of employee pay cheques, pay-
stubs, payroll reports, payroll service, 
accountant, payroll ledger

Your payroll liability amounts from the 
beginning of the calendar year to the date 
you started using QuickBooks.
� That is, the total amounts you withheld 

from all pay cheques you issued this 
year, and

� How much you already remitted to the 
government, benefits providers, etc. as a 
result of these liabilities.

Copies of liability cheques, payroll 
reports, payroll service, accountant, 
payroll ledger

Direct Deposit

For each employee using the service:
� Direct deposit request
� Bank number(s)
� Transit number(s)
� Account number(s)

Employee’s direct deposit request form

Information you need to start Where to find it
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Payroll expense and liability accounts
When payroll is turned on, QuickBooks Enterprise Solutions adds two accounts to your 
Chart of Accounts:

� Payroll Expenses (an Expense account)

� Payroll Liabilities (an Other Current Liability account)

To keep your balance sheet and your profit and loss statement accurate, QuickBooks 
Enterprise Solutions associates each payroll item with the appropriate account or accounts.

Whenever you create a new payroll item, QuickBooks Enterprise Solutions helps you assign 
it to the correct account or accounts by prefilling the account name to use. However, you 
can use a different account if you like. For example, an accountant for a corporation may 
want to create subaccounts of the Payroll Expenses and Payroll Liabilities accounts to report 
expenses for officer salaries separately from non-officer salaries.

It is also correct for some types of payroll items (such as a deduction for a loan repayment) 
to be associated with an account other than an expense or a liability account.

Payroll items for expenses

Expenses are the amounts you record and pay as they occur. Common company payroll 
expenses include gross pay (e.g. wages before taxes), company-paid payroll taxes (e.g. the 
employer’s part of Employment Insurance), and company-paid benefits for employees (e.g. 
premiums for a company-paid health plan).

Generally, you should assign all payroll expenses to the Payroll Expenses account. When 
you run payroll, QuickBooks Enterprise Solutions keeps track of your company’s expenses 
for each employee. You can then see totals for your expenses on the Payroll Summary report 
and on the Profit and Loss Statement.

Keeping track of payroll expenses

You can break down payroll expenses for salaries and hourly wages, as well as:

� Company-paid payroll taxes.

� Additions, commissions, and company contributions if the “Track Expenses by Job” 
checkbox is selected in the setup wizard for the individual payroll item. (In the Add or 
Edit New Payroll Item wizard, select “Track Expenses By Job.”)

To learn about… Search the Help index for…

Payroll Liabilities account payroll liabilities, account

Payroll Expenses account payroll, expenses account

Creating and using subaccounts subaccounts
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QuickBooks Enterprise Solutions prorates the company-paid expenses for an employee in 
the same proportions as you prorated the dollar amounts of the employee’s earnings.

Tracking expenses by customer and job

Some businesses like to see which customers and jobs create the most expense or work for 
them. If you want to keep track of all payroll expenses by customer or job, you need to do 
the following:

� Make sure that the accounting preference for Customer:Job tracking is enabled.
� Make sure that the following payroll and employee preference is turned on: “Report all 

payroll taxes by...”
� On every payroll item for a commission, addition, or company contribution, select the 

checkbox for “Track Expenses by Job.”
� On each pay cheque you write, associate every salary or hourly wage with the correct 

job or jobs.

Tracking expenses by class

If your business is a nonprofit organization that needs to do fund accounting, you may 
want to keep track of expenses by class. To track payroll expenses by class, do the following:

� Turn on “Use class tracking” in the accounting preferences.
� Turn on the following payroll and employees preference: “Report all payroll taxes by...”
� On every payroll item for a commission, addition, or company contribution, select the 

checkbox for “Track Expenses by Job.”
� Depending on the payroll and employee preference you choose, assign one class to an 

entire pay cheque, or assign a separate class to each earnings payroll item on a pay 
cheque.

Tracking expenses by service item

Some businesses keep track of expenses by service item. To track payroll expenses by service 
item, do the following:

� Turn on the payroll and employee preference for “Report all payroll taxes by 
Customer:Job and Service Item.”

� On every payroll item for a commission, addition, or company contribution, select the 
checkbox for “Track Expenses By Job.”

� Set up each employee to “Use time data to create pay cheques.”
� On each pay cheque you write, associate every Customer:Job with the correct Service 

Item.

To learn about… Search the Help index for…

Keeping track of payroll expenses 
by customer and job, or class, or 
service item

payroll, tracking expenses
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Payroll items associated with liabilities

Often, you have to deduct an amount from an employee’s payment and pass it on to the 
government or another institution. For example, when you pay an employee, you hold 
back the income tax that the employee owes the government and remit that money to the 
government later.

These types of deductions are not expenses because the money you pass on comes from the 
employee, not your company. Instead, because you temporarily keep money that you owe 
to someone else, these types of deductions are liabilities. Payroll items for liabilities are 
usually assigned to the Payroll Liabilities account.

When you do your payroll, QuickBooks Enterprise Solutions calculates how much you owe 
the government or other agency for each tax, deduction, and company contribution 
payroll item and records it in the Payroll Liability account. With each pay cheque you write, 
the balance of this account increases.

When you pay your payroll taxes and other payroll liabilities using the Pay Liabilities 
window, QuickBooks Enterprise Solutions decreases the balance of the liability account.

Combinations of expenses and liabilities

Some payroll items are a combination of liabilities and expenses. For example, the 
portion of Employment Insurance (EI) that you withhold from an employee’s pay 
cheque is a liability, while the portion that you pay is an expense.

Payroll items for company-paid taxes and company contributions are usually assigned to 
both a liability account and an expense account.

Setting up your payroll items
Payroll items are the building blocks of your payroll system. When you create any kind of 
payroll transaction in QuickBooks Enterprise Solutions—whether it’s a pay cheque, a 
payroll liability payment, or a payroll adjustment—you use payroll items to do it (in the 
same way that sales forms use service and inventory items).

There are payroll items for employee compensation (salaries and wages), amounts you 
withhold from employee pay cheques (income tax and other liabilities), employer-paid 
expenses (such as company-paid benefits), and additions and deductions (such as bonuses 
and loan repayments). QuickBooks uses payroll items to track the individual amounts on a 
pay cheque and the accumulated year-to-date wage and tax amounts for each employee. 

QuickBooks Enterprise Solutions displays your payroll items on the Payroll Item list. The 
names of the payroll items are what you’ll see on pay cheques and in payroll reports. 
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About the default payroll items

When the payroll feature is first turned on, QuickBooks Enterprise Solutions creates the 
Payroll Item list with some standard payroll items. These include:

Payroll item 
name

Type Use for

Sick Salary Yearly Salary Accrued time (such as sick time) paid out 
to a salaried employee

Vacation Salary Yearly Salary Vacation pay paid out to a salaried 
employee who is on vacation

Sick Hourly Rate Hourly Wage Accrued time (such as sick time) paid out 
to an hourly employee

Vacation Hourly Rate Hourly Wage Vacation pay paid out to an hourly 
employee who is on vacation or who left 
the company

VacPay - Accrual 
Paid Out

Vacation Pay A specific amount of vacation pay paid 
out to an employee, for example, when he 
or she leaves the company

VacPay - Accrued Vacation Pay Earned (but not yet paid out) vacation pay 
for an employee

VacPay - Paid Out Vacation Pay Vacation pay paid out to an employee 
who is paid out every pay period

Federal Income Tax Payroll Taxes Federal income tax withheld from the 
employee. Also includes provincial 
income tax, except in Québec.

CPP - Company Payroll Taxes Canada Pension Plan, company 
contribution

CPP - Employee Payroll Taxes Canada Pension Plan, employee 
contribution

EI - Company Payroll Taxes Employment Insurance, company 
contribution

EI - Employee Payroll Taxes Employment Insurance, employee 
contribution

QPP - Company Payroll Taxes Québec Pension Plan, company 
contribution

QPP - Employee Payroll Taxes Québec Pension Plan, employee 
contribution

Québec Income Tax Payroll Taxes Québec income tax withheld
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Creating new payroll items

As you set up your payroll system, you will need to create new payroll items to match the 
way you remunerate your employees. To create new items, use the Add New Payroll Item 
wizard.

To start the Add New Payroll Item wizard:
� With the Payroll Items list open, click the Payroll Item menu button, then select New.

As you create an item in the Add New Payroll Items wizard, you should:

� Confirm that the expense and liability accounts assigned to it meet your needs and 
change them, if you need to.

� Choose how to track the payroll item on T4 and, in Québec, Relevé 1 forms, if it’s 
an addition, deduction, or company contribution. If you are not sure how to tax a 
payroll item, check with the Canada Customs and Revenue Agency, your 
provincial Minister of Revenue, or your accountant.

Note: From the Tax Tracking Type drop-down menu, you can choose tracking options for T4 forms only 
(listed first), for both T4 and Relevé 1 forms (listed next), or for Relevé 1 special cases (last).

Payroll item type Use for

Yearly Salary � Compensation to employees whose annual salary is 
independent of the number of hours actually worked.

� Compensation to salaried corporate officers (with 
expenses assigned to an expense account for corporate 
officer salaries).

Hourly Wage Compensation based on the number of hours worked.

Commission Compensation based on a percentage of another quantity 
(such as sales volume) or a flat amount times another 
quantity (such as units sold).

Deduction Any deduction from gross or after-tax (net) pay. Examples 
include union dues, loan repayments, and employee-paid 
insurance.

Addition Any addition to gross or after-tax (net) pay. An example is a 
bonus.

Company Contribution Any company-paid benefit or expense that you want to 
track with each pay cheque. Examples include employee 
benefits such as pension plans or health and life insurance.

Other Tax Miscellaneous taxes based on employee wages. These 
taxes may be paid by the company or the employee. 
Examples include payments to the Workers Compensation 
Board, the Ontario Employer Health Tax, and the Québec 
Health Services Fund.
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How to set up common payroll items

This handy guide explains how to set up many different types of payroll items.

To learn about… Search the Help index for…

Changing the name of payroll 
items

payroll items, editing

Adding payroll items payroll items, adding

Adding a payroll item for a 
miscellaneous tax

payroll items, other tax

Payroll item Type
Gross 
or Net

Fed CPP EI QIT QPP
T4 or 
RL-1

� Award or bonus
� One-time payment or 

supplemental wages
� Misc. reimbursement

Add’n Gross � � � � � Box
14/A

Advance Add’n Net n/a n/a n/a n/a n/a

Advance repayment Ded’n Net n/a n/a n/a n/a n/a

Alimony or maintenance 
payment (tax deductible)

Ded’n Gross � �

Alimony or maintenance 
payment (not tax deduct-
ible)

Ded’n Net n/a n/a n/a n/a n/a

Automobile allowance 
(taxable)

Add’n Gross � � � � � Box
34/I

Automobile expense reim-
bursement (not taxable)

Add’n Net n/a n/a n/a n/a n/a

Canada Savings Bond Ded’n Net n/a n/a n/a n/a n/a

Charitable donation Ded’n Net n/a n/a n/a n/a n/a Box
46/N

Garnisheed wages Ded’n Net n/a n/a n/a n/a n/a

Labour-sponsored fund Ded’n Gross � �

Provincial Health Care 
(company-paid)

Co.
Ctrb’n

n/a � � � � � Box
40/L
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Private Health Care (paid 
by employee)

Ded’n Net n/a n/a n/a n/a n/a

Private Health Care (paid 
by company)

Co.
Ctrb’n

n/a � �

Registered Pension Plan 
(RPP), employee contribu-
tion

Ded’n Gross � � Box
20/D

Registered Pension Plan 
(RPP), company contribu-
tion

Co.
Ctrb’n

n/a � � Box
40/L

Registered Retirement 
Savings Plan (RRSP), 
employee contribution

Ded’n Gross � �

Registered Retirement 
Savings Plan (RRSP), com-
pany contribution

Co.
Ctrb’n

n/a � � Box
40/L

Union Dues Ded’n Gross � � Box
44/F

Payroll Taxes

� Manitoba Payroll Tax
� Ontario Employer Health 

Tax
� Québec Health Services 

Fund
� Northwest Territories 

Payroll Tax

Other 
Tax

n/a n/a n/a n/a n/a n/a n/a

Non-Cash Benefits

Housing, board, and 
lodging

Co.
Ctrb’n

n/a � � � � Box
30/H

Travel in designated area Co.
Ctrb’n

n/a � � � � Box
32/K

� Personal use of 
employer’s auto

� Auto operating 
expenses or standby 
charges

Co.
Ctrb’n

n/a � � � � Box
34/I

Payroll item Type
Gross 
or Net

Fed CPP EI QIT QPP
T4 or 
RL-1
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Setting up employees

Generally, an employee is a person you pay on a regular and ongoing basis to perform 
services for your company, using materials and equipment you provide.

If your business is a sole proprietorship or an unincorporated partnership, owners and 
partners are not usually employees. If your company is incorporated, corporate officers who 
work in the business are usually employees.

If you’re not sure whether a person providing services for you is an employee, owner, or 
subcontractor, contact the Canada Customs and Revenue Agency or your accountant. 

To set up employees for payroll, you need to:

� (Optional but recommended) Set up your employee defaults.

� Add new employees to your Employee list, or add payroll information for employees 
already on your Employee list.

Taxable interest Co.
Ctrb’n

n/a � � � � Box
36/L

Stock option benefit Co.
Ctrb’n

n/a � � � � Box
38/L

Other taxable benefit Co.
Ctrb’n

n/a � � � � � Box
40/L

� GST on Employee 
Benefits

� QST on Employee 
Benefits

Co.
Ctrb’n

n/a � � � �

Payroll item Type
Gross 
or Net

Fed CPP EI QIT QPP
T4 or 
RL-1

Use payroll only to pay employees, not subcontractors or owners.

To pay subcontractors, set them up as vendors, have them bill you, and pay them with 
the Pay Bills feature. Then, you can create a T4A report to help you fill in their T4A.

To pay owners, use an owner’s draw from an equity account.
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Entering ’standard employee’ information

The employee defaults help you set up payroll for several employees quickly. You enter 
payroll information that most employees have in common. These defaults then show up 
every time you enter information for a new employee. If the information isn’t right for a 
particular employee, you can change it for him or her.

The Employee Defaults window resembles the Payroll Info tab of the New/Edit Employee 
window. You can set up the following information in it:

� Salary or wage payroll items (with or without rates of pay)

� Pay period

� Class, if you’re using classes to track your employees

� Whether you want to use time data to create pay cheques 

� Additions, deductions, and company contributions that appear on pay cheques

Note: The order in which you enter payroll items in the Addition, Deductions, and Company Contri-
butions area can affect how QuickBooks Enterprise Solutions calculates each item and income 
taxes.

� Payroll and other taxes

� TD1 and, in Québec, TP-1015.3 basic amounts

� Accrual time and vacation pay

The Class field is 
available only if you 
have class tracking 
turned on. 

This checkbox 
appears only if 
time tracking is 
turned on.

To learn about… Search the Help index for…

Setting up the employee defaults employee defaults, creating

How the order of payroll items 
affects amounts on your 
employee’s pay cheques

pay cheques, affecting amounts
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Setting up employees

Before setting up your employees in QuickBooks Enterprise Solutions, you should create the 
payroll items you need for your business (see “Setting up your payroll items” on page 148).

Also, consider setting up your employee defaults (see “Entering ’standard employee’ 
information” on page 154), so that QuickBooks Enterprise Solutions can prefill much of the 
information you need when you set up an individual employee.

Using the Employee list and employee profiles

In QuickBooks Enterprise Solutions 2.0, each of your employees has a profile containing 
information about him or her (such as contact information, Social Insurance Number, date 
of birth, and the payroll information you need to create pay cheques). These profiles are 
stored in the Employee list and are made up of three tabs: 

� Address Info: the employee’s contact information, Social Insurance Number, date of 
birth, hire and release date, and similar information.

Note: If you do not enter an employee’s correct date of birth, QuickBooks Enterprise Solutions cannot 
calculate Canada Pension Plan or Québec Pension Plan contribution amounts for him or her. 
CPP or QPP contribution amounts for an employee will also be zero if he or she is not between 
18 and 70. (In the year the employee turns 18 or 70, QuickBooks Enterprise Solutions prorates 
the calculation according to CCRA guidelines.)

� Additional Info: custom fields for tracking any information you prefer.

� Payroll Info: this employee’s salary or hourly wage and any additions, deductions, 
company contributions, or other taxes that apply to him or her.

This tab also contains four buttons for setting up other important parts of the 
employee’s payroll information:

- Payroll Taxes: the employee’s payroll deductions for income tax (see “Entering 
information from employee TD1 forms” on page 156).

- Direct Deposit: the employee’s bank account number and routing number (see 
“Setting up direct deposit for employee pay cheques” on page 158).

- Accrual Hours: how the employee accrues time (such as sick days or time off in lieu 
of overtime).

- Vacation Pay: how the employee accrues vacation pay.

QuickBooks Enterprise Solutions also provides a “notepad” in which you can make notes 
about an employee.

To learn about… Search the Help index for…

Adding new employees employees, adding

Changing information about an 
existing employee

employees, editing
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If you pay on commission

If your employees earn commissions for items they sell, after setting them up on the 
Employee list, you should also set them up on the Sales Rep list.

Then, when you enter an invoice, sales receipt, or estimate, select the employee’s initials 
from the Rep drop-down list on the sales form to give him or her credit. Then you will be 
able to produce reports showing sales by employee. Pay commission employees with a pay 
cheque, not a "regular" cheque.

To track commission sales for owners or partners, add them to the Sales Rep list like 
employees, but pay them with an owner’s draw instead of a pay cheque.

Entering information from employee TD1 forms

The Canada Customs and Revenue Agency (CCRA) requires you, as an employer, to keep a 
current federal and provincial TD1 form on file for each of your employees. For Québec 
employees, you must keep a federal TD1 form and a provincial TP-1015.3 form on file.

TD1 (and, in Québec, TP-1015.3) forms help employees calculate the personal tax credits 
they will claim when they file an income tax return in the spring. The totals from these 
forms tell QuickBooks Enterprise Solutions how much income tax it should deduct from the 
pay cheques you create for an employee.

Most employees should fill in both the federal TD1 form (Personal Tax Credits Return) as 
well as the TD1 form for the province they work in. Employees who work in Québec should 
fill in a federal TD1 form and a provincial TP-1015.3 form.

You can download blank federal and provincial TD1 forms for your employees to fill in 
from the CCRA web site (http://www.ccra-adrc.gc.ca/). You can get blank TP-1015.3 forms 
from the Québec Minister of Revenue web site (http://www.revenu.gouv.qc.ca/).

Setting up payroll information for 
an employee

employees, payroll information

How the order of payroll items 
affects amounts on your 
employee’s pay cheques

pay cheques, affecting amounts

Categorizing employees by class employees, grouping by department 
or location

Adding notes for an employee employees, notes about

To learn about… Search the Help index for…

Paying the owner(s) of a business owners’ draws

To learn about… Search the Help index for…
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Some employees who are paid on commission and who claim their business expenses may 
ask to use Form TD1X (Statement of Commission Income and Expenses for Payroll Tax 
Deductions). In this case, you should consult your accountant as you will have to perform 
special payroll calculations for this employee.

An employee should fill in new personal tax credit forms when:

� you first hire him or her.

� the employee wants to change the tax credits he or she is claiming. For example, say 
that an employee, Rick, wants to claim the tax credit for being a student. He should 
complete new tex credit forms, which will show how much tax you should hold back, 
within a week of the change.

� the federal or provincial tax credit amounts change. In this case, QuickBooks Enterprise 
Solutions notifies you that your employees' TD1 and TP-1015.3 claim amounts need to 
be updated, and you should do so as soon as possible.

After your employees have completed their TD1 (and, in Québec, TP-1015.3) forms, you 
need to copy the total claim amounts from them into QuickBooks Enterprise Solutions. 
QuickBooks Enterprise Solutions can then withhold the correct amounts of income tax 
from your employees’ pay cheques.

Note: According to the CCRA, it is a serious offence to knowingly accept a Form TD1 that contains false 
information. If you think an employee is entering incorrect information, contact the CCRA.

To enter an employee’s tax credit claim into QuickBooks Enterprise 
Solutions:
1 Find the employee's profile in the Employee list and display it.

2 Click the Payroll Info tab.

3 Click the Payroll Taxes button.

4 From the Tax Table drop down list, choose the province or territory where the 
employee works (not where the employee lives or where your company is located).

5 In the Subject To area, do the following:

� In the Federal TD1 field, enter the total claim amount (Line 12) from the 
employee’s federal TD1 form.

� If the employee wants you to hold back extra income tax from his or her pay 
cheques (say, to avoid paying a large sum when filing a tax return in the spring), 
enter the amount to withhold from each pay cheque in the Additional Tax field. 
You can only enter a dollar amount, not a percentage.

� In the Provincial TD1 field, enter the total claim amount from the employee's 
provincial TD1 form (Line 12) or, in Québec, TP-1015.3 form (Line 20).

6 Click OK to return to the employee’s Payroll Info tab.

An employee’s TD1 and, in Québec, TP-1015.3 claims must be updated within 
a week of any change that affects his or her income tax return.

You and your employee share the responsibility for keeping these forms current.
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Tip: Often, the amount an employee claims on a TD1 form (or, in Québec, TP-1015.3 form) is the 
same as the basic claim amount. If your enter the basic claim amount into your employee 
defaults, QuickBooks Enterprise Solutions can prefill it when you set up payroll for an individual 
employee.

Setting up direct deposit for employee pay cheques

After you sign up for Direct Deposit, you need to:

� Check that QuickBooks Enterprise Solutions automatically created the Direct Deposit 
payroll item for you. This payroll item appears in the Payroll Item list and, for 
employees using the service, in the Employee Summary area of their Preview Pay 
Cheque window.

� For each employee who wants to use the service, enter the information into their 
profile that tells QuickBooks Enterprise Solutions where and how to deposit their pay 
cheques. You can split an employee’s pay cheque between two accounts. For each, you 
need the bank account, financial institution, and branch number.

To enter the information, in the Payroll Info tab of the employee’s profile, click Direct 
Deposit.

To learn about… Search the Help index for…

Setting up TD1 information for an 
employee

TD1 forms, employees

Entering default TD1 information TD1 forms, employee defaults

Setting up TP-1015.3 information 
for an employee

TP-1015.3 forms

Before you can set up direct deposit for your employees, you must first sign 
up for this optional service.

Direct Deposit allows you to electronically deposit your employee’s pay cheques into 
their bank accounts on a day you specify. Direct deposit payments are secure, conve-
nient, and time-saving for you and your employees. 

To learn more about Direct Deposit or apply for this service, from the Employees menu, 
select Employee Services, then Direct Deposit.
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Summarizing amounts for this year to date

Note: Skip this section if your company has not done payroll before or has not issued any pay cheques 
so far this year. You are ready to start writing pay cheques.

If you’re just starting to use QuickBooks Enterprise Solutions for payroll and you’ve already 
issued pay cheques in the current calendar year, you need to:

� Enter summaries of your payroll transactions from January 1 up to your QuickBooks 
Enterprise Solutions start date. (For information about start dates, see “Determining a 
start date” on page 43.) You will need a summary of the transactions for each employee 
and also one of any payments you’ve made for income tax and other payroll liabilities. 

� Enter your payroll transactions (pay cheques and liability cheques) for the period 
between your QuickBooks Enterprise Solutions start date and today.

A wizard will help you enter your year-to-date (YTD) information. To start it, from the 
Employee menu, choose Enter YTD Amounts. After you’ve entered your YTD information, 
QuickBooks Enterprise Solutions updates it as you issue pay cheques during the remainder 
of the payroll year to keep your payroll tax amounts correct.

This field identifies the 
employee’s financial 
institution and branch.

Its format is the five-digit 
branch number first, a 
hyphen, then the three-
digit institution number 
(for example, 00123-987).

You can get these 
numbers from a cheque 
for the account.

You can deposit an 
employee’s pay 
cheque into two 
bank accounts; for 
example, a 
Chequing and a 
Savings account.

To learn about… Search the Help index for…

Setting up employees for direct 
deposit

direct deposit, setting up employees 
for

Signing up for direct deposit direct deposit, signing up for

Branch, institution, and bank 
numbers

� institution numbers
� bank numbers
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Entering year-to-date summaries for each employee

For each employee (both current and former) you paid during the current calendar year, 
you must enter a summary of his or her earnings and the amounts you deducted from it. 
These amounts can include income tax, Employment Insurance, Canada Pension Plan or 
Québec Pension Plan, and any other amounts you tracked by pay cheque from Jan. 1 to 
your QuickBooks Enterprise Solutions start date.

You need to enter both the amounts you withheld from the employee’s earnings and the 
amounts that your company paid as a result of the employee’s earnings. For example, you 
must enter both the employee’s and employer’s parts of CPP/QPP and EI.

Depending on how you’ve kept your records, you can enter amounts summarized by 
month, by pay period, or for the entire year to date.

As you work though the Enter YTD wizard, it asks you to select the employee whose year-
to-date information you want to enter. When you click Enter Summary, QuickBooks 
Enterprise Solutions displays each payroll item you entered in that employee’s profile.

� In the Other Employee and Company Payroll Items area, leave the Period Amount field 
blank if there was no amount for this payroll item during this period.

� In the Salary and Hourly Wages area, enter payroll items for accrual time and vacation 
pay taken during this period and their corresponding wage amounts. Do not include 
these amounts in your totals for regular salary or hourly wages.

� Add payroll items for one-time-only payroll amounts, such as bonuses, that occurred 
during this period. You must enter anything that affected the employee’s compen-

In this area, enter the 
totals for salary, hourly 
wages, or vacation pay 
paid out during this 
period. 

Enter hours worked 
during the period if you 
want them to appear on 
reports. QuickBooks 
displays a message if 
hours are required.

In this area, enter totals 
for all other earnings, 
withholdings, and 
company-paid taxes or 
payroll expenses for 
this employee.

Include taxes regardless 
of whether you have 
paid them yet.

To insert a payroll item, 
press CTRL+INSERT. 
You can skip over items 
not used in this period. 

If the amount you paid 
the employee has already 
come out of your bank 
account, select this.

If you want, you can type 
a description about this 
adjustment.
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sation or payroll taxes. You do not have to enter non-payroll adjustments such as reim-
bursements for office supplies.

� Enter separate amounts for the employee and company portions of CPP/QPP and EI. 
QuickBooks Enterprise Solutions uses the employee amount to track employee with-
holding; it uses both amounts to track your total payroll liability.

� Enter all liabilities created because of compensation paid, even if you have already paid 
them or they were company expenses. For example, if you provide an employee benefit 
and track it as a payroll expense for each pay period, you must type amounts for this 
employee in this window. Later, you will also enter the amounts you’ve already paid 
towards this liability so that QuickBooks Enterprise Solutions can keep track of how 
much you still owe.

After you’ve entered the amounts for this period, click OK to finish. If you have another 
period to enter, click Next Period instead.

Should my YTD information affect my accounts?

Option When to choose
What QuickBooks 
does

Do not affect 
accounts

Most people should choose 
this option at setup. 
� You need to enter all your 

account opening balances in 
QuickBooks Enterprise Solu-
tions as of your start date, 
and you do not want these 
amounts to change the bal-
ances of your accounts.

� If your start date is midyear, 
and you make an adjustment 
for all income and expense 
accounts, you do not want 
these amounts to affect that 
adjustment.

� Affects no balance sheet 
accounts and adds no 
expenses.

� Adjusts year-to-date 
amounts to print on pay 
cheques; to display in pay-
roll reports; and to observe 
annual limits for taxes, 
deductions, and additions.
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About wage bases

A "wage base" is the portion of an employee’s earnings that’s actually used to calculate 
payroll withholding amounts. It’s also called taxable income, insurable earnings, or 
pensionable earnings.

For every government-withholding payroll item (such as income tax, CPP/QPP, and EI) in 
the lower half of the YTD Adjustment window, QuickBooks Enterprise Solutions tracks the 
employee’s wage base for reports. You can view the employee’s wage bases by clicking Show 
Wage Bases.

QuickBooks Enterprise Solutions calculates wage bases for government withholding in this 
way:

� First, it totals all salary, hourly wages, and commissions.

� Then it adds to gross those additions and company contributions that affect gross and 
are subject to that specific withholding.

Affect liability and 
expense accounts 
but not the bank 
account

You may want to choose this 
option at setup if you have 
never used a payroll liability 
account before, and you want 
a correct balance in the 
account.
This option is also appropriate 
after you start using payroll if 
you need to adjust the amount 
owed for a payroll item.

� Enters an increase in each 
liability account associated 
with a payroll item used for 
the period.

� Tracks an expense for each 
expense account associated 
with a payroll item used for 
the period.

� Enters a decrease in the 
Opening Bal Equity account 
for the net amount paid the 
employee during the period. 
(This adjustment keeps your 
books in balance.)

Affect liability, 
expense, and 
bank accounts

You are unlikely to want to 
choose this option at setup 
since it affects your bank 
account balance. 

� Enters a payment in the des-
ignated bank account for the 
net amount paid the 
employee during the period.

� Enters an increase in each 
liability account associated 
with a payroll item used for 
the period.

� Tracks an expense for each 
expense account associated 
with a payroll item used for 
the period.

Option When to choose
What QuickBooks 
does
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� Finally, it subtracts from gross any deductions that should be taken off prior to calcu-
lating that specific withholding.

If the total exceeds the maximum annual earnings limit for this tax, the wage base equals 
the maximum earnings limit. If you entered amounts for earlier periods this year, 
QuickBooks Enterprise Solutions counts the wage base from the earlier periods towards the 
maximum.

Entering year-to-date summaries of liability payments

Note: Skip this section if your company has not made any payments for payroll withholdings (such as 
deducted income tax) this calendar year.

For this adjustment, you’ll need to know how much you paid from January 1 of this year 
up to your QuickBooks Enterprise Solutions start date for each of the following:

� Income tax and other payroll withholdings (Employment Insurance, Canada Pension 
Plan or Québec Pension Plan, and other payroll taxes), whether withheld from 
employees or paid as a company expense.

� Each deduction you withheld and then paid (for example, for benefits such as an 
employee-paid dental plan).

� Each company contribution you paid (for example, for benefits such as a company-
paid health plan).

This adjustment is just for your payroll liabilities and your expenses for employer-paid 
payroll withholding. It is not for expenses paid directly to employees (such as salaries, 
bonuses, or hourly wages).

To learn about… Search the Help index for…

Entering YTD amounts for 
employees

year-to-date amounts, employee

Wage bases wage base

Type the ending date 
of the period you are 
summarizing.Type the date 

you made the 
liability 
payment.
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Making sure your payroll data is complete

Because QuickBooks Enterprise Solutions bases new payroll transactions on existing ones, 
it’s very important that you enter all of your payroll data accurately. After you set up your 
payroll information in QuickBooks Enterprise Solutions, you should make sure that it is 
complete and correct.

To learn about…
Search the Help index 
for…

Entering YTD liability payments year-to-date amounts, liability 
payments

Procedure Comments
Search the 
Help index 
for...

�

Review your Employee 
list.

The Employee list should 
include names of all employees 
on your payroll at any time 
during the current calendar year 
(even if they have left).

employees, 
reports about
lists, printing

❏

Review your employee 
dates of birth.

Each employee’s profile should 
include his or her date of birth. 
Otherwise, QuickBooks cannot 
calculate Canada or Québec 
Pension Plan amounts for that 
employee.

employees, 
editing

❏

Review an employee 
contact list report.

The report should include Social 
Insurance Numbers, addresses, 
and phone numbers for all 
employees.

employees, 
reports about

❏

Review your Payroll Item 
list.

The Payroll Item list should list 
everything you need to track on 
a pay cheque.

payroll, 
reports about
lists, printing

❏

Review your payroll 
summary for all 
employees for this 
entire calendar year.

You should be able to match the 
amounts for payroll items in 
QuickBooks Enterprise Solutions 
with amounts in the payroll 
accounts of your prior payroll 
system.

employees, 
reports about

❏
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Review your a payroll 
liabilities as of December 
31 of this year.

You should be able to match the 
amounts for payroll items in 
QuickBooks Enterprise Solutions 
with amounts on the liability 
report of your prior payroll sys-
tem.

payroll, 
reports about

❏

Print a balance sheet as 
of December 31 of this 
year. 

It should match the balance 
sheet from your prior account-
ing system as of December 31 of 
this year.

balance sheet, 
reports

❏

Print a balance sheet as 
of December 31 of last 
year. 

It should match the balance 
sheet from your prior account-
ing system as of December 31 of 
last year.

balance sheet, 
reports

❏

Print a profit and loss 
statement for the entire 
calendar year.

It should match the profit and 
loss statement from your prior 
accounting system for the entire 
calendar year.

profit and loss 
reports

❏

Procedure Comments
Search the 
Help index 
for...

�
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Managing payroll and employee information
As your business grows and changes, you will probably find it necessary to add or remove 
payroll items, hire (and sometimes release) employees, and track additional information 
about your payroll.

Managing payroll item information

Remember that you can use the same payroll item for many employees. You can customize 
hourly wage payroll items, for example, in the setup window for each employee to allow 
for different rates of pay.

You can change the information for existing payroll items, although you probably do not 
want to change whether the item is subject to income tax or its T4 and Relevé 1 tracking. 
You may want to change a payroll item, for example, because

� The annual limit for a deduction changes.

� Your accountant wants you to assign it to a different account.

You can’t delete the payroll items for income tax and other government deductions that 
QuickBooks Enterprise Solutions creates for you, but you can hide these items if you don’t 
use them.

What the changes to payroll items affect

Changes you make to payroll items affect new pay cheques you write, and certain changes 
can also affect how payroll amounts are classified historically on tax forms, reports, and 
cheque details.

Employee profiles and all previously-written cheques are affected when you change any of 
the following information for payroll items:

� Payroll item name

� Account(s) assigned to it (liability or expense)

� Assigned box on T4 and, in Québec, Relevé 1 forms (for wages, tips, etc.)

Changing the following information affects future pay cheques only:

� Payroll taxes affected (for additions to or deductions from gross pay)

� How the item is calculated on the pay cheque

To learn about… Search the Help index for…

Changing payroll items payroll items, editing

Making payroll items inactive, 
hiding them, or showing them

lists, hiding and showing entries

Deleting payroll items payroll items, deleting
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Managing employee information

You can change an employee’s personal or payroll information whenever necessary, and 
the changes will affect all future pay cheques you write to him or her. Changes you make 
to an employee’s name, address, and Social Insurance Number are also reflected in 
previously-written pay cheques, but do not affect any of the amounts on those pay cheques.

The following types of information must be changed individually for each affected 
employee. Changing the payroll item doesn’t affect the employees who use it.

� Annual limits for a deduction.

� Rate or amount changes for a deduction, addition, company contribution, or other tax 
item.

Tip: Change the information in the employee defaults first. In many cases, QuickBooks Enterprise 
Solutions asks if you want to also change the information for all matching employees.

Hiding, showing, or merging employees

You can’t delete an employee who has existing payroll transactions, but you can hide a 
name on the Employee list by making the employee inactive. When you make an employee 
inactive, QuickBooks Enterprise Solutions keeps his or her information and payroll 
transactions, but hides the employee’s name on the Employee list and any employee drop-
down lists. You can make an employee active again at any time.

If you find you have the same person on your Employee list twice, you can merge the names 
if there are no payroll transactions for either employee. Merging employees is not 
reversible.

Merging payroll items lists, merging two entries

To learn about… Search the Help index for…

To learn about… Search the Help index for…

Changing employee information employees, editing

Giving an employee a raise employees, raises

Adding custom fields for an 
employee

employees, custom fields for

To learn about… Search the Help index for…

Making employees inactive, hid-
ing them, or showing them

employees, hiding and showing

Merging employee names employees, merging two names
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Hiring and releasing employees

When you hire a new employee, simply set up a profile for him or her in the Employee list 
(see “Setting up employees” on page 155). If you have set up employee defaults (page 154), 
this information is copied from the defaults into the new employee profile. Then, if you 
need to, you can change any of the information for this particular employee.

When an employee leaves the company, you need to enter the employee’s release date into 
his or her profile. When you do, QuickBooks Enterprise Solutions displays the Deceased 
checkbox, which you should select if the employee has passed away.

Tip: It’s a good idea to enter a release date for an employee only after you have written his or her final 
pay cheque. Once you enter a release date in the employee’s record, QuickBooks Enterprise 
Solutions doesn’t display the employee’s name in the Select Employees To Pay window when 
the pay period end date is later than the release date..

You can’t delete a released employee if there are payroll transactions for him or her. You 
can, however, make the employee inactive to hide his or her name in the Employee list.

Preparing a Record of Employment (ROE) 

If you release an employee, QuickBooks Enterprise Solutions provides an unofficial Record 
of Employment printout, to help you fill out a Record of Employment (ROE) form for him 
or her. Although you cannot submit the ROE that QuickBooks Enterprise Solutions prints 
(because the official ROE form has an official serial number on it that you are required to 
use), you can copy the information from the ROE printout directly to the official ROE form.

1 From the Employees menu, choose Process Record of Employment.

2 Choose the employee you want, then click OK.

Deleting an unused employee employees, deleting

To learn about… Search the Help index for…

To learn about…
Search the Help index 
for…

Hiring a new employee employees, adding

Releasing an employee employees, releasing

Creating a Record of Employment 
for an employee

record of employment
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Paying your employees

Note: Before you begin writing pay cheques, be sure that your payroll system is set up completely and 
correctly (see page 142). Also, you should go online to make sure you have the latest tax table.

Selecting employees to pay

To select which employees you want to pay:
� From the Employees menu, choose Pay Employees. 

When you’ve selected the employees you want to pay, click Create to display pay cheque 
information for the first employee.

Tip: You can pay employees in groups. For example, first select your salaried employees whose pay 
cheques you don’t need to review and pay them. Then select your hourly employees and preview 
their pay cheques so you can enter their hours.

QuickBooks creates a pay cheque for each employee 
you select. You can sort the list by either the 
employee’s first or last name, according to the setting 
in Payroll and Employee Preferences

QuickBooks draws 
the cheque from this 
bank account.

If you print cheques, 
select this checkbox.

If you write them 
by hand, clear the 
checkbox and enter 
the number of the first 
cheque in the field.

The Pay Period Ends 
field shows the next 
date that an employee 
in the list should be paid 
according to the pay 
frequencies you set up. 
If you have not yet paid 
an employee in the list, 
the field shows today’s 
date. 

The cheque field 
defaults to today’s date.

When you create a pay cheque, 
this date changes to the next 
pay period end date.

If all your employees are salaried and 
receive a standard pay cheque for this 
pay period, select this option.

If you enter hours worked, commission bases, 
vacation pay, accrued time, or other variations 
from pay period to pay period, select this option.
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Previewing, adjusting, and creating pay cheques

When you select Enter hours and preview cheque before creating in the Select Employees 
To Pay window, then click Create, QuickBooks Enterprise Solutions displays the Preview 
Pay Cheque window.

In the Preview Pay Cheque window, you can do all of the following:

� View the amounts QuickBooks Enterprise Solutions calculated for each payroll item 
(including gross earnings, government withholding, and all other additions, deduc-
tions, and company contributions) for the pay cheque.

� Type or edit the number of hours worked.

� Enter accrued time or vacation pay, or prevent these from accruing on this pay cheque.

� Enter the base quantity on which to calculate commissions and other additions, deduc-
tions, or company contributions based on quantity.

� Add or delete wage, commission, addition, deduction, or company contribution 
payroll items.

The Company Summary shows company-
paid taxes and contributions that do not 
affect the amount of the pay cheque.

The Employee 
Summary shows 
wages, commis-
sions, withheld 
amounts, and other 
additions and 
deductions that 
print on the voucher 
of the cheque.

The cheque total.

If the employee is 
paid by the hour, type 
or edit the number of 
hours worked at each 
rate of pay. 

(QuickBooks fills in 
hours worked either 
from time data or 
from the last pay 
cheque.)

Enter the quantity 
for a commission, 
addition, deduction, 
or company contri-
bution here.

To prevent vacation 
pay and accrued 
hours from accruing 
on this pay cheque 
only (for example, if 
it’s a commission or 
bonus pay cheque), 
select this checkbox.

QuickBooks Enterprise Solutions is more accurate than printed tax tables.

You may notice differences between calculations in QuickBooks Enterprise Solutions 
and the CCRA’s printed tax tables for different wage brackets. Because QuickBooks 
Enterprise Solutions uses a very accurate method to calculate withholding amounts 
and tax tables that are annualized (rather than weekly, biweekly, or monthly), it may dif-
fer from printed tables by a few dollars.
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Note: To suppress payment of regular salary on a bonus cheque, delete the salary item in the Preview 
Pay Cheque window (select it and press CTRL+DEL) or edit the amount of the salary to zero in 
the Rate column.

� Edit the amount for any payroll item.

After reviewing the employee’s pay cheque, click Create to go on the next employee, or, if 
you’ve paid all your employees, return to the Select Employees to Pay window.

If you’re using direct deposit, when you click Create after you’ve entered all of your 
employees’ pay cheques, QuickBooks Enterprise Solutions asks if you want to send the pay 
cheques to the payroll service now. Click OK to go online and send the pay cheques.

When you pay an employee, QuickBooks Enterprise Solutions does the following:

� Updates the pay period end date of the last cheque written for the employee.

� Creates a pay cheque for your employee for the net amount, showing the deductions 
in the voucher area, or a direct deposit payment to be sent to the payroll service later.

� Increases or decreases the employee’s accrued time by the number of hours and 
vacation pay by the amount entered for the pay cheque.

If you selected the Do not accrue checkbox in the Preview Pay Cheque window, you 
prevented the accrued time and vacation pay from accruing for this pay cheque only.

� Updates year-to-date balances for the employee.

� Draws the amount of the pay cheque from the bank account you chose.

If you are using direct deposit, QuickBooks Enterprise Solutions does not draw the 
amount from your account until you go online and send the pay cheque to the payroll 
service.

� Records an increase in each affected liability account, showing the extra liability 
resulting from this payroll transaction (for both the employee’s pay cheque deductions 
and company contributions).

If you are using direct deposit, QuickBooks Enterprise Solutions increases your Direct 
Deposit Liabilities account, which returns to a $0.00 balance after you go online and 
send the payment to the payroll service.

� Updates and tracks your payroll expenses in expense accounts.

� Updates any other accounts you have assigned to any payroll items used in the payroll 
transaction. 

Reviewing and correcting pay cheques

After you’ve recorded a pay cheque, you can review it at any time. You should rarely need 
to make changes to or void pay cheques, but if you do, from the Employees menu, select 
Edit/Void Pay Cheque.

To learn about… Search the Help index for…

Previewing and adjusting 
pay cheques

pay cheques, checking amounts in
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For example, you may want to:

� Void a pay cheque if there was a payroll error in a recent pay cheque that your 
employee has not yet cashed.

Note: If you file payroll tax forms for the period covering a pay cheque, then void that pay cheque, you 
may have to re-file the tax forms. It may be easier to write a “regular” cheque (using the Write 
Cheques window) to the employee for the difference and adjust your payroll liability amounts 
manually, but you should consult your accountant before doing so.

� Delete a pay cheque if it is a duplicate and you haven’t printed it yet.

Printing pay cheques and pay stubs

You can print all your pay cheques at one time, but you must print them separately from 
other cheques. Set up your printer for pay cheques the same way as for other cheques.

If you don’t print pay cheques with vouchers, you can print pay stubs for your employees 
instead. Pay stubs provide all required legal information, including:

� The employee’s full name, address, and Social Insurance Number.

� Pay period start and end dates.

� Salary or hourly rate and hours, and gross pay for the pay period.

� Government withholding amounts (such as income tax) and other deductions from 
and additions to wages.

� Taxable company contributions, such as the taxable portion of company-paid group 
life insurance.

� (Optional) Accrued time and vacation pay used and remaining.

� Net pay.

� Year-to-date amounts for the preceding items.

Employees who are set up for direct deposit should receive an Advice of Deposit form 
instead of a pay stub. Intuit offers Advice of Deposit forms, which are personalized with 
your company name and address. You cannot use Advice of Deposit forms with a 
continuous-feed printer unless the printer has a single-feed attachment. 

To learn about… Search the Help index for…

Editing existing pay cheques pay cheques, changing

Voiding pay cheques pay cheques, voiding

Deleting pay cheques pay cheques, deleting

To learn about… Search the Help index for…

Printing pay cheques pay cheques, printing
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Paying payroll liabilities
When it’s time to pay your payroll liabilities, QuickBooks Enterprise Solutions shows you 
how much you owe and to whom, lets you choose which liabilities to pay, and creates the 
cheques for you. It also helps you fill in the forms to send to the government with your 
payment.

Some types of businesses and businesses in some regions have to complete different payroll 
forms from the ones discussed here. Be sure to discuss your business with the CCRA and 
your accountant to ensure your payroll meets all the regulations that apply to it.

Creating payroll liability cheques and forms

Adjusting a payroll liability

In rare cases, you may find that the amount for a payroll item tracking a liability doesn’t 
match what you actually owe. For example, there may be a discrepancy due to rounding. 
You can adjust your payroll liabilities with the Liability Adjustment window.

Printing pay stubs pay stubs

Creating direct deposit payments pay cheques, direct deposit

To learn about… Search the Help index for…

Step Procedure

1 Create a Payroll Liabilities report to see how much you owe, to whom, 
and for what.

2 Adjust the amounts you owe, if necessary.

3 Use the Pay Liabilities window to create cheques for the amounts you 
owe.

4 Fill in a PD7A form to send to the CCRA along with your payment.

5 In Québec, fill in a TPZ-1015 form to send to the Minister of Revenue with 
your payment.
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1 From the Employees menu, choose Adjust Payroll Liabilities, then do the following:

Enter the date 
you want this 
adjustment to 
affect your 
payroll liability 
account.

Enter the amount of the 
adjustment.

A positive amount increases 
what you owe. A negative 
amount reduces what you owe.

For example, if the Liability by 
Payroll Item report says that 
you owe $450 but you know 
you owe $477.89, enter the 
difference: 27.89.

Select a payroll 
item to adjust.
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2 (Optional) Click Accounts Affected to select how the adjustment will affect your 
accounts.

� If your liability and expense accounts have the wrong totals as well as your liabil-
ities (the usual case), you should choose to affect your accounts.

� If your liabilities are wrong but your liability and expense accounts have the 
correct totals, choose to not affect your accounts.

3 Click OK.

4 If you chose to affect your liability and expense accounts in Step 2 and the payroll item 
you are adjusting is used to withhold amounts from pay cheques, QuickBooks Enter-
prise Solutions asks you to choose an expense account to adjust so your accounts will 
be balanced.

Type the name of the expense account you want to adjust, then click OK. (Most people 
choose Payroll Expenses.)

Paying payroll liabilities

Most businesses must send a cheque to the CCRA for last month’s payroll deductions by the 
15th of the current month. Check with the CCRA or your accountant to see what’s right for 
your business. Then consider setting up a reminder note in the To Do list.

To pay your payroll liabilities

1 From the Employees menu, choose Pay Payroll Liabilities.

2 Type the date range for the liabilities you want to pay, then click OK.

Note: Check these dates carefully as QuickBooks Enterprise Solutions uses them to create the PD7A 
report. You use this report to fill in a PD7A form to submit with your liability payment each month.

3 In the Pay Liabilities window, mark the payroll items you want to pay.

� These liabilities can be selected and paid only as a group: CPP Employee, CPP 
Employer, EI Employee, EI Employer, Federal Income Tax Withholding, and other 
federal withholding items.

To learn about… Search the Help index for…

Adjusting payroll liabilities payroll liabilities, adjusting

Always use the Pay Liabilities window to write cheques for your liabilities.

Do not use the Write Cheques window! If you do, QuickBooks Enterprise Solutions does 
not update your payroll liability accounts, and your payroll reports will not be accurate.
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4 Select whether you want to review the cheque(s), then click Create.

� After you create a cheque, the Payroll Liabilities report shows a decrease in the 
amount you owe to reflect the payment. However, the PD7A Summary report 
shows the amount you owed for the period regardless of payments you’ve made.

The window shows liabilities owed as of the end of last 
month that are not yet paid. Change these dates if you 
pay more than once a month.

This is the date the 
transaction affects 
your chequing 
account.

QuickBooks displays 
this date on the 
liability cheque as the 
paid-through date.

If you want, you can 
change the amount 
you’re paying in this 
column.

Click here to generate a Payroll 
Liabilities report for this period.

Select this checkbox 
to show all payroll 
liabilities for the 
period, including any 
credits and zero 
amounts.

If you use QuickBooks 
to print cheques, 
select this checkbox.

If you write cheques 
by hand, clear it.

Mark the liabilities 
you want to pay. 
QuickBooks creates 
one cheque per 
liability payee (like 
the Receiver 
General), not one 
cheque per liability.

To add a name that’s 
missing in the 
Payable To column of 
this window, edit the 
payroll item.

To learn about… Search the Help index for…

Paying payroll liabilities payroll liabilities, paying

Adding a name missing in the 
Payable To column

payroll items, editing

Creating a report that shows your 
payroll liabilities

payroll, reports about

Entering a discount for payroll 
liabilities

payroll liabilities, discounts

Entering a penalty for payroll 
liabilities

payroll liabilities, penalties

Entering a refund cheque for 
overpayment of payroll liabilities

payroll liabilities, refund cheque
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Creating a PD7A report

Along with your monthly payment to the CCRA, you need to submit a PD7A (Current 
Source Deductions Remittance) form. On this form, you report the federal income tax 
amounts, EI premiums, and CPP contributions you withheld from your employees’ pay 
cheques over the past month.

To help you prepare this form, QuickBooks Enterprise Solutions provides a PD7A Summary 
report.

1 From the Reports menu, choose Employees & Payroll, then PD7A Summary.

2 Check that the dates show the correct payroll deductions period (they probably don’t!), 
and type new dates if necessary.

3 Click OK to generate the report.

4 Use the information on this report to fill in your PD7A form.

Creating a TPZ-1015 report

In Québec, along with your monthly payment to the Minister of Revenue, you need to 
submit a TPZ-1015 form. On this form, you report the Québec income tax amounts and 
QPP contributions you withheld from your employees’ pay cheques over the past month.

To help you prepare this form, QuickBooks Enterprise Solutions provides a Québec 
Remittance report.

1 From the Reports menu, choose Employees & Payroll, then Québec Remittance 
Report (TPZ-1015).

2 Check that the dates show the correct payroll deductions period (they probably don’t!), 
and type new dates if necessary.

3 Click OK to generate the report.

4 Use the information on this report to fill in your TPZ-1015 form.

Creating year-end T4 and Relevé 1 slips
T4 (Statement of Remuneration Paid) and Relevé 1 (RL-1) slips are end-of-year payroll forms 
that show an employee’s wages and payroll deductions for the past year. In January or 
February, you need to create these slips for your employees, the Canada Customs and 
Revenue Agency, and, in Québec, the Minister of Revenue. 

You also need to complete a T4 Summary form (which summarizes your employee’s T4 
slips) for the CCRA and, in Québec, an RLZ-1 form (which summarizes your employee’s 
Relevé 1 slips) for the Minister of Revenue. QuickBooks Enterprise Solutions helps you fill 
in these forms, too.
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Preparing year-end payroll forms

Creating and reviewing year-end payroll slips

You create T4 and Relevé 1 slips in the much same way.

1 From the Employees menu, choose either Process T4s or Process Relevé 1s.

2 Choose the correct year from the drop-down list. Usually, you create year-end slips for 
the year that just ended.

3 Select the employees you want to create year-end slips for.

4 Click either Review T4s or Review Relevé 1s, depending on the slip you are creating.

5 Carefully review the first employee’s slip.

6 To correct employer or employee information, click Cancel and make the changes in 
the following places:

� To correct the name, address, or business number of the employer (that is, your 
company), select Company Information from the Company menu.

� To correct the employee’s name, address, or Social Insurance Number, select 
Employee List from the Employee menu, then double-click the employee to edit.

7 To adjust the amount in a box, double-click the box, then enter the adjustment in the 
window that appears.

� (Optional) Type a description to remind you about what this adjustment is for.

� Type the adjustment, then click OK.

Note: QuickBooks Enterprise Solutions adds the adjustment to the amount in the box. To 
reduce the amount in the box, put a minus sign (-) before the adjustment.

Step Procedure

1 Consult your accountant, CCRA, and provincial guidelines about how to 
report any benefits or amounts you’re not certain about.

2 In QuickBooks Enterprise Solutions, create and review a T4 slip for each 
employee who worked for you during the last year (see “Creating and 
reviewing year-end payroll slips” below). Enter any adjustments you 
need to make.

3 Print the slips.

4 Distribute the printed slips. Usually, the employee receives two copies of 
each form and the government agency that requires it receives one.

5 In Québec, repeat Steps 2 though 4 for the Relevé 1.

6 Fill in a T4 Summary form to send to the CCRA.

7 In Québec, fill in an RLZ-1 form to send to the Minister of Revenue.
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8 To approve the form (with changes, if any), click Next.

9 Repeat Steps 5 through 8 for the remaining employees.

10 On the last form, click OK.

Printing year-end payroll slips

Before you can print your employees’ year-end payroll slips, you must review them (see 
“Creating and reviewing year-end payroll slips” on page 178).

1 Confirm that the employees whose slips you want to print are selected.

2 Click either Print T4s or Print Relevé 1s, depending on which slip you are creating.

3 Distribute the forms:

- Give each employee the top two copies of his or her T4 form. Send the final 
copy to the CCRA.

- Send the top copy of the employee’s Relevé 1 form to the Québec Minister of 
Revenue, give the next two copies to the employee, and keep the fourth.

Filling in a T4 Summary form

Along with your employees’ T4 slips, you need to send a T4 Summary form to the CCRA. 
To help you prepare this form, QuickBooks Enterprise Solutions provides a T4 Summary 
report.

1 From the Reports menu, choose Employees & Payroll, then T4 Summary.

2 Make sure the date range is correct for your reporting period (it probably isn’t!), and 
enter new dates if necessary.

3 Click OK to generate the report.

4 Use the figures on the report to fill in your T4 Summary form.

Filling in an RLZ-1 form

In Québec, when you send your employees’ Relevé 1 slips to the Minister of Revenue, you 
also need to include an RLZ-1 form. To help you prepare this form, QuickBooks Enterprise 
Solutions provides a Relevé 1 Summary report.

1 From the Reports menu, choose Employees & Payroll, then Relevé 1 Summary.

2 Make sure the date range is correct for your reporting period (it probably isn’t!), and 
enter new dates if necessary.

3 Click OK to generate the report.

4 Use the figures on the report to fill in your Relevé 1 Summary form.
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Basing pay cheques and invoices on time 
worked

If you track the time your employees spend on each job, you’ll be able to:

� Invoice customers based on the number of hours of work done for them.

� Automatically fill in hours on pay cheques.

� When paying subcontractors, automatically fill in hours on cheques and bills.

� Track payroll costs by job, class, or type of work.

� Report hours worked by person, job, or type of work. 

� Track billable versus non-billable time.

� Make better decisions about employee productivity and your hiring needs.

Should I make time billable?

When you record time worked for a particular customer or job, one option is to mark it as 
billable. Then, when you invoice the customer, you can add the billable time to the invoice 
with a few clicks. After you put the time on a sales form, QuickBooks Enterprise Solutions 
marks it as billed, so you won’t charge a customer twice for the same thing.

If the work done by your employees is billable to a customer, it becomes billable as soon as 
you record the time in QuickBooks Enterprise Solutions. It doesn’t matter whether you have 
actually paid the employees for it yet.

Some businesses track time without making it billable. For example, if you agree to do a job 
at a fixed price, you would not invoice for time. However, you might still want to track time 
so you can decide after completing the job whether you set the right price.

Also, you can track accrued time (like sick time), which is normally not billable.

Choosing a method to track time

QuickBooks Enterprise Solutions comes with a separate Timer program that can run 
regardless of whether QuickBooks Enterprise Solutions is on the same computer. You can 
track time with the Timer and transfer the time data into QuickBooks Enterprise Solutions 
later.

You can also use the built-in Stopwatch or enter time data into QuickBooks Enterprise 
Solutions manually using the weekly timesheets. 
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Setting up QuickBooks Enterprise Solutions to track time

Note: You must do this preparation before other users can install and use the Timer.

Situation How to track time See…

You want people who don’t have 
access to QuickBooks to track their 
own time.

Distribute copies of the 
QuickBooks Timer to these 
people, and have them give 
you their time data.

� “Setting up QuickBooks 
Enterprise Solutions to track 
time” on page 181

� “Setting up and using the 
Timer” on page 183

� “Importing Timer informa-
tion into QuickBooks Enter-
prise Solutions” on page 187

� “Installing the Timer” on 
page 193

You have access to QuickBooks and 
want to use a stopwatch approach to 
time tracking: turn on a timer, work, 
then stop the timer. 

Use the Stopwatch in the 
Time/ Enter Single Activity 
window.

� “Setting up QuickBooks 
Enterprise Solutions to track 
time” on page 181

� “Using the Stopwatch to 
time an activity” on 
page 188

You (and others in your company) 
have access to QuickBooks and want 
to enter time data after the work is 
done.

Enter time data directly into 
QuickBooks Enterprise Solu-
tions, either on a weekly 
timesheet or as separate 
activities one at a time.

� “Setting up QuickBooks 
Enterprise Solutions to track 
time” on page 181

� “Entering time manually into 
QuickBooks Enterprise Solu-
tions” on page 189

Your employees submit paper 
timesheets.

One person can enter every-
one’s time data directly into 
QuickBooks Enterprise Solu-
tions on a weekly timesheet 
for each person.

� “Setting up QuickBooks 
Enterprise Solutions to track 
time” on page 181

� “Entering time manually into 
QuickBooks Enterprise Solu-
tions” on page 189

What to do Comments
Search the Help 
index for…

�

Turn on time tracking. The timesheet starts with the 
day you choose as the first day 
of your work week.

preferences, time ❏
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Setting up to track time while using payroll

When you set up your employees, be sure to select 
Use time data to create pay cheques on their Payroll 
Info tabs.

Pay cheques will then automatically have the employees’ time data (including job, class, 
and type of work) for the period covered by the pay cheque.

Exporting lists from QuickBooks Enterprise 
Solutions for the Timer

The first step in getting the Timer ready to use is to prepare a file with the information the 
Timer needs to work with your company file. You need this file because the Timer must 
describe activities using the exact same names that are on your lists in QuickBooks 
Enterprise Solutions.

On the Customer:Job list, set up 
the customers and jobs you want 
to track time for.

If you don’t plan to track time 
for a customer or job, you 
don’t need that name on the 
Customer:Job list now.

� customers, adding 
new

� jobs, adding new

❏

On the Item list, set up service 
items to use for the work to be 
tracked.

Service items are required if 
you make the time billable to a 
customer or job.
Be sure to create separate ser-
vice items for subcontracted 
services.

� service items, 
setting up

� subcontractors, 
service items for

❏

Set up the people whose time 
will be tracked.
Each person must be on one of 
the following lists:
� Employee
� Other Name (for owners and 

partners)
� Vendor (for subcontractors)

If you plan to pay employees 
based on tracked time, you 
must also set up their payroll 
information. See:
� “Setting up to track time 

while using payroll” below
� “Setting up employees” on 

page 153

� employees, adding
� other names, list of 
� vendors, adding

❏

On the Payroll Item list, set up 
salary or hourly wage payroll 
items to use when paying 
employees for time tracked

Required if you will track time 
for employees.

� hourly wages
� salaries

❏

On the Class list, set up classes 
for the work to be tracked

Class tracking is optional. classes, adding ❏

What to do Comments
Search the Help 
index for…

�
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To create a file for the Timer, from the File menu in QuickBooks Enterprise Solutions, select 
Timer, then Export Lists for Timer. Now follow the instructions on your screen. Save this 
file to a floppy disk so you can give it to your employees or subcontractors.

Setting up and using the Timer

How the Timer works with QuickBooks Enterprise 
Solutions

The Timer for QuickBooks Enterprise Solutions is designed to track and record time data 
which you can then import into your company file. Use the Timer when you want to gather 
time data from people who don’t have access to QuickBooks Enterprise Solutions but do 
have access to a computer.

Note: If you simply want to time an activity in QuickBooks Enterprise Solutions—not gather time data 
from others—use the Stopwatch instead. See “Using the Stopwatch to time an activity” on 
page 188.

You are allowed to make copies of the Timer program to give to other people whose time 
you want to track. When you do, you can photocopy the two-page Quick Reference Sheet 
on page 194 for them as well.

Note: If you distributed earlier versions of the Timer, you should replace those copies with the Timer 
that comes with QuickBooks Enterprise Solutions.

This flowchart shows the relationship between Time and QuickBooks Enterprise Solutions. 

To learn about… Search the Help index for…

Preparing a file of information 
from QuickBooks that the Timer 
can use

Timer, exporting lists to
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The two programs share information this way:

� QuickBooks Enterprise Solutions exports lists, such as the Customer:Job list.

� The Timer imports those lists.

� The Timer records data about time activities for the jobs, then exports it.

� QuickBooks Enterprise Solutions imports the time data and makes it part of the 
company file.

Setting up the Timer

Before you can set up the Timer, you must first install it (see “Installing the Timer” on 
page 193). Then use the following checklist to set it up. (The checklist shows whether the 
QuickBooks Enterprise Solutions user or the Timer user has to do the task, in case they are 
not the same person.)

Using the Timer

Recording activities in the Timer

You can use the Timer either to time an activity while you are doing it, or to record the time 
after you have finished. 

Task
Which user 
and which 
Help index?

Search the Help 
index for…

�

Export QuickBooks lists and 
give the disk to the Timer user.

QuickBooks Timer, exporting lists 
to

❏

Prepare Timer install disks (if 
the Timer user can’t use the 
QuickBooks Enterprise Solu-
tions CD-ROM).

QuickBooks Timer, creating disks 
for

❏

Install the Timer on the user’s 
computer.

Timer See “Installing the 
Timer” on page 193.

❏

Create a Timer data file. Timer data files, creating ❏

Import the QuickBooks lists 
into the Timer data file.

Timer lists, importing ❏

Choose your name from the 
Timer’s list of users.

Timer default user ❏
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The first time you time an activity, you have to set it up in the Timer.

Once you have set up an activity, you can choose it from the drop-down list as a template 
for the new day’s work (instead of setting it up again every day). You can add a note while 
timing an activity or after completing it.

Viewing and editing recorded activities

You can view a list of the activities you’ve recorded in the Timer. However, you can’t print 
this list (or anything else) in the Timer. After you export time data to QuickBooks Enterprise 
Solutions, the QuickBooks Enterprise Solutions user can print the list of activities.

You can run the 
Timer in a larger 
window that 
shows detail or 
in a very small 
one (far right). Click this button to switch 

between minimal size and 
full size.

To learn about…
Search the Timer Help (not 
the QuickBooks Help) for…

Timing an activity while you are 
doing it

� activities, setting up for timing
� activities, timing

Recording an activity after doing it activities, entering time for manually

Recording notes about an activity activities, adding notes to



186 Chapter 7   Setting up payroll and time tracking

Viewing and changing customer information

When you import information from the lists in QuickBooks Enterprise Solutions, you 
import customer contact information as well as the customer’s names. 

If a customer is on the list imported from QuickBooks Enterprise Solutions, or if you already 
exported Timer data using the customer, you can’t change information about the customer. 
Instead, the QuickBooks Enterprise Solutions user must change the information and give 
you an updated list file.

You can add a new customer to use when recording an activity. However, you cannot add 
a job for a new or existing customer. The Help topic suggests what to do instead.

Managing Timer data files

From time to time, you will need to update the lists in your Timer data to make them match 
those in the QuickBooks Enterprise Solutions company file. The QuickBooks Enterprise 
Solutions user must prepare the updated list file and make it available for importing into 
the Timer.

If you track time for more than one QuickBooks Enterprise Solutions company, you must 
have separate Timer data files.

To back up a Timer file, from the Timer’s File menu, select Backup. To use the backed up 
file again, from the Timer’s File menu, select Restore. Also, you can reduce the file size of 
a Timer data file by selecting Condense from the Timer’s File menu.

To learn about…
Search the Timer Help (not 
the QuickBooks Help) for…

Viewing a list of all recorded activ-
ities within a specified date range

activities, viewing data about

Changing information about a 
recorded activity

activities, editing data about

Deleting a recorded activity activities, deleting the record of

To learn about…
Search the Timer Help (not 
the QuickBooks Help) for…

Viewing contact information 
about a customer

customers, contact information for

Adding, editing, or deleting a cus-
tomer

� customers, adding
� customers, editing
� customers, deleting
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Exporting Timer information to QuickBooks Enterprise 
Solutions

When you are finished recording time, you need to export your recorded activities to an IIF 
file that QuickBooks Enterprise Solutions can import. 

Importing Timer information into QuickBooks 
Enterprise Solutions

After the Timer user exports his or her time data into an IIF file, you can import it into your 
QuickBooks Enterprise Solutions company file. In addition to activities, QuickBooks 
Enterprise Solutions imports any items on lists (that is, names, service items, classes) that 
are not currently on the corresponding QuickBooks Enterprise Solutions lists.

To learn about…
Search the Timer Help (not 
the QuickBooks Help) for…

Updating the Timer’s lists of cus-
tomers, jobs, service items, and 
classes to match changes in the 
QuickBooks file

lists, updating

Backing up your Timer data onto 
a 3.5-inch disk or your hard disk

data files, backing up

Restoring a backup of Timer data 
so you can use or view it

data files, restoring from a backup 
disk

Reducing the size of your Timer 
file

data files, condensing to save disk 
space

Creating a new Timer data file to 
use with a different QuickBooks 
company file

data files, creating for the Timer

Switching to a Timer data file for a 
different QuickBooks company

data files, opening

To learn about…
Search the Timer Help (not 
the QuickBooks Help) for…

Exporting activities to an IIF file 
that QuickBooks can read

activities, exporting to QuickBooks

After importing information from the Timer, check the Timer Import Detail 
report to ensure that the correct payroll items are assigned to each activity.

The Timer Import Detail report is only available from the Import Summary window.



188 Chapter 7   Setting up payroll and time tracking

Time reports in QuickBooks Enterprise Solutions show all timed activities, including those 
imported from the Timer. To create a report similar to the Timer Import Detail report, you 
can customize a Time by Job Detail report to add columns for payroll item and import date.

Using the Stopwatch to time an activity

Use the Stopwatch on the Time/Enter Single Activity window in QuickBooks Enterprise 
Solutions when you want to time an activity—simply start the Stopwatch, work, and stop 
it when you’ve completed the work.

� From the Employees menu, select Time Tracking, then Time/Enter Single Activity.

To learn about…
Search the QuickBooks 
Help index for…

Importing data from a Timer file 
into the QuickBooks company file

Timer, importing timed activities 
from

Viewing a report of the imported 
Timer activities or the imported 
items on lists

Timer, reports about imported 
activities

Editing an imported activity in 
QuickBooks Enterprise Solutions

time, entries

Viewing a report on activities 
exported to or recorded in Quick-
Books Enterprise Solutions

time, reports about

Once recorded, the 
time shows up in 
both this window 
and in the Weekly 
Timesheet 
window.



Basing pay cheques and invoices on time worked 189

Entering time manually into QuickBooks Enterprise Solutions

If you want to enter time data a week at a time and you generally don’t enter a lot of detailed 
notes about your activities, use the Weekly Timesheet window to enter time data manually.

If you enter a lot of detailed notes about your activities or prefer to enter time data as you 
complete each activity, use the Time/Enter Single Activity window.

When you fill in and record a Time/Enter Single Activity window, you can later view the 
information on a weekly timesheet.

Conversely, when you fill in and save a weekly timesheet, you can view Time/Enter Single 
Activity windows that each show the work on one job on one day. The two are simply 
different views of the same data, similar to views of individual cheques versus your cheque 
register.

On the weekly 
timesheet, the far-
right column shows 
whether the time is 
billable, not billable, 
or already billed.
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Paying for time worked

QuickBooks Enterprise Solutions automatically transfers time data when you create pay 
cheques for employees who are set up for time tracking. It fills in the hours for each salary 
or hourly wage payroll item included in the time data for the payroll period.

If customers or jobs, service items, or classes are assigned to an employee’s time activities, 
this detail is also included. For example, out of 40 hours altogether, 19 may be assigned to 
Job A, 11 to Job B, and the remaining 10 hours to Job C. QuickBooks Enterprise Solutions 
then splits the payroll expenses for the employee according to how you assigned the time.

Paying nonemployees for time worked

Some businesses need to pay people who are not employees (such as owners, partners, or 
subcontractors) based on time worked. QuickBooks Enterprise Solutions can transfer time 
data for a specified date range to a payment to a nonemployee. That is, it can fill in the 
number of hours worked and the rate for that type of work.

To pay a subcontractor or other vendor, you can either write a cheque (if you want to pay 
immediately) or enter a bill (to be paid at a later time). To pay an owner or partner (someone 
on your Other Names list), you can write a cheque.

To learn about… Search the Help index for…

Blank timesheets timesheets, blank

Filling out a weekly timesheet timesheets

Entering details for a single 
activity

single activity entries

Using the Stopwatch to time an 
activity

Stopwatch

QuickBooks Enterprise Solutions does not track whether you have paid 
workers for time or not, only whether you have passed time costs on to your 
customers.

If you pay a worker (employee, owner, or subcontractor) for time and then edit the time 
data or import new information from the Timer, QuickBooks Enterprise Solutions does 
not track which time has been paid for and which has not. All it tracks is the end date of 
your last payment for time to the worker.

To avoid paying for the same time twice, make sure your worker has submitted all his 
or her time data for a period before you create a pay cheque covering that period —
that is, pay a worker only for work that takes place after the end date of your last time 
payment to him or her. If you accept late time data, print a Time by Job Detail report 
and mark the activities you are paying for.
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Tip: Always set up subcontractors as vendors and use their vendor names when you track time and 
pay them. Then QuickBooks Enterprise Solutions will show payments to subcontractors for time 
worked on reports. (And remember, when you set up a subcontractor as a vendor, select the T4A 
tracking checkbox in the vendor profile to make it easier to create year-end T4A forms.)

Service items for nonemployee time data

If you plan to transfer time for nonemployees to a cheque or bill, the time data should have 
a service item assigned to it. QuickBooks Enterprise Solutions uses the rate for "purchases" 
of the service item when calculating how much to pay a nonemployee for the hours 
worked.

� Service items for subcontractors (vendors)

When you pay a subcontractor set up as a vendor, the payment is an expense to the 
business. You should assign the time to a service item set up to track costs in an expense 
account. (This service item should not be used for owners or partners.)

� Service items for owners or partners

When you pay an owner or partner, the payment is a draw against equity rather than 
an expense to the business. You should assign the time to a service item set up specifi-
cally to track costs in that person’s equity account. The service item should not be used 
for any other purpose.

Transferring nonemployee time to a cheque or bill

When you pay a nonemployee for time worked, use the Write Cheques window. (To pay 
employees, always use the payroll system!)

When you write the cheque or enter the bill, QuickBooks Enterprise Solutions alerts you if 
there is current time data for the payee. If you want to pay for the time now, you can specify 
the date range the payment should cover. Then QuickBooks Enterprise Solutions prefills the 
Items tab of the payment with the service item, customer and job (if any), rate, number of 
hours, and amount.

To learn about… Search the Help index for…

Setting up an owner or partner � owners
� partners, setting up

Adding a name to the Vendor list vendors, adding

Setting up a vendor for T4A forms T4A forms

To learn about… Search the Help index for…

Setting up a service item that 
includes both costs and income

service items, billing work by 
subcontractors or owners
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Charging customers for time worked

You can transfer time data to invoices and statement charges as long as the time data has a 
customer:job and service item and is currently marked as billable.

As you create an invoice, you can display the unbilled time for the job and select what to 
include. When you record the invoice, QuickBooks Enterprise Solutions marks the time you 
selected as billed, so you won’t bill for it again by mistake. (You can also charge for time as 
a statement charge instead of writing an invoice.)

Recording the cost of work vs. invoicing for it

When you record time or bill your customer for it, you are not recording its cost to you. To 
record the cost, you have to take a second step. The following table shows how you record 
costs for time worked and what you have to do to invoice customers for work. 

To learn about… Search the Help index for…

Paying nonemployees for time 
worked

time, paying nonemployees for

To learn about…
Search the QuickBooks 
Help index for…

Transferring time to invoices and 
statement charges

� invoices, time and cost
� statements, time and cost

Making time billable again if you 
billed for it mistakenly

time, making billed time billable 
again

Don’t make both a worker’s time and your payment to that worker for the 
time billable.

� If you make a subcontractor’s bill for time worked billable, you can invoice your 
customer in turn for the subcontractor’s charges. When you invoice the customer, 
open the Choose Billable Time and Costs window and select the subcontractor’s 
bill from the Expenses or Items tab (whichever you used on the subcontractor’s 
bill). This is the recommended method.

� If you pay a subcontractor, owner, or partner for time worked by using the Write 
Cheques window, you can make the service items on the cheque billable. Then, 
when you invoice your customer, open the Choose Billable Time and Costs 
window and select the time from the Items tab. 

� If you make the time itself billable, you can invoice for the time from the Time tab 
of the Choose Billable Time and Costs window. 

� If you make both the time and the bill or payment billable, you are in danger of 
invoicing the customer twice for the same work!
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Because recording time has no direct effect on costs, the reports about time show hours but 
they don’t show costs.

Installing the Timer

The QuickBooks Enterprise Solutions CD-ROM allows you to create a set of 3.5-inch install 
disks to give to a person who needs the Timer.

Once you have created the disks, see the Quick Reference Sheet for installation instructions.

The work is 
done by …

You record the cost of 
the work when you …

To invoice other 
people for the work…

Employees Pay the employees. Make the time billable.

Subcontractors
(vendors)

Enter bills from the subcon-
tractors (or write cheques or 
enter credit card charges for 
the work).

On the bills, cheques, or credit 
card charges, make the items 
or expenses billable.
OR
Track the time and make the 
time billable.

Owners or 
partners

Payments to owners or part-
ners for time worked are a 
draw against equity, not an 
expense, and therefore do not 
affect net the profit.

Make the time billable.
OR
Write a cheque to pay for the 
time worked, and make the 
items on the cheque billable.

You are allowed to make copies of the Timer and its Quick Reference Sheet 
to give to people whose time you want to track in QuickBooks Enterprise 
Solutions.

Be sure you have completed “Setting up QuickBooks Enterprise Solutions to track time” 
on page 181 and “Setting up the Timer” on page 184 before you do.

To learn about…
Search the QuickBooks 
Help for…

Using the CD-ROM to create a set 
of install disks for the Timer

Timer, creating disks for



194 Chapter 7   Setting up payroll and time tracking

The Timer and QuickBooks 
Enterprise Solutions 

� Before you can use it, the Timer needs to import 
information from QuickBooks Enterprise Solu-
tions.

� Then use the Timer to time your activities.

� Finally, export a file of time data for Quick-
Books Enterprise Solutions to import.

Installing from the QuickBooks 
Enterprise Solutions  CD-ROM

Other users can only install the Timer from the 
QuickBooks Enterprise Solutions CD-ROM, not 
QuickBooks too.

1 Insert the CD-ROM in your CD-ROM drive.

2 If the Installer starts automatically: Click Other 
Installation Options and choose Timer.

In the Installer does not start automatically. 
display the Run window: 

� In Windows 98 or later, select Run from the 
Start menu.

� In Windows 3.1, from the File menu in 
Program Manager, select Run.

Type the letter of your CD-ROM drive, then 
:\timer\install.exe and click OK.

3 Follow the instructions on your screen.

Installing from 3.5-inch disks
1 Insert the first Timer install disk in your 

3.5-inch disk drive.

2 Display the Run window:

� In Windows 98 or later, select Run from the 
Start menu.

� In Windows 3.1, from the File menu in 
Program Manager, select Run.

3 Type the letter of your floppy drive, then 
\:install (for example, a:\install), then click OK.

4 Follow the instructions on your screen.

Starting the Timer
� In Windows 98 or later, click Start, then 

Programs, then QuickBooks, then Quick-
Books Timer.

� In the Windows 3.1 Program Manager, double-
click the Timer icon in the QuickBooks program 
group.

Setting up the Timer
1 In the Open Timer File window (displayed the 

first time you start the Timer), choose Create 
New Timer File, then click OK.

2 Type a name for the Timer file and the location 
to save it, then click OK.

3 From the File menu of the Timer, choose Import 
QuickBooks Lists.

4 Select the name of the .IIF file to import from 
QuickBooks. (You may have to navigate to a 
new drive or folder.) Click OK.

The person who works with QuickBooks Enter-
prise Solutions must make this IIF file available 
to you.

5 From the File menu of the Timer, choose Pref-
erences, then Default Name.

6 Choose your own name from the drop-down 
list.

7 If your time is always billable to a customer or 
job, select the checkbox, then click OK.

8 Fill in the fields you need and click OK.

For help with this window, click Help.

Timer Reference Sheet
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Setting up an activity to time
1 In the main Timer window, click New Activity.

2 Fill in the fields you need and click OK.

Timing an activity
1 If the activity you want to time is not already in 

the Current Activity field, choose it from the 
drop-down list.

� If you choose from Today’s Activities, the 
Timer will add time to the time already 
shown for today.

� If you choose from Activity Templates, the 
Timer will start with zero time.

2 To start timing, click Start (or Resume).

3 To stop timing, click Stop.

Entering time manually
1 Choose the activity from the Activity Templates 

section of the drop-down list in the Current 
Activity field.

If the activity is not on the list, set it up first.

2 When the activity is in the Current Activity 
field, click Edit. 

3 In the Edit Activity window, change the date if 
you did not perform the work today. 

4 In the Duration field, type the time.

You may enter time in any of the following 
formats:

� Hours and minutes (for example, 01:30)

� Hours as decimals (for example, 1.5)

� Hours as fractions (for example, 1 1/2)

� Number of minutes (for example, 90)

No matter which format you use, the Timer 
displays hours and minutes when you tab out of 
the field.

5 Click OK to record the activity and its time.

Shrinking the Timer
� Click the Resize button (to the right of the Start 

button).

� To make the timer full size again, click the 
Resize button on the shrunken Timer.

Exporting Timer data for 
QuickBooks Enterprise Solutions
1 From the File menu of the Timer, choose Export 

Time Activities.

2 In the Export Activities window, change the 
date through which to export all unexported 
activities if the date is not correct.

3 Click Export.

4 In the Create Export File window, specify a 
name, drive, and folder (or directory) for the IIF 
file you are creating. 

5 Click OK.

Using the Timer’s Help system

For onscreen help while using the Timer, press F1 or 
choose Help for this Window from the Help menu.

To find out how to use other Timer features (such as 
entering notes or viewing your activity data), 
choose Help Contents from the Help menu.

System requirements for the 
Timer

The Timer requires the following hardware and 
software:

� 486 PC (or higher) with a minimum of 8 MB 
(megabytes) of RAM (random access memory); 
16 MB is recommended.

� Hard disk with at least 8 MB of free disk space 
(plus space for your data file)

� Windows 3.1 or later

� VGA monitor or better
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What’s new in QuickBooks Enterprise 
Solutions

The new features and improvements in QuickBooks Enterprise Solutions make managing 
your business even easier.

Here’s a summary of what’s new in QuickBooks Enterprise Solutions.

Tracking different units of measure

Note: If you are upgrading from any of the QuickBooks 2003 versions and you are already familiar with 
the units of measure and assembly item features, you do not need to read the following sections 
within this chapter. The information is meant for those who upgraded from 2002 or earlier.

The units of measure feature was introduced in the 2003 product. If you are upgrading to 
QuickBooks Enterprise Solutions from QuickBooks 2002 or an earlier version and used the 
inventory feature, you’ll know that QuickBooks tracked an inventory item’s unit of measure 
as a one-to-one relationship. In other words, whether you were purchasing, selling or 
stocking an item, its unit of measure was always a single unit. 

With QuickBooks Enterprise Solutions and other 2003 products, you can now set up a 
different unit of measure than the one you purchased it in. For example, you can buy soda 
pop in cases with 12 cans to a case, and sell them by the can. Then, when you sell one can, 
QuickBooks Enterprise Solutions understands this transaction to mean 1/12 of your 
inventory.

New feature Comment

Up to 10 users can work 
simultaneously

Up to 10 users can access the same company file and, with Quick-
Books Enterprise Solutions, 10 software licenses are included.

Higher list limits Add a total of up to 29,000 names such as customers, vendors, 
employees, and other names; and a total of 29,000 inventory, non-
inventory, and service items to the same company file.

Improved simultaneous user 
performance

Reduced delays while simultaneous users are searching for transac-
tions or running reports. 

Combine reports from multiple 
companies
(Requires Excel 97, 2000, or 2002)

Combine financial reports from multiple Enterprise Solutions com-
pany files. If you need to track different locations, offices, depart-
ments, or regions with different Enterprise Solutions files, you can 
run combined reports across these files with Enterprise Solutions. 
The ability to combine reports is especially useful if you use different 
company files to manage complicated projects.

For more details, see “Combining reports from multiple company 
files” on page 91.
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Setting up different units of measure 

Turning on the units of measure preference

Before you can set up different units of measure for items, the units of measure preference 
must be turned on. Once turned on, units of measure cannot be turned off, therefore, you 
should only activate this feature if you buy, stock or sell in different units. 

1 From the Edit menu, choose Preferences.

2 From the scroll box on the left, select Purchases & Vendors.

3 On the Company Preferences tab, select Inventory and purchase orders are active, and 
then select Units of Measure are active. (Inventory must be turned on in order to 
activate units of measure.)

What happens when units of measure is turned on?

With the units of measure preference turned on, you’ll see the following changes in 
QuickBooks Enterprise Solutions.

� A Units of Measure button is added to the Inventory Part and Inventory Assembly type 
items window. This button opens the Define Units of Measure window where you can 
set up different units of measure for these items. 

� A field is added to the Service and Non-inventory Part items window where you can 
assign a descriptive label that represents the unit of measure used when dealing with 
the item.

� A Unit column is added to all forms. This new column displays the item’s unit of 
measure associated with the type of transaction. For example, the selling unit is used 
on sales forms such as invoices and sales orders, and the purchasing unit on purchase 
forms such as bills and purchase orders.

� A Unit column is also displayed on some windows such as  "Adjust Quantity/Value on 
Hand" and "Change Item Prices".

� A Unit column is added to display an item’s units of measure on reports to do with the 
item list; and purchases, sales and inventory transactions. 
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Setting up different units of measure

You can now keep track of how you purchase, stock and sell your items with the units of 
measure feature. Different units of measure can be set up for Inventory Part and Inventory 
Assembly type items. The association between an item’s units of measure cannot be 
changed once a transaction involving the item is recorded. Therefore, if you have a quantity 
on hand for an item, you must set up its units of measure before entering an amount in the 
Quantity on Hand field.

1 From the Lists menu, choose Item List.

2 From the Item menu button, choose New. 

3 From the Type field of the New Item window, choose Inventory Part or Inventory 
Assembly, and then click the Units of Measure button. The Define Units of Measure 
window appears.

4 Click OK. 

Adding items with units of measure to forms

Once units of measure are set up for an item, the item’s appropriate unit of measure is then 
displayed on business forms. Sales forms show the selling units, and purchasing forms show 
purchasing units. On forms, you cannot switch to a different unit of measure. 

Type the unit of 
measure you use 
to stock the item.

Clear this box 
and type the unit 
you use when 
selling the item.

Enter the number of selling 
units that make up a stocking 
unit, or vice versa.

If the purchasing unit is the same 
as the stocking unit, keep this box 
checked. If the purchasing unit is 
different, clear the box, and set 
up the purchasing unit the same 
way the selling unit was set up.

When entering a bill, an item’s purchasing unit is 
shown. If we were to cite the example shown above, 
you’d see that the purchasing unit for Soda Pop is a 
case. QuickBooks understands this to mean 12 cans 
as defined by the item’s selling units of measure.

When that same item is added to an invoice, however, the unit displayed is the selling unit.

Tip: You can enter fractional or decimal values on forms. For example,
if you purchased only half a case, you could enter .5 or 1/2 on your bill.

Bills

Invoices
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Assigning a label to Service & Non-inventory Part 
items

A descriptive label can be added to Service and Non-inventory Part items (with units of 
measure turned on) to help identify the unit of measure or rate that is used for these items. 
Different units of measure cannot be tracked for these item types. These labels act only as 
a title, and when created, are displayed on business forms and reports.

Reporting in different units of measure

By default, some reports display an item’s unit of measure. The unit that is displayed 
depends on the report being created. For example, a "Purchase by Item Summary" report 
displays the purchasing units of measure, whereas the "Sales by Item Summary" report 
displays the selling units. You can change the reports to display in the units you want 
through the Modify Report window.

If you want to see the 
purchasing unit on 
this report, click 
Modify Report.

In the Modify Report 
window, select 
Purchasing Unit to 
show the item’s 
purchasing unit of 
measure. 

QuickBooks converts 
the quantity (which in 
selling units is one can) 
to .08333 of a case.

Qty * Unit

0.08333 case

Qty * Unit

1 can

Because this is a 
sales report, by 
default, the selling 
unit is shown. 

The report changes 
to show the items in 
their purchasing 
units.
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Assembling inventory items
Inventory assembly items allow you to create an item that contains assembled material 
units (finished goods) you buy or produce, track as inventory, and resell. You can keep track 
of how many items remain in stock after a sale, how many items you have on order, your 
cost of goods sold, and the value of your inventory. Note that inventory assembly items in 
QuickBooks Enterprise Solutions are appropriate for indicating "light" assembled items on 
sales forms and in reports. QuickBooks Enterprise Solutions does not track inventory 
throughout a manufacturing process. 

You must have QuickBooks Pro, Premier or Enterprise Solutions to create and build 
inventory assembly items. Afterwards, you can use any version of QuickBooks to view, sell, 
and report on existing assembly items. 

Defining and building inventory assembly items

Creating assembly items in QuickBooks Enterprise Solutions is a two-part process: first you 
define an assembly item and save it using the New Item window, then you build the 
assembly in the Build Assemblies window. Assembly item units are not added to inventory 
and assembly components (inventory parts or other assemblies) are not deducted from 
inventory until you build the assembly. Note that if you enter a quantity on hand in the 
New Item window while defining a new assembly item, this transaction is recorded as an 
inventory adjustment. In this case, assembly units are added to inventory but components 
are not deducted from inventory.

All component items included in an assembly must first be defined as inventory parts or 
assembly items before you can use them in an assembly.

Editing inventory assembly items

Assembly definition details, such as the list and quantity of components, can be edited until 
the assembly is used in a transaction. The most obvious transaction that affects the status 
of a new assembly is the build process, but adjusting inventory by changing the quantity 
on hand in the New Item window also causes a transaction to occur.

After an assembly has been used in a transaction, you can't edit the assembly's component 
list. However, you can still modify most other aspects of an assembly definition.

Changing quantity on hand for assemblies adjusts the overall number of assembly units in 
inventory, but does not change the quantity on hand of components (inventory part items 
or assemblies) used in the parent assembly.
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Pending builds

A pending build is an inventory assembly build transaction that could not be finalized 
because there were not enough component parts in inventory to build the specified number 
of assemblies at build time. When a build is pending, "Pending" appears in the Build 
Assemblies window to remind you that these assemblies haven't been built. 

If you modify or delete a previous build transaction, or change inventory quantities or the 
dates of purchase orders, invoices, or sales receipts, assembly builds that were finalized 
could change to pending. Finalized builds change to pending when the quantity of at least 
one component drops below the quantity needed to build the specified number of 
assemblies on the build transaction date. You can use the pending builds report to see a list 
of all builds that are currently pending.

In addition, you can choose to manually mark a build as pending even if you currently have 
enough components in stock to build the specified quantity. This allows you to set up build 
information but postpone building the assembly until later. Why mark a build as pending?

Selling inventory assemblies

When assembly items appear on any form (for example a sales receipt or in a report), their 
component items are hidden. Only the assembly name, description, and price appear.

If you attempt to sell more assembly units than you have available in inventory, 
QuickBooks Enterprise Solutions warns you that quantities are insufficient to fulfill the 
order. If you decide to go ahead with this transaction, the quantity on hand for the specified 
assembly changes to a negative value. You can set a build point in the Build Assemblies 
window to remind you when assembly stock is getting low and you need to build more 
units. If you turn on reminders, a list of assemblies that need to be built appear in the 
Reminders window.

Disassembling inventory assemblies

There are several ways to disassemble inventory assemblies and return component items to 
inventory. You can:

Use the Adjust Quantity/Value on Hand window to adjust the quantity on hand for each 
assembly component and the assembly item. 

Reduce quantity to build in the Build Assemblies window and then click Build & Close. The 
quantity of assembly units in inventory are decreased and the quantity of component 
inventory parts are increased accordingly. 

Delete a build transaction completely. The quantity of assembly units in inventory are 
decreased and the quantity of component inventory parts are increased accordingly, but 
this method completely removes the build transaction from QuickBooks Enterprise 
Solutions and should not be used if you want to maintain a record of the transaction. 
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accounts payable

The record of outstanding bills a business must pay. 
Called A/P for short.

accounts receivable

The record of money owed to a business, that is, 
outstanding invoices or statement charges for which 
the business has not received payment. Accounts 
receivable is called A/R for short. (Even though the 
word accounts is plural, QuickBooks uses a single 
account on the chart of accounts to track all the 
money that different people owe you.) 

accrual basis

A method of bookkeeping in which you regard 
income or expenses as occurring at the time you ship 
a product, render a service, or receive a purchase 
rather than at the time you pay or receive cash. With 
this method, the first time you enter the transaction 
into your records and the moment when you pay or 
receive cash may be two separate events. 

accrual hours

Time that your employees accrue ("earn") as they 
work. Examples include sick time and time off in lieu 
of paid overtime.

aging

The tracking of due dates and amounts of 
outstanding invoices (and of your unpaid bills). 
QuickBooks has preset accounts receivable and 
payable aging reports.

assets

Assets include what you have and what people owe 
you. Examples include: 
� cash on hand and in your chequing account
� money you are owed
� furniture
� vehicles

total assets = total liabilities + equity

balance sheet

A report that summarizes the financial position of a 
business. A balance sheet shows the value of your 
company’s assets, liabilities, and equity as of a 
particular day. It is called a balance sheet because the 
value of the assets is always exactly equal to the 
combined value of the liabilities and equity.

billable

Time worked or purchases made for a particular 
customer or job, that you want to charge back to that 
customer or job in QuickBooks.

After you put the time or purchase on a sales form, 
QuickBooks marks it non-billable, so you won’t 
charge twice for the same thing.

cash basis

A method of bookkeeping in which you regard 
income or expenses as occurring at the time you 
actually receive a payment or pay a bill. 

CCRA

Canada Customs and Revenue Agency, formerly 
Revenue Canada. 

class

Anything in your business (other than a customer or 
job) for which you need to track both income and 
expenses.

combined reports

A feature in QuickBooks Enterprise Solutions that 
allows you to combine data from multiple company 
files in to one report. For more details, see 
“Combining reports from multiple company files” 
on page 91.

condense

To remove detail you no longer need from older 
transactions in your QuickBooks company file, with 
the result that your company file shrinks in size and 
QuickBooks performs better. 

Glossary of terms
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corporation

A business organization that has been incorporated. 
A corporation is owned by its stockholders. 

customer

Any person, business, or group that buys or pays for 
the services or products that your business or organi-
zation sells or provides

equity

The net worth of a company, equal to the total assets 
minus the total liabilities. All the equity belongs to 
the owners.

equity = assets - liabilities

inventory

The most common kinds of inventory are: 
merchandise or stock in trade; raw materials; work in 
process; finished products; and supplies that physi-
cally become a part of the item intended for sale.

item

A service you provide or a product you sell, which 
you set up on your Item list. In addition, you can 
have items for miscellaneous charges and for various 
calculations on your sales forms. 

job

A project for a particular customer.

liabilities 

Liabilities include what your company owes to other 
people or your company debts. Examples include: 
� unpaid bills or credit card accounts
� loans
� money you collect for the government, like 

income tax from employee pay cheques or 
GST/PST from customers.

maintenance release (R)

Also called an update or a patch.

A revision of QuickBooks that you download or 
install over an existing version of QuickBooks.
Maintenance releases are offered free of charge 
throughout the year (some shipping and handling 
charges may apply) and can include bug fixes, latest 
payroll or legal requirements, and feature additions. 

When we publish a maintenance release, a number is 
associated with it (for example, R4, R5 etc.). This 
number is important when it comes time to install a 
newer version of QuickBooks, as it is a way for Quick-
Books to determine which maintenance release you 
have installed.To see what version and release you 
currently have installed on your computer, press 
CTRL+1 with QuickBooks open.

multicurrency

A feature that, when turned on, gives you the ability 
to deal in foreign currencies. 

multi-user mode

More than one person can access your company file 
at the same time.

net profit

The sum remaining after all expenses have been met 
or deducted, synonymous with net earnings and net 
income or net loss.

online banking

Doing bank transactions through the Internet.

partnership

An unincorporated company owned by two or more 
persons.

patch

See maintenance release.

payroll taxes

A blanket term for all deductions you withhold from 
an employee’s pay cheque and remit to a level of 
government. Examples are income tax deductions, 
Employment Insurance premiums, and Canada or 
Québec Pension Plan contributions.
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payment item

A type of item on your Item list. You can set up a 
different payment item for each method of payment.

Use payment items on cash sales receipts only when 
you need to show two or more kinds of payments on 
the same receipt.

profit and loss statement

This report shows how your cash position changed 
over a period of time. It shows the amount of cash 
earned from profit, where you received additional 
cash, and where your cash was spent. 

progress invoice

One of a series of invoices all based on the same 
estimate for the same job. Use progress invoices 
when you want to invoice for the job in phases—that 
is, by milestone or by percentage complete.

QuickBooks keeps track of the amount you have 
already invoiced and the amount not yet invoiced. 

QuickReport

A report that shows a list of transactions you are 
likely to want to see for the name you have selected. 
The particular report depends not only on the name 
you select but also where you select it.

realized gains and losses

For transactions that involve foreign currencies, the 
difference between what the foreign currency was 
worth when the customer paid you and what it was 
worth when you converted it to your home currency 
(by depositing it into your financial institution) or, if 
you haven’t converted the foreign currency to your 
home currency, what it is worth today. Contrasts 
with "unrealized gains and losses".

reconcile accounts

An analysis explaining the difference between a 
company’s book balance of cash and it’s bank 
statement balance.

reimbursed expenses

Expenses you have incurred on behalf of a customer, 
and for which you have requested reimbursement.

restore

To expand a company file from a compressed backup 
into a functioning company file again.

retained earnings account

An equity account that QuickBooks automatically 
adds to your chart of accounts when you set up a new 
QuickBooks company. QuickBooks uses the account 
to track profits from earlier periods that have not 
been distributed to owners. At the beginning of a 
new fiscal year, QuickBooks automatically transfers 
net income into your Retained Earnings account.

sales tax

A tax you collect from a customer when he or she 
pays for the sale. There are several types of sales tax 
in Canada: the Goods and Services Tax (GST), the 
Harmonized Sales Tax (HST), and provincial sales 
taxes such as the Québec Sales Tax.

single-user mode

Only one person can access your company file at any 
time.

sole proprietorship

An unincorporated company owned by one person.

start date

The date QuickBooks will have complete infor-
mation about your company finances. The start date 
can be in the past if you enter historical records; it 
can be the current date; or it can be some day in the 
future if you prefer to enter information gradually. 

time tracking

Keeping a record of the hours that you, your 
employees, or your subcontractors work so that you 
can then pass the expense on to your customers.

trial balance

In traditional accounting, a document that adds up 
all the debits and credits so that mistakes can be 
traced if debits don’t equal credits. Because Quick-
Books always adds correctly, you do not need to do a 
trial balance. Nevertheless, QuickBooks provides a 
trial balance report if you want to see your data in 
this format.
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unrealized gains and losses

For transactions that involve foreign currencies, the 
difference between what the foreign currency was 
worth when the customer paid you and what it was 
worth when you received it or, if you haven’t 
received it, what it is worth today. Contrasts with 
"realized gains and losses".

Many accountants prefer you take your unrealized 
gains and losses into account when you create 
reports about your company’s net worth.

upgrade

The process by which you promote an earlier version 
of QuickBooks to a newer version. For example, if 
you currently have QuickBooks 2000 and you 
bought QuickBooks 2002, you would be upgrading to 
the QuickBooks 2002 version.

update

(noun) A newer release for the version of QuickBooks 
that you’re currently using. This is also referred to as 
a maintenance release and it typically contains bug 
fixes. (verb) The process of converting the format of 
an existing company file so that it can be opened 
with a newer version of QuickBooks.

version (v)

An annual release of QuickBooks which is available 
through stores. Versions include enhancements and 
new features. (For example, QuickBooks version 
2001, 2002, etc.)

wage base

The total amount of employee wages or earnings on 
which a payroll tax is calculated.

zero rated

Under the GST, certain goods and services are taxed 
at a rate of 0% instead of the usual 7%. These items 
are called zero rated.

Zero-rated items are not tax exempt. If you sell a 
zero-rated item, you charge your customers 0% GST 
on it. This means that you do not collect any GST to 
remit to the government. However, because the item 
is taxable, you can claim input tax credits (the GST 
you paid on the materials you needed to produce the 
item) for it.
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Symbols
.AIF, 8

.QBA, 8

.QBB, 8

.QBW, 8

.QBX, 8

: (colon) between customer and job, 63

Numbers
5-User Value Pack, registering, 99

A
accountant’s review feature, 30–32

accountants, 34

accounting
accrual, 42
cash basis, 42

accounting software
transferring data to and from QuickBooks, 29

accounts
account numbers for, 68
affecting during payroll setup, 161
chart of, 50
creating, 70
editing, 68
expense, 56
foreign, 128
income, 56
opening balance for, 70
payroll, 146
Quicken, equivalent of, 25
setting up income and expense, 56

tax lines, assigning to, 107

accounts (types)
accounts payable, 37
accounts receivable, 37
asset, 37
balance sheet, 36
bank, 37
credit card, 37
equity, 38
fixed asset, 37
liability, 37
long term liability, 37
non-posting, 36
other asset, 37
other current asset, 37
other current liability, 37

accounts (working with)
automatically-created accounts, 36

accounts payable, 55
account for, 37
converting from Quicken, 23
historical transactions, 68

accounts receivable
account for, 37
after converting from Quicken, 22
historical transactions, 68

accrual basis bookkeeping
adjustment during setup, 71
defined, 42

accuracy of QuickBooks payroll compared to printed 
tax tables, 170

activities
editing or viewing Timer data about, 185
exporting from the Timer, 187
importing into QuickBooks from the Timer, 187
recording in the Timer, 184
recording time manually in QuickBooks, 189
single, recording, 190
timing with the Stopwatch, 188
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additions, payroll item for, 150

adjusting
income and expense accounts, 72
liabilities for GST/PST, 122
liabilities for payroll items, 173

administrator, 101

advisor, 34

alignment
adjusting for printing, 111

amortization of loans, only in Quicken, 28

archiving, see condensing data

assets
accounts for, 37
balance sheet, viewing on, 39
current, accounts for, 37
defined, 39

audit trail, 103–104

autoload printer feature, aligning forms with, 112

Automatic Update
turn off, 77

awards, paying to employees, 151

B
backing up data, 92

bad debt, adjusting GST or PST owed, 122

balance sheet accounts
types of, 37

balance sheet, described, 39

bank accounts
description, 37

benefits for employees, payroll item for, 150

billable status
deciding whether to make time billable, 180
making billed time billable again, 192

bills
paying foreign vendors, 139
unpaid, 55

blank timesheets, 190

bonuses, paying to employees, 151

bookkeepers, 34

bookkeeping methods
accrual basis, 42
cash basis, 42

bookkeeping software, transferring data to and from 
QuickBooks, 29

books, closing, 103

business number, 117

business segments, tracking, 35

buying units, 198

C
calculating payroll taxes, slight discrepancies, 170

calendar year, 107

Canada Customs and Revenue Agency
GST and, 116
income tax and, 105
payroll liabilities and, 173

Canada Pension Plan
calculations and employee’s date of birth, 155
payroll items for, 149

cash basis bookkeeping, 42

cash flow forecast reports, 41

cash vs. accrual
choosing, 42
reporting, 109

categories in Quicken, equivalent of, 25

CD
update QuickBooks, 79

CD-ROM
installing QuickBooks from, 5

changing
how dates display, 79
Internet connections, 74

chart of accounts
adding accounts, 68
automatically-created accounts, 36
creating, 50
described, 36
setting up, 50

checklist for setting up payroll, 144–145

cheques
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alignment adjustments for, 111
ordering from Intuit, 227
pay stubs, printing, 172
payroll

printing, 172
reviewing and correcting, 171
writing, 171

chequing accounts, historical transactions and, 69

classes
adding, 35
employees, grouping by, 156
payroll expenses, tracking by, 147
turning on preference for, 35
uses for, in QuickBooks, 35

closing books or period, 103

colon (:) between customer and job, 63

columns, changing for reports, 88

combining
names after converting from Quicken, 20
reports from multiple companies, 91

commissions
employee template, adding to, 154
employees on, 156

company
backing up, 92
creating new, 49
data file, described, 34
described, 34
multicurrency and, 126
passwords, 101
restoring data, 93
sample, 86
searching for lost file, 9
selecting a tax form for, 49
setting up, 47
setup, preparing for, 46
turning on GST/PST tracking, 49

company contributions
employee template, adding to, 154
employees, individual, setting up for, 155
payroll item for, 150

company files, 35
creating combined reports from, 91

compensation
one-time payment, 151
payroll items for, 150

condensing data, 94
how it affects reports, 96
summary transactions, 95
when using Payroll Service, 94

connecting
QuickBooks to the Internet, 73

connection
changing for the Internet, 74

construction industry, tracking standard categories, 
35

consultants, 34

contacting technical support, 223

converting, Quicken data, 16–20

corporations
described, 44
officer salaries, 150

CPP (Canada Pension Plan), payroll items for, 149

creating
combined reports from multiple company files, 91
foreign invoices, 136
sales order, 201

credit cards
accounts, 37

currency list, 131

currency, see multicurrency

current assets, accounts for, 37

custom fields
filtering reports for, 90
for employees, 155

customers
foreign, 136
payroll expenses, tracking by, 147
tax codes for, 120

customizing reports, 88
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D
data

audit trail of, 103–104
backing up, 92
condensing, 94
exporting, 28
exporting from the Timer, 187
files, 35
importing from other software, 28
refreshing, 100
restoring, 93
Timer, importing into QuickBooks, 187
transferring to and from QuickBooks, 29

dates
changing how they display, 79
report ranges, 90
start date, 43

deductions, payroll
employee template, adding to, 154
employees, individual, setting up for, 155
payroll item for, 150

defaults
accounts created, 36
employee, for payroll, 154

departments, tracking, 35

deposit slips, ordering from Intuit, 227

deposits
direct, 158

direct deposit, 158

disable, Automatic Update, 77

discrepancies between QuickBooks and printed tax 
tables, 170

disk space required for QuickBooks, Timer, and 
Internet Explorer, 2

disks
saving disk space, 94

duplicate names, after converting from Quicken, 20

E
EasyStep Interview, 47

chart of accounts in, 50
income tax form and, 50

payroll and, 66
turning on GST/PST tracking, 52

EI (Employment Insurance), payroll items for, 149

employee defaults, 154
TD1 information in, 154, 156
TP-1015.3 information in, 154, 156

employees
adding, 168
benefits for, 150
bonuses for, 151
categorizing, 156
commissions, 156
custom fields, 155
defaults, 154
deleting, 167
direct deposit for, 158
duplicate names, 167
editing information about, 155
hiding, 167
merging names, 167
notes about, 156
paying, 169, 171
payroll information

changing, 155
setting up, 153–154
year-to-date summaries, 160

preferences for, 143
raises, 167
releasing, 168
removing from list, 167
setting up, 155
sharing QuickBooks on a network, 101
tracking time for, 180, 190

Employment Insurance, payroll items for, 149

envelopes, ordering from Intuit, 227

equity
accounts, 38
balance sheet, viewing on, 39
redistributing during setup, 72
retained earnings from, 72
transferring from Opening Bal Equity, 22, 72

errors in payroll tax calculations, 170

Excel
creating combined reports in, 91

exchange rates, 126
downloading current rates, 132
how they affect transactions, 133
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see also multicurrency, 126
updating, 133

expense accounts
opening balances, 72
setting up, 56
uncategorized, 71

expenses, payroll, 146

exporting
data, 28, 29
lists for use in Timer, 182
Timer data for use by QuickBooks, 187
vs. other methods of transferring data, 29

F
federal income tax, payroll items for, 149

federal payroll taxes
employees, setting up for, 155
paying, 176

fields
custom for employees, 155
filtering reports with, 90

file types, 8

files
backing up, 92
condensing, 94
network location, 98
restoring, 93

filing payroll tax forms, 173
PD7A, 177
Relevé 1, 178
T4, 178
TPZ-1015, 177

filtering reports, 90

firing an employee, 168

fiscal year, 93, 107
adjusting for mid-year QuickBooks start date, 72

flowcharts, 82

fonts, changing on reports, 88

foreign currency, see multicurrency

forms
described, 84
invoices, types of, 54
printing, alignment, 111

G
garnisheed wages, payroll item for, 151

Goods and Services Tax see GST/PST, 52

GST Payable account, 122
adjusting, 122

GST/PST
adjusting liabilities, 122
amount owed as of start date, 71
applying to sales, 120
business number, 117
codes, setting up, 119
customer tax codes, 120
how QuickBooks calculates, 116
liabilities, 118
liability reports, 121
locking after paying, 103, 123
paying liabilities, 121
preferences, 117
purchases including, 120
refunds for overpayments, 122
sales including, 120
tax codes, setting up, 119
tracking, 52, 117
turning on in EasyStep Interview, 52
what you owe, 121
Zero Rated tax code, about, 119

H
hardware requirements

for QuickBooks, 2
for Timer, 195

help
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how-do-I menus, 85
index, 85

hiding
items in lists, 83

hiding and showing
employees, 167

historical transactions, 68
entering for payroll, 69

hours worked
entering on pay cheques, 170
recording manually in, 189
recording with the Stopwatch, 189
recording with the Timer, 184

how-do-I menus, 85

I
Icon bar, 82

IIF file format, 28

importing
activities from the Timer, 187
QuickBooks lists into Timer, 184

income accounts
opening balances, 72
setting up, 56
uncategorized, 71

income statement, described, 40

income tax
form, 45, 107
preparing information, 108
QuickTax, 108
reports about, 109
selecting a form in the EasyStep Interview, 50
setting up and tracking, 105

industry information, 86

Installation Key Code, entering, 5

installing
QuickBooks, 5
Timer, 193
what happens during, 11

international business, see multicurrency

Internet
changing your connection, 74

connecting QuickBooks to, 73
requirements, 73
setting up a connection, 74
updating QuickBooks from

updating
QuickBooks from the Internet, 76

Intuit
phone numbers, 226
registering your software with, 8
technical support, 224
Web sites, 226

investment tracking, only in Quicken, 28

invoices
choosing format, 54
ordering from Intuit, 227

items, 198
about, 70
adding to forms with units of measure set, 200
foreign prices, 130
GST/PST codes for, 119
payroll, 148–166
setting up units of measure, 200

J
jobs

payroll expenses, tracking by, 147

L
liabilities

accounts for, 37
adjusting for payroll item, 173
adjusting GST/PST, 122
balance sheet, viewing on, 39
defined, 39
GST/PST, 118, 121
payroll, see payroll liabilities

lists
described, 83
exporting, 29
exporting for use in Timer, 182
updating for Timer, 187

loan amortization, only in Quicken, 28
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locations, tracking, 35

locking sales tax after paying, 103, 123

login, 101

long term liability accounts, 37

lost company file, 9

M
Macintosh

converting Quicken for, 19

manually update QuickBooks, 77

margins
adjusting alignment when printing forms, 110
adjusting for reports, lists, and graphs, 111

maximum number of users, 99

memorizing reports, 89

memory required to run QuickBooks, 2

merging
employee records, 167
names after converting from Quicken, 20
payroll items, 167

Microsoft Internet Explorer
disk space required, 2
replacement of earlier versions during QuickBooks 

installation, 5

midyear setup, 72

modes, multi-user and single-user
switching between, 100

modifying your Internet connection, 74

mortgage amortization, only in Quicken, 28

multicurrency
adding foreign prices to items, 130
an overview, 126
creating

currencies, 131
foreign accounts, 128
POs for foreign vendors, 138

currency calculator, 133

depositing foreign money, 137
downloading exchange rates, 132
exchange rates, 126, 133
foreign customers

creating, 129
invoicing, 136
payments from, 137

foreign vendors
creating, 129
paying, 139
POs for, 138

home-currency adjustments, 134
items, adding a foreign price to, 130
printing

realized gains & losses report, 136
unrealized gains & losses report, 134

realized gains & losses, 135
setting up, 126–130
transferring funds, 140
unrealized gains & losses, 133
using, 126–140

multiple users
maximum number of, 102
setting up for, 99
update QuickBooks for, 78

multi-user mode, 101
file location, 98
maximum number of users, 99
switching to, 100

N
names, Quicken conversion and, 20

navigators, 82

net worth, 38

network requirements, 2

networks
maximum number of users, 99
setting up QuickBooks on, 99
sharing QuickBooks on, 101

non-posting accounts on chart of accounts, 36
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notes, adding to Timer activities, 185

number format in reports, 88

numbers
changing how numbers display, 79
for accounts, 68

O
officer salaries, 150

online accounts
re-enabling after converting, 21

online banking
converting from Quicken, 18

online banking, converting from Quicken, 21

online registration, for QuickBooks, 227

onscreen help
how-do-I menus, 85

Open Window list, 82

Opening Bal Equity account, 72
adjusting balance during setup, 72

opening balance
for accounts, 70

opening balances
entering in EasyStep Interview, 45

order
creating sales, 201

ordering
cheques, 227
deposit slips, 227
envelopes, 227
invoices, 227
startup guides, 227
statements, 227

other asset accounts, 37

other current asset accounts, 37

other current liability accounts, 37

Other Names list, after Quicken conversion, 19

other tax items, 150

Other, on reports, 92

overpayments
GST/PST liability, refund cheque for, 122

payroll liability, refund cheque for, 176

owners
commission sales, 156
paying, 153

owners/partners, paying for time worked, 190

P
partners

commission sales, 156

partnerships
described, 44
income and expenses, tracking by partner, 35
time worked, paying partners for, 190

passwords, 101
changing, 102
close books or period with, 103
deleting, 103

pay cheques
direct deposit and, 158

pay cheques see payroll cheques

pay stubs, printing, 172

paying
employees, 171
foreign vendors, 139
GST/PST liabilities, 121
nonemployees (subcontractors), 190
payroll liabilities, 173, 176

payroll
accounts, 146
checklist for setting up, 144–145
condensing payroll data, 94
customizing accounts for, 146
EasyStep Interview and, 66
employee template, adding to, 154
employees, individual, setting up for, 155
expenses, 146
historical transactions, entering, 159–164
paying employees, 169
preferences for, 143
service for, 142
setting up, 143
subaccounts, 146
tracking expenses, 147
turning on or off, 142
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payroll cheques
deleting, 171
editing, 171
historical, entering, 160
printing, 172
printing pay stubs, 172
voiding, 171, 172
writing, 171

payroll expenses
class, tracking by, 147
customer, tracking by, 147
job, tracking by, 147
reports, 146
service item, tracking by, 147

payroll forms
PD7A, 177
Record of Employment, 168
Relevé 1 forms, 177
Relevé 1, printing, 179
RLZ-1.S-V report, 179
T4 forms, 177
T4 forms, printing, 179
T4 Summary report, 179
TPZ-1015 report, 177

payroll items, 148–166
additions, 150
changes, effects of, 166
company contributions, 150
created by QuickBooks, 149
creating new, 150
deductions, 150
displayed by QuickBooks, 149
editing, 166
examples of common items, 151
hourly wages, 150
liabilities, adjusting, 173
merging, 167
officer salaries, 150
order of, effect on amounts and gross pay, 154, 

156
other tax items, 150
salaries, 150
showing, 166
vacation, 149

payroll liabilities
adjusting, 175
discounts for, 176
how QuickBooks tracks, 148
paying, 173, 176
PD7A, 177
penalties, 176
Relevé 1 forms, 177
Relevé 1 forms, printing, 179
RLZ-1.S-V report, 179
T4 forms, 177
T4 forms, printing, 179
T4 Summary report, 179
TPZ-1015 report, 177
year-to-date summaries for setup, 163

Payroll Service, 142

payroll taxes
employees, setting up for, 155
historical, 159
on employee defaults, 154
other, payroll items for, 150
paying, 173, 176
payments, entering year-to-date summaries, 163
PD7A forms, filing, 177
refunds for overpayments, 176
Relevé 1 forms, 177
Relevé 1 forms, printing, 179
RLZ-1.S-V report, filing, 179
T4 forms

filing, 178
printing, 179

T4 Summary report, filing, 179
tax forms, filing, 173
TPZ-1015 report, 177

PD7A forms, filing, 177

phone numbers
Intuit, 226
ordering cheques and other supplies, 227
ordering software and other products, 227
registering QuickBooks, 227

POs for foreign vendors, 138

preference
units of measure, 199
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preferences
described, 52, 54
employee, 143
GST/PST, 52, 117
multicurrency, 127
payroll, 143
setting up, 52, 54
using classes, turning on, 35

previous versions of QuickBooks, upgrade, 10

previous versions of QuickBooks, upgrading from, 10

printing
alignment, adjusting, 111
files to disk, compared to other methods of 

transferring data, 29
margin issues, 110
pay stub reports, 172
payroll cheques, 172
realized gains & losses report, 136
Relevé 1 forms, 179
T4 forms, 179
troubleshooting, 110
unrealized gains & losses, 134

prior liability payments, 163

problems
printing, solving, 110

problems, solving before you call Intuit, 224

procedures, finding, 85

product lines, tracking by, 35

product registration, 8

professional advisor, 34

profit and loss statement, described, 40

provincial sales tax see GST/PST

PST
Payable account, 122
tracking, 52, 117

PST Payable account
adjusting, 122

Q
QPP (Quebec Pension Plan), payroll items for, 149

Quebec income tax, payroll item for, 149

Quebec Pension Plan

calculations and employee’s date of birth, 155
payroll items for, 149

QuickBooks, 2
Administrator, 101
and your industry, 86
company files, 35
comparing with Quicken, 25
dates, changing format, 79
disk space required, 2
installing, 5
multiple users, 99
network, sharing on, 101
numbers, changing format, 79
Payroll Service, 142
registering your software, 8
reinstalling, 9
sample company, 86
startup guides, ordering from Intuit, 227
transferring data, 28
update problem, fix, 14
updating, 76
updating from a CD, 79
updating from Web site, 78
updating multiple users, 78

QuickBooks file types, 8

QuickBooks Payroll Service
direct deposit, 158

QuickBooks, disk space required, 2

Quicken, 16–27
accounts payable, converting, 19, 23
accounts receivable, after conversion, 22
categories, equivalent of, 25
comparing with QuickBooks, 25
converted data, differences, ??–27
converted data, fine-tuning, 19–20
converting

to QuickBooks, 16–21
converting from, 19
for Macintosh, converting from, 19
setting preferences, 21

QuickTax, 108

R
RAM required to run QuickBooks, 2

realized gains and losses, 135
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Record of Employment report, 168

refreshing data, 100

refund cheques
GST/PST, 122
payroll liability, 176

registering QuickBooks, 8, 227

registers
described, 84
entering transactions in, 70

reinstalling QuickBooks, 9

release date for an employee, 168

Relevé 1 forms, 177
printing, 179
tracking information in QuickBooks, 150

reorganizing transactions in reports, 88

Rep field in New Employee window, 156

Report Finder, 88

reports
changing the scope of the information, 90
combining from multiple companies, 91
condensing data & how it affects reports, 96
customizing, 88
date ranges, 90
filtering, 90
finding the report you want, 88
fonts on, 88
GST/PST liability, 121
memorizing, 89
“Other” on, 92
realized gains & losses, 135
saving the customization and filtering, 89
trial balance, 11
unrealized gains & losses, 133

requirements, hardware and software, 2

restoring company data, 93

retained
earnings, adjusting for during setup, 72
transactions, 95

retained earnings
description, 38

RLZ-1.S-V report, 179

routing number formats, 159

S
salaries

employee, changing, 167
employee, entering, 156
officer, payroll item for, 150
payroll item for, 150
removing from bonus check, 171
year-to-date, entering for setup, 160

sales
commission tracking, 156
foreign customers, 136
forms described, 84

sales orders
creating, 201

sales tax
applying to sales, 120
business number, 117
codes, setting up, 119
historical data, 71
how QuickBooks calculates, 116
liabilities, 118
liability reports, 121
locking after paying, 103, 123
paying liability, 121
preferences, 117
tracking, 52, 117
turning on in EasyStep Interview, 52
what you owe, 121

sales tax codes
customer, 120
item, setting up, 119
Zero Rated, about, 119

sample company, 86

searching for lost company file, 9

security
passwords, 101, 103
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selling units, 198

Service for Payroll, 142

service items
tracking payroll expenses by, 147

setting up
accounts, 56
an Internet connection, 74
chart of accounts, 50
employee defaults, 154
employee payroll information, 153–154
employee year-to-date payroll summaries, 160
foreign accounts, 128
foreign customers, 129
foreign vendors, 129
multicurrency, 126–130
payroll, 143
units of measure, 199, 200
your business, 47

sharing QuickBooks on a network, 101

sick time
accrual period and hours, entering on employee 

defaults, 154
employees, setting up for, 156
entering, 155
year-to-date, entering, 160

single activities
entering details about in QuickBooks, 190
timing, 188

single-user mode
switching to, 100

software requirements, for QuickBooks, 2

sole proprietorships, description, 44

spreadsheets
transferring data to and from QuickBooks, 29

start date, 43
choosing, 43
GST/PST liabilities, 118

startup guides, ordering from Intuit, 227

statement of cash flows, 41

statements, ordering from Intuit, 227

step-by-step instructions, finding, 85

stocking units, 198

Stopwatch
timing activities with, 188

when to use, 181

subaccounts, payroll, 146

subclasses, 35

subcontractors
paying, 153
T4A forms for, 191
time worked, paying for, 190

subtotals on reports, 88

summary transactions, 95

supplemental wages, 151

support
contacting technical, 228

T
T4 forms, 177

filing, 178
prepare, 178
printing, 179
tracking information in QuickBooks, 150

T4 Summary
prepare, 178
report, 179

T4A forms, setting up, 191

tax codes
adjustments, 122
customer, 120
for items, 119
items for, 150
paying GST/PST liability, 121
Zero Rated, about, 119

tax forms
payroll, 173
PD7A, 177
Relevé 1 forms, 177
Relevé 1, printing, 179
RLZ-1.S-V report, 179
selecting in EasyStep Interview, 50
T4 and T4 Summary, preparing, 178
T4 forms, 177
T4 Summary report, 179
T4, printing, 179
TPZ-1015 report, 177

tax lines, assigning to accounts, 107
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If you don’t find the topic you are looking for here, try QuickBooks Help. From the QuickBooks Help 
menu, choose Help Index, enter the keyword, and press ENTER.

taxes
preparing information, 108
QuickTax, 108
reports about, 109

TD1 forms
employee defaults and, 154, 156

technical support
phone numbers and Web sites, 226

Technical Support phone number, choose Help & 
Support from the Help menu, and then under 
Contact Intuit, click Phone Directory or see the 
back cover of the User’s Guide

templates, for payroll, 154

time tracking, 190
deciding whether to make time billable, 180
for employees, 180
options for tracking, 180
recording time manually in QuickBooks, 189
recording time with the Stopwatch, 188

time, paying nonemployees for, 190

Timer
creating disks for, 193
data

backing up, restoring, or condensing, 187
exporting to QuickBooks, 187
files, creating, 184
importing into QuickBooks, 187

disk space required, 2
hardware requirements, 195
install disks, creating, 193
installing, 193
lists

exporting from QuickBooks, 182
importing from QuickBooks, 184
updating to match changes in QuickBooks, 187

recording activities in, 184
setting up, 183
when to use, 181

timesheets
blank, 190
filling out, 190

TP-1015.3

employee defaults and, 154, 156

TPZ-1015 report, 177

tracking
GST/PST, 52, 117
payroll expenses, 147

tracking different units, 198

transactions
audit trail, 103
deleted during condensing, 95
historical, 68
retained, 95
sorting

in reports, 88
summary, created during condensing process, 95

transferring
data between other software and QuickBooks, 28
foreign funds, 140

trial balance, 11

troubleshooting
printing problems, 110
problems, 224

turning on
audit trail, 104
class tracking, 35
payroll, 142
units of measure, 199

U
uncategorized

expenses, 72
account, adjusting at setup, 71

income, 72
account, adjusting at setup, 71

units of measure
adding to forms, 200
setting up, 199
tracking, 198

unpaid bills, 55

unrealized gains & losses report, 133
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updating
automatically, turn off, 77
exchange rates, 133
problems with, 14
QuickBooks, 76
QuickBooks automatically, 77
QuickBooks for multiple users, 78
QuickBooks from a CD, 79
QuickBooks from Web site, 78
QuickBooks manually, 77

upgrading from a previous version of QuickBooks, 10

US dollar, see multicurrency

users
auditing, 103
login, 101
maximum number, 99
maximum number of, 102
multiple, 99
passwords, 101
setting up, 101

V
vacation pay

employees, setting up for, 156
entering, 155
payroll item, 149
year-to-date, entering, 160

vacation time
accrual period and hours, entering on employee 

defaults, 154

vendors
foreign, 138
paying subcontractors, 153
T4A forms for, 191
time worked, paying for, 190

version
information, accessing, 10, 206

versions, upgrading from previous, 10

voiding, pay cheques, 172

W
wage bases

employee year-to-date setup, viewing, 162

wages
employee

changing hourly rates or salary, 167
entering hourly rates, 156
entering salary, 156

garnisheed, payroll item for, 151
hourly, payroll item for, 150
officer salary, payroll item for, 150
salary, payroll item for, 150
supplemental, 151
year-to-date, entering for setup, 160

Web sites
connecting QuickBooks to, 73
products and supplies, 227
updating QuickBooks from, 78

Windows
converting Quicken to QuickBooks, 16–27
software requirements for QuickBooks, 2
software requirements for Timer, 195

windows within QuickBooks, 82

word processors
transferring data to and from QuickBooks, 29

write-offs, adjusting GST or PST Payable account, 122

writing, payroll cheques, 171

Y
year-to-date amounts

payroll, entering, 159–164

Z
Zero Rated tax code, 119
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If you’re unable to solve a problem, you can get 

assistance by telephone, fax, and the Internet. Intuit 

Canada also offers services to help you make the 

most of your software. Appendix A

Contacting 
technical 
support

Contacting Intuit
Intuit Product 
Support

224

Web-based 
support

224

Telephone 
support

224

Password 
removal

224

Solving problems 
on your own

224

Speaking with a 
Product Support 
Representative

226

Contacting Intuit 226
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Intuit Product Support

Web-based support

QuickBooks.ca (http://www.quickbooks.ca) is the official site for Canadian QuickBooks 
users. Visit to get answers to many QuickBooks Enterprise Solutions questions, important 
QuickBooks Enterprise Solutions updates and information about special offers.

If you have Internet access on your computer, you can reach QuickBooks.ca from the Help 
menu in QuickBooks Enterprise Solutions.

Telephone support

For our QuickBooks Enterprise Solutions customers, we offer a toll-free support number 
which is available 24 hours a day, seven days a week. 

After 5 p.m. (mountain standard time), our paging system becomes active. Leave your 
name, company name and a number where you can be reached, and a support specialist 
will return your call shortly.

Password removal

If you forget your password, password removal is available. See “QuickBooks Enterprise 
Solutions Technical support” on page 228 for contact information.

Solving problems on your own

Note: We recommend you back up your data on new, formatted disks or to the Internet before you start. 
For more information, see “Backing up your company data” on page 92.

Use the following guidelines to help you solve some of the typical problems you may have.

Try the procedure again

Start at the beginning. Examine windows where you filled in fields to be sure you are asking 
the program for what you want.

For example, if invoices you just entered are not showing on your Profit and Loss statement. 
You should ask questions such as:

� Does the date of the report include those invoices?

� Do the invoices appear if you change the report from Cash to Accrual basis?

� Does this problem occur with only invoices for one particular customer?

� Have you changed any filters on the report? (Try to create a new report from scratch to 
see if the problem is solved.)
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Try a related procedure

For example, if you have a printing problem:

� Ensure the printer is working by trying to print something else. If you have trouble 
printing cheques, try printing a report. If you can’t print one of the sales forms, try 
printing a similar form.

� If you can’t print from QuickBooks Enterprise Solutions, try printing from another 
program such as Microsoft’s Notepad. If nothing prints from Notepad, you know the 
problem is related to the printer, not the software. Check the printer connections, the 
printer driver, the print queue, and so forth.

Think about what has changed

If something used to work but now it doesn’t, think about what’s changed with your 
computer.

� Have you changed or added other prgrams on your computer recently?

� Have you added a new printer?

� Have you moved your company file to a new location?

� Have you changed a setting in the Preferences window?

If the program “hangs” or locks up on you

There can be a number of reasons why your system freezes while using QuickBooks 
Enterprise Solutions or any program. Try restarting your computer to see if that solves the 
problem. If restarting doesn’t help, go through the following list of questions and take any 
related action:

� Does your computer system (and network) meet the minimum requirements necessary 
for QuickBooks Enterprise Solutions? (See “Hardware and software requirements” on 
page 2.)

� Are you making the best use of available system resources by shutting down other 
programs that may be running? (Check for programs that may be running in the back-
ground without your knowledge.)

� Do you have enough hard disk space available? (This is particularly common for those 
working in a multi-user, peer-to-peer network situation.)

� Do you have any conflicts with sound or video drivers?

Note: If you encounter system freezes while using QuickBooks Enterprise Solutions, you may want to 
call for technical support. See “QuickBooks Enterprise Solutions Technical support” on 
page 228. But first see “Speaking with a Product Support Representative”, below.
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Using the QuickBooks Enterprise Solutions utilities

A technical support representative may ask you to run the Verify Data or Rebuild Data 
utility to recover damaged transactions. The Verify utility detects any data errors; the 
Rebuild utility ensures that the errors have been corrected.

Because Rebuild can cause additional problems to your data file that can increase the 
difficulty of recovering your data, we do not recommend running Rebuild on your own.

Note: The Rebuild utility requires that you back up your company first. If a technical support represen-
tative asks you to run Rebuild, you will need to have formatted disks on hand for the backup.

Speaking with a Product Support Representative

Be prepared when you call

If you need to call for assistance, you can speed up the time it takes to get an answer by 
doing the following before you call:

� Register your version of QuickBooks Enterprise Solutions and have your registration 
number available. To display your registration number, choose About QuickBooks 
Enterprise Solutions from the Help menu.

� Be at your computer with QuickBooks Enterprise Solutions running. 

� Make notes of the windows you opened and the tasks you did prior to encountering 
the problem. Know the exact wording of any message that appeared on the screen.

� Have a pencil and paper handy to take notes.

� If your company file is set up for multiple users who have access to different areas of 
QuickBooks Enterprise Solutions, you'll need to have access to most of the software. 
You might also want to switch to single-user mode.

� Have the following information available:
� Model of computer, amount of memory (RAM) and available hard disk space
� Accessory manufacturer, type, and model (monitor and printer, for example)
� Operating system type and version; network configuration and software version

Contacting Intuit

Customer service

For information 
about...

Contact...

� Software replacements
� Billing inquiries
� Exchanges
� Order status

Intuit Customer Service:
1-888-333-8580
Mon. - Fri., 8 am - 5 pm, Mountain Standard Time
(these hours may be extended throughout the year)
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QuickBooks Enterprise Solutions registration

Supplies and product ordering information

For information 
about...

Comments... Contact...

Registering QuickBooks Enter-
prise Solutions

You can register online or by 
phone.
To register online: (24 hours per 
day, 365 days per year):
� From the File menu, choose 

Register QuickBooks, then 
follow the onscreen instructions.

� Or, visit our Web site: 
http://www.quickbooks.ca/

To register by phone, call:
1-888-333-8580
Mon. - Fri., 8 am - 6 pm, 
Mountain Standard Time
(These hours may be extended 
at various times of the year.)

For information 
about...

Comments... Contact...

Ordering supplies Includes:
� Cheques
� Invoices
� Statements
� Envelopes
� Printable deposit slips

Supplies Sales and Service
1-877-445-3233
Mon. - Fri., 6 am - 6 pm
Mountain Standard Time
or visit our Web site:
http://www.quickbooks.ca/

supplies.html

Ordering Intuit products Includes:
� QuickBooks Enterprise Solu-

tions services such as direct 
deposit

� Additional user’s guides

To order QuickBooks products, call:
1-888-333-8580
Mon. - Fri., 8 am - 6 pm
Mountain Standard Time
(These hours may be extended at 
various times of the year.)
or visit our Web site:
http://www.QuickenStore.ca/
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QuickBooks Enterprise Solutions Technical support

For information 
about...

Comments... Contact...

QuickBooks Technical Support Visit our Web site to:·
� Get answers to commonly asked 

questions.
� Get the most up-to-date Quick-

Books Enterprise Solutions infor-
mation, tips, and updates.

� Find a QuickBooks Advisor or 
training seminar in your area.

A technical support specialist is 
available for QuickBooks 
Enterprise Solutions customers 24 
hours a day, seven days a week.

Customer Number

______________________________
(write your customer number here for 
future reference)

� Visit our Web site

http://www.quickbooks.ca/
24 hours per day, 365 days 

� Or, to speak with a technical 

support specialist:

1-877-224-5934 (toll free)
Mon. - Fri., 8 am - 5 pm, 
Mountain Standard Time
(after 5 pm, you can leave a 
number where you can be 
reached in our paging sys-
tem, and a specialist will 
return your call)

Online banking � If you experience problems 
connecting to your financial 
institution's Web site, accessing 
your account, or downloading 
transactions into QuickBooks 
Enterprise Solutions with the 
"Download to QuickBooks" but-
ton, contact your financial insti-
tution.

� If you experience problems 
connecting to the Internet, 
contact your Internet Service 
Provider (ISP).

� If you have problems with 
online banking window in 
QuickBooks Enterprise Solu-
tions, call:
1-877-224-5934 (toll free)
Mon. - Fri., 8 am - 5 pm, 
Mountain Standard Time


